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Abstract 

Neurodegenerative Diseases (NDs) are the leading causes of disability/death 

globally. The Diet-Microbiota-Gut-Brain (DMGB) axis is a promising area of research 

for NDs, investigating how intercommunication between diet, intestinal microbiota, and 

the intestinal epithelium distally effect the brain. NDs also co-appear with perturbed 

metabolic and oxidative regulators in the gut, such as peroxisome organelles, that control 

tissue integrity and commensal populations. Therefore, I hypothesized that peroxisomes 

in the gut are important modulators of the DMGB axis. Recruiting the Drosophila 

melanogaster (fruit fly) as my model, I depleted peroxisome function in the animal’s 

intestinal epithelium (midgut), which effected climbing behaviour, accompanied by redox 

stress, inflammation and cellular death throughout the brain over aging. I also screened 

these midguts for peroxisome-dependent transcription factors that control DMGB axis 

communication, and identified Myo-inhibitory peptide (Mip) expression corresponded to 

the climbing deficit that was observed. Therefore, Mip in the DMGB axis of Drosophila 

requires further investigation.  
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CHAPTER 1: INTRODUCTION 

1.1       Introduction to neurodegenerative disease   

The brain is the body’s primary information, coordination, and communication hub 

(Thau et al., 2022; Y, Wang et al., 2020). Part of the Central Nervous System (CNS), the 

brain connects to distal parts of the body via the Peripheral Nervous System (PNS); 

modulating interorgan communication and moderating tissue homeostasis (McHugh & Gil, 

2018; Peters, 2006). However, aging of the peripheral organs can effect these 

communication and coordination processes, such as hormonal, or mechanical 

abnormalities of the aging body (Ali et al., 2018, Venkat et al., 2015). The brain may 

become stressed from trying to correct dysregulated inter-organ communication 

throughout the body, thus making the brain more susceptible to injury (Peters, 2006). Injury 

is especially concerning with declining organ-reserve as the brain ages, jeopardizing 

cellular survival throughout the brain (Atamna et al., 2018). Diseases of exacerbated and 

progressive and brain-wide neuronal death are classified as neurodegenerative diseases 

(NDs), such as Alzheimer (AD) and Parkinson (PD) diseases (Muddapu et al., 2020). 

NDs are one of the leading causes of disability and death world-wide by metrics of 

Global Burden of Disease (GBD) studies (Aarli et al., 2006; Feigin et al., 2019, 2020; 

Health, 2022). Accompanied by severe and progressive cognitive and motor disturbances, 

(Jahn, 2019; Loučanová et al., 2015; Muddapu et al., 2020), the consequences of NDs are 

debilitating, and effected individuals often require in-home/hospital-care from 

family/medical staff (Family Resource, 2021). These medical expenses are financially 

unforgiving for both the individual and family (Aarli et al., 2006; Feigin et al., 2019, 2020), 

and the strain on global health care systems plus the global economic burden are heavy 
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(Ou et al., 2021; Vossius et al., 2011; Weintraub & Horn, 2008; Wong, 2020, W.Yang et 

al., 2020). As the exponentially growing global population ages, and life span is prolonged 

due to medical advancements, the incidence of NDs will rise (Durães et al., 2018). 

According to the World Health Organization in 2022, the current global incidence of NDs 

like dementias (i.e. AD) is roughly 55 million, and expected to reach 139 million by 2050 

(World Health Organization, 2022). Additionally, the global incidence of PD is around 6.1 

million (Ou et al., 2021), and expected to reach 12 million by 2040 (Dorsey et al., 2018). 

Despite best efforts to find a cure, and alleviate the GBD of NDs, the aetiologies remain 

elusive and research on pathogenesis is still speculative (Durães et al., 2018).  

NDs are categorized into two groups; sporadic, contributing to over 90% of cases, 

and genetic (Bekris et al., 2021; Pang et al., 2017). Sporadic NDs are the most difficult to 

study because, pathogenesis is driven by both spatial and temporal interactions of 

environmental and genetic factors, which are still largely unknown (Hampel et al., 2021; 

Lu & Vogel, 2009; Muddapu et al., 2020; Pang et al., 2017). Genetic cases are much easier 

to study, allowing scientists to investigate the pathogenic nature of mutant-alleles, which 

are linked to and may be the causative agents of neurodegeneration (Bekris et al., 2021). 

Advancements in genomic sequencing (Next-Generation Illumina sequencing) have also 

provided new vantage points to unraveling the origins of genetic and sporadic NDs (Pang 

et al., 2017; Zheng & Chen, 2022). However, carrying mutant-genes linked to NDs does 

not guarantee onset of these diseases, and thus there are environmental components that 

contribute to onset (Hampel et al., 2021; Pang et al., 2017). Therefore, by studying genetic-

linked NDs, the environmental factors that may contribute to sporadic NDs are also 

considered.  
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Recently, the repurposing of antimicrobial drugs to treat NDs, has added an 

additional layer of complexity to the study, suggesting peripheral origin of these diseases 

(Durães et al., 2018). For example, the intestinal epithelium (gut) and its vast metabolic 

function and gut microbiota (commensal) populations, heavily influenced by dietary 

lifestyles, have been implicated to have neuroprotective effects on the brain and even seed 

NDs in the gut when perturbed (Brudek, 2019; Castelli et al., 2021; Challis et al., 2020; Q 

Chen et al., 2019; Mertsalmi et al., 2020). Therefore, the pathogenesis of NDs may not be 

confined to the brain, but originate from interorgan-communication networks (axes), 

especially the Diet-Microbiota-Gut-Brain (DMGB) axis. Finally, since the gut may be a 

source of pathogenesis for NDs, finding alternative treatment options such as dietary 

changes, would help to prevent less side effects than current psychotherapeutics 

(Winiarska-Mieczan et al., 2020). Ultimately, providing accessible and inexpensive 

treatment options for all, to reduce global prevalence. 

 

1.1.1  Alzheimer disease: pathophysiology, pathology, and pathogenesis 

Dementias, such as AD, are the most common types of NDs and twice as prevalent 

in females than males (Mielke, 2018; Podcasy & Epperson, 2016; Y. Wang et al., 2020). 

The hallmark pathologies of AD have been identified in both sexes to negatively effect 

cognition such as long and short-term memory, and locomotor behaviour (Clancy, 2013; 

Da Costa et al., 2013; Ju et al., 2013; Levenson, et al., 2014; Podcasy & Epperson, 2016; 

Raskin et al., 2015). These hallmarks include misfolded protein oligomers (that aggregate) 

such as extracellular β-amyloid plaques and intracellular neurofibrillary tangles (NFTs, 

made of tau microtubule associated protein) (Hampel et al., 2021; Kou et al., 2011; 
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Mohandas et al., 2009; Tracy et al., 2022) (Figure 1). Moreover, neurons that possess these 

aggregates within or in proximity of the cell have compromised survival, and additionally 

promote the same fate to surrounding neurons (prion-like effects) (Guest, 2019; Morley et 

al., 2018; Raskin et al., 2015; Sarantseva et al., 2009; Shadfar et al., 2015). Damages to the 

cell as a result include oxidative stress, mitochondrial damage, and ultimately cellular death 

which triggers local to wide-spread inflammation in the brain and atrophy (Figure 1) 

(Ashraf et al., 2014).  

In particular, β-amyloid plaques have also been proposed to occur outside of the 

CNS, in the Enteric Nervous System (ENS) of the gut (Kowalski et al., 2019). This is 

because Amyloid Precursor Protein (APP) and β and γ secretases (which cleave APP into 

β-amyloid monomers) are regularly expressed in the enteric neurons (Kowalski et al., 2019; 

Sarantseva et al., 2009). Furthermore, preliminary studies in transgenic APP Mus musculus 

(mice) have identified that accumulation of β-amyloid in enteric neurons leaves mice more 

vulnerable to local inflammation of the gut (Chalazonitis & Rao, 2018; Kowalski et al., 

2009). Although the study of β-amyloids and AD in the gut is still in its infancy, there are 

many propositions as to how β-amyloids promote NDs in the brain from the gut 

(Chalazonitis & Rao, 2018). For example, a popular hypothesis is that β-amyloids are 

cross-seeded within the gut to the brain via an unknown mechanism of gut-brain 

communication (Braak et al., 2003; Kowalski et al., 2019). 

Recent evidence has demonstrated that soluble β-amyloid monomers play 

important roles in the regulation of synaptic neurotransmission, and have 

antimicrobial/antioxidant properties (helping prevent inflammatory injury) (Y. Li et a., 

2012; Mohandas et al., 2009). These monomers are therefore involved in facilitating 
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communication between neurons, injury prevention and recovery of brain tissue and even 

maintenance of Blood Brain Barrier (BBB) integrity that protects the immune-privileged 

brain (Mohandas et al., 2009). Since the ENS is just as vast in neuronal networks as the 

CNS, and neurodegenerative brain pathologies can also occur in the ENS (Braak et al., 

2003; Kowalski et al., 2019), then APP is likely neuroprotective in enteric neurons too. 

Thus, maintaining the integrity of the intestinal-epithelial-barrier of the gut, analogous to 

the BBB of the brain (Chalazonitis & Rao, 2018). The antimicrobial/antioxidant  role of 

APP in the CNS is thus justified in the ENS because, the gut epithelium is frequently self-

renewing to prevent injury and infection (Rath & Haller, 2022). The gut also has a diverse 

and protective microbiome which can be perturbed due to pathogenic infection/antibiotic 

use and/or local inflammation (Hakansson & Molin, 2011; Rinninella et al., 2019).  

The existence of β-amyloids are then possible in the ENS. However what triggers 

these pathologies to arise is unknown. It has been proposed that some bacterial species in 

the gut, such as Escherichia coli, can produce bacterial amyloids (Kowalski et al., 2019), 

which may also act like prions that could promote β-amyloid oligomerization and 

aggregation in the gut (Hetz & Saxena, 2017; Simon, 2018), or promote cleavage of APP 

into its Aβ42 β-amyloid isoform which is more prone to oligomerization (Bekris et al., 

2021; N. Li et al., 2019; Sarantseva et al., 2009; Simon, 2018). Aggregates therefore form, 

hindering ENS signaling, which then translates what is happening in the gut to the brain. 

The nature of this gut-brain communication has been hypothesized by Dr. Heiko Braak 

(Braak et al., 2003), that pathologies of NDs are likely to start in the gut and then, through 

an unknown mechanism of gut-brain communication, appear in the brain shortly after.  
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Tauopathies are an example of Braak’s hypothesis; similar to β-amyloid 

pathogenesis of NDs in the brain, tau monomers oligomerize and form aggregates known 

as NFTs and neuritic plaques, which can cause inclusions (inflammation due to intra/extra-

cellular damage) in and around neurons (Anwal, 2021; Bălaşa et al., 2020; Guest, 2019). 

In-fact, tauopathies have been found to occur decades before any clinical symptoms are 

present, and proposed to promote and intensify β-amyloid pathology (Kametani & 

Hasegawa, 2018). Moreover, both β-amyloid and also tau tangles/plaques both promote 

local intestinal inflammation and weakening of the gut epithelial barrier (Kowalski et al., 

2019). This weakened barrier can cause metaflammation (low-grade chronic systemic 

inflammation) linked to NDs (Komleva et al., 2021; Rydbom et al., 2021), thus gut-brain 

communication along the ENS may not be the sole contributor to NDs. The roles of tau 

and β-amyloid peptides are therefore likely to be amplifying neurodegenerative disease 

pathologies, like positive feedback. Therefore, the environment of the gut (the diet and 

commensals) may be distally seeding NDs in the brain in more ways than one (Berding et 

al., 2021); this is an example of communication within the DMGB axis (Figure 1).   

Although studies involving neurodegenerative disease-linked genes and peptides 

are very limited in DMGB axis research, the mechanisms of pathogenesis for both β-

amyloids and tau can be hypothesized using the rapidly expanding research on another 

neurodegenerative disease-linked gene for PD, known as α-Synuclein. Peptide α-

Synuclein, which also oligomerizes, creates extracellular lesion and has prion-like effects 

in the tissue it occupies, as does tau and β-amyloid (Bendor et al., 2013; Ruiz-Riquelme et 

al., 2018). Therefore, α-Synuclein is another potential candidate of  pathogenesis of NDs. 
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1.1.2  Parkinson disease: pathophysiology, pathology, and pathogenesis 

Parkinson disease is another common neurodegenerative disease, defined primarily 

by progressive loss of motor-coordination, initiation and bradykinesia due to death of 

dopaminergic neurons in the Substantia Nigra (SN) (Figure 1) (Dorsey et al., 2018; Faustini 

et al., 2017). According to sources such as (Dorsey et al., 2018), PD is one of the most 

rapidly growing NDs in the world, and males are more likely to develop these particular 

NDs than females (Feigin et al., 2019; Moisan et al., 2016; Podcasy & Epperson, 2016). 

Patients with PD may also develop AD later during the course of PD (high comorbidity). 

This is thought to be due to cross-related mechanisms of pathogenesis between the two 

NDs (Xie et al., 2014).  

Anatomically, PD begins with atrophy in the brain stem at the SN, an essential brain 

region that produces and projects dopamine to the limbic system, and then into higher 

cortical areas (Figure 1) (Mayfeild, 2010). These projections are known as the nigrostriatal 

pathways, and reach certain cortical areas which are known for initiating and coordinating 

movement (Figure 1), i.e. the basal ganglia (Faustini et al., 2017; Sonne, et al., 2022).   

Hallmark pathologies of PD include intracellular misfolded protein aggregates of α-

Synuclein oligomers (synucleinopathies) that form plaques called Lewy bodies in the SN 

(Figure 1) (Y. Huang et al., 2015; Shahmoradian et al., 2019; G. Wang et al., 2016). These 

intracellular inclusions are suspected to cause aberrant neurotransmission because, α-

Synuclein is a SNAP-associated protein in neurons (CNS/PNS/ENS) that tethers and 

primes pre-synaptic vesicles for exocytosis (Killinger et al., 2019). Similar to β-amyloids, 

α-Synuclein has been found in preliminary studies to appear in the gut/ENS (Devos et al., 
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2013), therefore, the peptide is not confined to driving neurodegenerative pathology in the 

brain only, just as Braak hypothesized (Braak et al., 2003).  

 In fact, α-Synuclein aggregates have been identified in the gut epithelium of 

humans years before clinical onset of PD, presenting non-motor symptoms in the forms of 

constipation, and Inflammatory Bowel Disease (IBD) (Barbut et al., 2019; Brudek, 2019; 

Q. Chen et al., 2019). IBD is influenced by the gut commensals (Custers et al., 2022; Dinan 

& Cryan, 2017; Hakansson & Molin, 2011; Moloney et al., 2016; Zeng et al., 2017), and 

therefore commensals are suspected to play a role in the formation of α-Synuclein Lewy 

bodies (Mertsalmi et al., 2020; Rinninella et al., 2019). IBD has also been linked to 

mitochondrial abnormalities in the gut (Jackson & Theiss, 2020), and PD (Brudek, 2019). 

Protein α-Synuclein aggregates have been found to cause mitochondrial damage by 

interacting with complex-I of the electron-transport-chain, and slowing down 

mitochondrial metabolism (Faustini et al., 2017; Kamp et al., 2010). This type of 

mitochondrial stress increases the redox state of intestinal epithelial cells and can create 

inflammation (Console et al., 2020; Friedman & Nunnari, 2014). Therefore, α-Synuclein 

may act just like β-amyloids and tau in AD, as a facilitator and amplifier of PD by seeding 

pathology in the gut to ultimately affect the brain (Braak et al., 2003; Kitani-Morii et al., 

2021).  

Recent evidence in mice has found that α-Synuclein may literally be seeded in the 

gut and then migrate to the brain via an unknown method of gut-brain communication.  For 

example, fluorescently tagged-α-Synuclein was inoculated into the intestines of the mice 

and then tracked (Challis et al., 2020). What the researchers found was that the tagged-α-

Synuclein translocated from the gut to the brain of the mice, and created human Parkinson-
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like behaviours. In addition, what was also observed after inoculation was abnormalities in 

GI function as well as inflammation, which is also characteristic of pre-clinical human PD 

patients described in the previous paragraph (i.e. constipation and inflammatory bowel 

disease) (Challis et al., 2020; Dinan & Cryan, 2017). Moreover, this study in particular 

suggested that α-Synuclein are metaphorically like seeds, and that the one who sows the α-

Synuclein is the gut-epithelium. Therefore, the metabolic status of the gut and commensals 

within the DMGB axis ultimately effect/promote prion-like protein aggregation. All that’s 

left to understand now is how this axis is perturbed (aetiologies of disease)  

Overall, PD and AD are two common NDs which have been studied on their own 

within the brain. However, as more evidence emerges on the pathogenesis of the canonical  

genes that characterize these diseases, it is becoming clear that the body is not only 

controlled and coordinated by the brain but, the body can communicate back and effect the 

brain. 

 

1.1.3  A holistic approach to studying neurodegeneration  

For decades the study of genetic-based NDs have generated several theories on  

sporadic disease pathogenesis (Garden & Spada, 2012), based on how the disease 

pathologically presents in the brain; including aberrant neurotransmission, mitochondrial 

dysfunction, and oxidative stress. However, emerging evidence has proven that cells are 

not autonomous between tissue types, as pathologies that were previously characterized in 

brains affected by NDs have also been found in distal parts of the body, such as the 

gut/ENS. An example would be α-Synuclein Lewy bodies found in enteric neurons (Barbut 

et al., 2019; Challis et al., 2020). Moreover, these findings highlight how NDs are not 
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confined to the brain as previously believed, and instead aid in bidirectional 

communication with the rest of the body for in inter-organ communication/coordination 

and the maintenance of tissue homeostasis  (McHugh & Gil, 2018; Peters, 2006). 

Especially communications within the DMGB axis briefly described below.  

One reason why NDs should be studied using a holistic approach is because of the 

role of peptide hormones as neurotransmitters (Hoffmann et al., 2021). Typically, the brain 

is known to secrete endocrine hormones (from the pituitary glad most of the time) to 

communicate and activate/deactivate physiological mechanisms in distal tissue/glands, to 

maintain energy balance throughout the body (Hoffmann et al., 2021, Sadiq & Tadi, 2022). 

Likewise, in vertebrates and invertebrates, distal organs such as the gut are also known to 

participate in endocrine (peptide hormone) signaling back with the brain, to balance energy 

expenditure, regulate growth, immunity, and stress of the gut, by coordinating metabolism 

and feeding behaviour (Hentze et al., 2015; Sadiqu & Tadi, 2022). The mechanism of 

action for regulating this energy homeostasis is still unclear. However, certain peptide 

hormones (neuropeptides, NPs) are suspected to be secreted by the gut, then bind and signal 

through neurons of the ENS to the CNS. For example, galanin in mammals is considered 

to be one of these NPs, which also has an orthologue in other animals such as Drosophila 

melanogaster (Hentze et al., 2015; Hoffmann et al., 2021; Min et al., 2016). Furthermore, 

NPs of the gut have also been implicated in AD and PD, because disturbances in gut 

metabolism/commensals can alter secretion of neuroprotective NPs like galanin (Wraith et 

al., 2009).  

Other ways of perturbing gut metabolism and gut-brain communication is through 

metabolic organelle stress/damage of peroxisomes and mitochondria (Rath & Haller, 2022; 
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Schrader et al., 2015). Both peroxisomes and mitochondria have been linked to 

neurodegeneration, and even share roles in Reactive Oxygen Species (ROS) homeostasis, 

which can cause inflammation and damage in the gut  (Petkovic et al., 2021; Yakunin et 

al., 2010; Yan et al., 2021). As introduced in section 1.1.1, inflammation of the gut 

epithelium in inflammatory/IBD have been identified in PD patients. This gut 

inflammation can be triggered by fatty diets, and changes of gut-commensal populations, 

triggering mitochondrial dysfunction; possibly peroxisomes too, since both organelles 

share similar metabolic roles (Console et al., 2020; Moloney et al., 2016) (to be discussed 

later). Inflammation of the gut can then weaken the intestinal epithelium, and allow 

opportunistic pathogens or inflammatory mediators in the gut to enter the systemic 

circulation, causing metaflammation, or exhausting the immune system enough to warrant 

immunosenescence (loss of proliferative ability by immune cells) (Komleva et al., 2021), 

leaving the individual more susceptible to infection and disease (especially NDs).  

Conclusively, approaching the study of NDs from a holistic point of view will help 

to uncover the aetiologies of disease, because environmental factors such as diet are highly 

considered in holistic general health. As of recently, the study of NDs and aetiologies of 

these diseases have been confined and focused on pathogenesis in the brain. However, 

emerging evidence is slowly proving that pathogenesis may be on a larger scale which 

includes, and may begin in other organs (such as the gut) (H. Chen et al., 2022; Q. Chen et 

al., 2019). Based on what has been introduced this far about AD, PD and holistic research 

of NDs, the best highly intertwined network of communication that can drive NDs when 

disrupted is the DMGB axis. 
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Figure 1. A visual summary of the physical and behavioural pathologies of Alzheimer 

and Parkinson diseases as a result of perturbing diet-microbiota-gut-brain axis 

communication. The gut (particularly the small intestine) forms a triad of communication 

and coordination with the gut microbiota and diet (nutrition). As depicted in the bottom 

left of the diagram, this cross talk within the triad effects organelle function and 

metabolism of the gut-epithelial cells, and by mechanisms that are still unclear, these 

messages are then relayed to the brain. As a consequence of perturbed gut-brain 

communication (sad face to the bottom left), protein aggregate pathologies have been 

implicated to arise (β-amyloid plaques, α-Synuclein Lewy bodies, and NFTs) of tau 

microtubule associated protein). Finally, by following the arrows rightward, these 

pathologies correspond to elevated ROS/oxidative stress and inflammation in the AD and 

PD brain, along with debilitating behavioural changes (on the right-most side of the 

diagram from top to bottom: Memory loss, dramatic shifts in mood, trouble 

communicating, trouble with organization (executive function), sleep and locomotor 

disturbances). 

Diagram constructed via https://app.biorender.com/. 
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1.2 Studying neurodegeneration in Drosophila melanogaster 

To study NDs in the brain is difficult, however to study highly-intertwined inter-

organ communication between the gut-epithelium, gut-commensals, and brain is even 

more challenging in a complex mammalian system. Therefore, by using the Drosophila 

melanogaster (fruit fly), a simpler invertebrate model which carries out similar gross organ 

function and inter-organ communication compared to a mammalian system, one can begin 

to study, hypothesize, and unravel NDs in a better controlled system (Cassim et al., 2018; 

Jeibmann & Paulus, 2009; Perrimon et al., 2016). Moreover, due to gene and metabolic 

homologies between both the fly, transgenic AD and PD models, that present similar 

behavioural/cellular pathologies to human NDs, have been successfully constructed 

expressing canonical human-linked alleles of NDs such as α-Synuclein and β-secretase 

(Cassim et al., 2018; Jahromi et al., 2020; Prüßing et al., 2013). Therefore, making human 

disease easier to study in a less complex organism.  

The humble fruit fly is an amenable model organism, considered one of the pioneers 

of genetic and inter-organ communication research (Bodine et al., 2021; Cassim et al., 

2018). For many reasons, the Drosophila remains the best model for fundamental research; 

the first reason being the simplicity of its four chromosome genome (Cassim et al., 2018). 

Next, the fly also has a low genetic redundancy and high homology/orthology to human 

disease-associated genes. For example, about 75% of disease genes in humans have a 

functional ortholog in Drosophila (Cassim et al., 2018). This allows the ability to create 

transgenic fly models, to easily study the function of specific mammalian/human-linked 

genes that may function in the same biochemical pathways in flies. Moreover, the 

Drosophila also has a large arsenal of genetic tools, which helps to manipulate the 
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expression of human-linked disease genes in a spatial and temporal manner in the fly 

(Cassim et al., 2018; Brand & Perrimon, 1993). One of the most powerful systems in the 

fly is known as the Gal4-UAS system which enables knock-in/out/down genetic 

manipulation (Figure 2) (Cassim et al., 2018). In particular, for this thesis the Gal4-UAS 

binary genetic system was used to create model flies for NDs.  

 

 

 

 

 

 

 

 

 

 

 

Figure 2. A simplified schematic of how the Gal4-UAS system works to drive gene 

expression in Drosophila melanogaster. A fly expressing Gal4 transcription factor 

exclusively in the midgut under a tissue specific promoter Mex (P1 or parent 1), is crossed 

to a fly line expressing under the enhancer UAS, a target gene sequence or inverted repeat 

of a target gene sequence for RNAi (P2 or parent 2). The filial generation (F1 Gen) will 

then express more or less of the target gene.   
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Many types of metabolic pathways in Drosophila have been identified as conserved 

with humans. This includes signalling pathways, such as immuno-inflammatory pathways 

Toll, JAK/STAT and immunodeficiency (Imd) in Drosophila, and equivalent TLR-4, 

JAK/STAT and NF-kB pathways in humans (Myllymäki et al., 2014; Hoffman, 2003; 

Hoffmann & Reichhart, 2002). In-fact, the Toll-pathway was first discovered in 

Drosophila by Dr. Jules Hoffmann before being translated into humans (Hoffmann & 

Reichhart, 2002; Lye & Chtarbanova, 2018). Additionally, about 80% of functional 

proteins that are orthologous to mammals have a conserved functional domain with 

mammals (Cassim et al., 2018). Therefore, metabolic discoveries in Drosophila have great 

potential to be translated into humans.  

Another important piece of information to remember is that Drosophila only have 

an innate and lack an adaptive immune system (Lye & Chtarbanova, 2018). These innate 

immune-inflammatory pathways, whether in humans or Drosophila, respond to infection 

and aging/injury by promoting expression of inflammatory Antimicrobial Peptides (AMPs) 

(Myllymäki et al., 2014). For human NDs, chronic systemic inflammation caused by the 

innate immune system (AMPs and inflammatory cytokines) can lead to inflammation of 

the brain (Arora & Ligoxygakis, 2020; Lye & Chtarbanova, 2018). Typically, AMPs 

during infection are neuroprotective, but when constantly present in the brain with aging, 

AMPs elicit neurotoxic effects leading to neurodegeneration (Cao et al., 2013; Kounatidis 

et al., 2017; Lye & Chtarbanova, 2018). For example, in the fly intestinal epithelium 

(midgut), when Relish (an Imd downstream transcription factor) was supressed and 

expression of AMPs was dampened, the outcome of age-dependant neurodegeneration  

improved (Cao et al., 2013; Lye & Chtarbanova, 2018). Therefore, studying NDs in the 
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Drosophila in the context of inflammation is ideal, because the fly shares three similar 

innate immune-inflammatory pathways with humans, and lacks the added complexities of 

an adaptive immune response to consider when unraveling pathogenesis of NDs.  

Chronic sterile inflammation has also been hypothesized to influence sporadic 

NDs, but still unclear how (Arora & Ligoxygakis, 2020; Katzenberger et al., 2013; Lye & 

Chtarbanova, 2018). The Drosophila Toll-pathway, which is linked to the over expression 

of pathogenic amyloid-beta 42 (Aβ42) in a transgenic AD model of Drosophila (Lye & 

Chtarbanova, 2018; Tan et al., 2008), and the Imd pathway have both been implicated in  

sterile inflammation of the brain during (Katzenberger et al., 2013). However, what about 

in the peripheral organs such as the midgut of the fly? 

The Drosophila gastrointestinal tract has been researched over decades in regards 

to interorgan communication (Capo et al., 2019; Hung et al., 2020). The midgut in 

particular is compared to the mammalian small intestine, and has very similar organization 

of epithelial cells (Capo et al., 2019), especially where the enterocytes of the fly also have 

bristle brush boarders, like humans, to help with food absorption/metabolism (Held, 2017). 

Additionally there are other important cells found in the gut such as enteroendocrine cells 

for hormone release and suspected to secrete important neuroprotective neurotrophic 

factors (Capo et al., 2019; Di Cara et al., 2018; Ma et al., 2019). Moreover, like humans, 

the Drosophila has a gut commensal community which is involved in metabolism and 

survival of the gut epithelium (Capo et al., 2019). Not only influencing disease in the fly 

when perturbed (as seen in transgenic neurodegenerative disease models of the fly, similar 

to humans (Mertsalmi et al., 2020; Rydbom et al., 2021), but also effecting the longevity 
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of the animal (Kitani-Morii et al., 2021; Neophytou & Pitsouli, 2022; Schretter, 2020; von 

Frieling et al., 2020).  

Drosophila also share other similarities in body organ function and interorgan 

communication to mammals, despite different anatomy 

(https://droso4schools.wordpress.com/organs/). For example, the nervous system of the fly 

has similar essential functional brain regions as mammals, such as the mushroom body for 

learning and memory, analogous to the mammalian hippocampus, and central complex for 

movement, comparable to the basal-ganglia and precentral gyrus in humans (Barnstedt et 

al., 2016; Gomez-Marin et al., 2016). Moreover, the nervous system of the fly and 

mammals share similar mechanisms of neurotransmission; for example, dopamine in 

dopaminergic neurons of the central complex facilitate locomotion, as the basal ganglia 

does in mammals (Martin & Krantz, 2014). Therefore, the findings of neurodegenerative 

disease research in the fly could be translated into humans, considering similar physiology 

on the cellular level.  

Finally, working with Drosophila is also easier when considering maintenance of 

the animal. The fly has an average generational time-span of approximately 10 days, and 

does not need much to survive; where small amounts of food changed regularly will suffice 

(Cassim et al., 2018; Fernández-Moreno et al., 2007). This generational time is faster than 

most mammalian models; for example, rats and mice which only produce a small litter of 

offspring every 3 weeks, compared to about one-hundred per-day for the fly (Cassim et al., 

2018). Therefore, Drosophila are perfect models for obtaining multiple biological 

replicates to confirm findings during experimentation, increasing statistical power (in other 

words, increasing the confidence that what is observed during experimentation is true or 

https://droso4schools.wordpress.com/organs/
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false), and is overall a powerful model organism. It is an indispensable tool for basic 

research in, genetic, developmental biology, aging, and behaviour (Marra et al., 2021). 

Considering all that was mentioned above, the Drosophila is one of the most versatile 

model organisms to study mechanisms of disease, especially as complex as NDs and 

interorgan communication (Figure 3). 

 

 

 

 

 

 

 

 

 

Figure 3. A visual summary of the many benefits of using Drosophila melanogaster as 

a model organism. Diagram constructed via https://app.biorender.com/. 

 

1.3  Introduction to the diet-microbiota-gut-brain axis. 

The diet-microbiota-gut-brain axis is a rapidly expanding area of research, 

suggesting that distal interorgan communication of the gut, gut-commensals and 

environment through food has an overall impact on the entire body, especially the brain 

https://app.biorender.com/
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(Carabotti et al., 2015; de Wouters d’Oplinter et al., 2021; Kitani-Morii et al., 2021). 

Dysfunction of this axis has been linked to NDs, such as AD and PD (Berding et al., 2021). 

In the following section, each component of the DMGB axis is summarized, giving 

examples of vast  multiple interactome of this axis, and how NDs have been linked to axis 

dysfunction.  

 

1.3.1 The diet 

Food is essential for replenishing energy expenditure however, the type of diets that 

are consumed can also dictate an individuals protection against or increase the risk for 

developing disease, especially NDs (Cena & Calder, 2020). For example, certain types of 

diets, such as the Mediterranean diet have been proven to have anti-inflammatory benefits, 

because this diet is rich with Short Chain Fatty Acids (SCFAs) that are considered to be 

neuroprotective (Cena & Calder, 2020; Joseph, 2017; McEvoy et al., 2017; Virmani et al., 

2013). In NDs such as AD, the alteration of cellular membrane lipids in the brain as well 

as lipid-based signaling moieties known as lipid-rafts, which can be influenced by dietary 

fat intake, have been found to impinge on the brains ability to resist/recover from 

incidences of oxidative/inflammatory stress (Denisova et al., 1998; Shen et al., 2004; 

Joseph et al., 2009). Certain lipid accumulation in the gut (like saturated fatty acids), can 

trigger systemic metaflammation and release of inflammatory mediators into the peripheral 

circulation, which can reach and enter the brain to promote vulnerability to 

inflammation/oxidative stress, by weakening the BBB, making neurons more accessible to 

these circulating inflammatory mediators (Joseph et al., 2017; Komleva et al., 2021)  
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Dietary lipids such as fatty acids (FAs) and their derivatives play multiple roles in 

cellular homeostasis throughout the body. The homeostatic functions of lipids include 

cellular membrane dynamics such as  structure of cells and fluidity (i.e. Phospholipids and 

cholesterols), signaling  (i.e. Phosphatidylinositol’s), and energy storage via high-energy 

bonds (Alberts et al., 2002; Hebbar et al., 2019). These processes are especially important 

in the brain, to maintain neuronal integrity, facilitate signal transduction between/within 

neurons via lipid-rafts and neurotransmission, and finally provide the brain with a backup 

source of energy (Mattson, 2005; Yaqoob & Shaikh, 2010). In-fact, in many NDs, essential 

lipids directly or metabolically derived from the diet, such as omega-3 FAs, plasmalogens, 

sphingolipids (like phospholipids) and ceramides (mediate lipid-rafts), are either 

accumulated in excess or lacking; this lipid imbalance has been identified in countless 

cases of NDs (Dinicolantonio & Keefe, 2020; Senanayake & Goodenowe, 2019; Swanson 

et al., 2012; Yaqoob & Shaikh, 2010). Moreover, in the Drosophila models of NDs, similar 

lipid metabolic disturbances are observed (J. Lee et al., 2011; Sellin et al., 2018: Van 

Veldhoven & Baes, 2013). This ultimately suggests that lipid-metabolism is highly 

involved  in the pathogenesis of NDs (Yadav & Tiwari, 2014) 

SCFAs in particular, the metabolic end-products of gut-commensal fermentation of 

fibrous food, not only have implicated neuroprotective roles, but also can influence 

neuroinflammation and neurodegeneration (Baxter et al., 2019; Custers et al., 2022; Dinan 

& Cryan, 2017; Onyango et al., 2015). SCFAs have also been linked to the maintenance 

of gut and immune homeostasis in mammalian systems, with a neuro-immunoendocrine 

regulatory role in the gut-brain axis (H. Chen et al., 2022; Silva et al., 2020). For example, 

dietary butyrate which participates in anti-inflammatory innate-immune system regulation 
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not only in the gut (i.e. IBD) (Baxter et al., 2019), but also in the brain by influencing BBB 

permeability (H. Chen et al., 2022). Concurrently, in Drosophila models of PD, the 

administration of sodium-butyrate was shown to reduce degeneration of dopaminergic 

neurons and improve the locomotor deficits, in a pan-neuronal transgenic fly model for 

mutant-human-linked α-Synuclein (St Laurent et al., 2013). SCFAs also protect intestinal 

barrier function, where a high-fat-diet has been found to increase intestinal permeability, 

which may allow access of opportunistic microbes/local inflammatory mediators to the 

blood-stream, and therefore creating metaflammation (Custers et al., 2022; Neophytou & 

Pitsouli, 2022). Therefore, dietary SCFAs can be neuroprotective or neurotoxic, depending 

on which SCFAs are in abundance (H. Chen et al., 2022).  

SCFAs are not the only FAs that can be neuroprotective and neurotoxic in relation 

to abundance. Very long chain fatty acids (VLCFAs, normally oxidized by peroxisomes), 

dietarily derived from vegetable oils, nuts and seeds (Letters, 2013), can be lipotoxic to 

any tissue when accumulated, and have been found in AD along with abnormal peroxisome 

function in the brain (Kou et al., 2011). On the other hand, VLCFAs are also component 

of sphingolipids and glycerophospholipids, which are extremely important for cellular 

structure and signalling in the CNS, PNS, and implicated in the ENS (Kurek et al., 2013; 

Sassa & Kihara, 2014). For example Docosahexaenoic Acid (DHA, 22:6n-3, a product of 

peroxisome metabolism), has been extensively studied in animals and humans for their 

neuroprotective roles in the body and brain, and for alleviating neurodegenerative disease 

symptoms (Custers et al., 2022; Dinicolantonio & Keefe, 2020; Swanson et al., 2012). In-

fact,  in Drosophila, it has already been identified in a study by (Di Cara et al., 2018), that 

peroxisomal dysfunction produces dysplasia of intestinal stem cells and elevated redox 
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status (inflammation) in the fly midgut. As well as aberrant lipid metabolism due to an 

accumulation of non-esterified fatty acids (as discussed above) in the guts of these 

Drosophila. In addition, Long Chain Fatty Acids (LCFAs) (oxidized by mitochondria) 

have roles in  reducing immune function, overwhelming mitochondria when accumulated, 

and inducing oxidative stress (Custers et al., 2022; Swanson et al., 2012). Therefore, 

dysfunctional mitochondria in the gut due to LCFA accumulation may cause abnormalities 

in neurotransmission of the ENS, by compromising gut integrity and ultimately creating 

an unstable inflammatory local environment in the gut (IBD), linked to NDs (Q. Chen et 

al., 2019).  

In humans and Drosophila, diet has an impact on inflammation locally (i.e. IBD) 

and systemically (i.e. metaflammation), but specific mechanisms of action are still 

unknown; the field of research pertaining to the diet-microbiota-gut-brain axis in the 

context of NDs is still in its infancy (Diop et al., 2017; Kitani-Morii et al., 2021). However, 

diets high in fats, and sugars can induce metabolic syndromes (insulin resistance), which 

can lead to decreased longevity, sleep abnormalities, locomotor defects, and mitochondrial 

dysfunction/inflammation in the gut and systemically in  both the fly and mammals 

(Komleva et al., 2021; Murashov et al., 2021).  

Other nutrients such as vitamins also play an important role in both the human and 

Drosophila for maintaining gut and brain health; such as antioxidant in fruits (i.e. 

blueberries), to counteract other foods, like fats, which are known to create free radicals 

that need to be detoxified in the gut (Hung et al., 2020; Komleva et al., 2021; Qi et al., 

2019). For the brain in particular, dietary vitamin group B, such as B3 (niacin), B9 (folic 

acid), and vitamin B12 (cobalamin) are known to effect learning, memory, and overall 
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cognition in both mammal studies (Staff & Windebank, 2014; Virmani et al., 2013). 

However, an excess of vitamins, B12 can be toxic to the body (Staff & Windebank, 2014). 

In both human and Drosophila, emerging evidence suggests that vitamin B3 (niacin) 

improves locomotor deficits of human PD patients and PD model flies (Jia et al., 2008; 

Wakade et al., 2021). The gut microbiota is also a source of such metabolites, especially 

of B-group vitamins (Morowitz et al., 2011; Virmani et al., 2013). Therefore, dietary 

metabolites that are not lipids may act in neuroprotective ways within the DMGB axis of 

humans and Drosophila to prevent the onset of NDs.  

In conclusion, the diet plays a large role in influencing brain health directly and 

indirectly. Despite a lack of clarity as to how certain dietary derived metabolites may 

mediate their neuroprotective or neuroinflammatory roles on the brain (of both humans and 

Drosophila), the effects of diet on gut-metabolism is limited without commensals to help 

break down and digest ingested nutrients. Thus gut microbiota dictate how dietary nutrients 

are digested.  

 

1.3.2 The gut microbiota  

In its abundance, the human microbiome is composed of around 10x more cells 

than cells of the human body  (>200 taxa) (J. Yang et al., 2020), acting as a major organ 

system vital for human survival. In-fact, dysbiosis of gut commensal populations leads to 

metabolic and inflammatory diseases of the gut, as diversity has been positively correlated 

with protection against NDs (Dinan & Cryan, 2017). With emerging evidence on host- 

commensal interactions, it is now recognized that neurological diseases, such as NDs are 

co-morbid with gastrointestinal disturbances (Sampson & Sarkis, 2015; Vandvik et al., 
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2004). Likewise, in human PD-linked mutant-gene models of Drosophila, the appearance 

of protein aggregates in the brain have been observed in concurrence with commensal 

dysbiosis in the gut (Kitani-Morii et al., 2021; Rydbom et al., 2021). In Drosophila, gut 

commensal diversity is not as magnificent (<30 taxa) (Newell & Douglas, 2014) however, 

there are many phylogenetically common species shared with humans, which makes this 

animal an amenable model to study fundamental gut-commensal interactions (Douglas, 

2018; Newell & Douglas, 2014; Trinder et al., 2017).  

In humans and Drosophila, the phyla Firmicutes dominates the gut, where the 

Firmicutes is composed of many Lactobacillus species, (Douglas, 2018; Newell & 

Douglas, 2014; Trinder et al., 2017). These Lactobacillus species have been found to 

influence host metabolism and behavioural pathologies of NDs in various gut-commensal 

studies in humans/mammals and the Drosophila (Newell & Douglas, 2014). Lactobacillus 

plantarum in mammals has also been found to influence gut-lipid metabolism, increasing 

butyrate (SCFAs) which is known to be anti-inflammatory (Storelli et al., 2011). In 

Drosophila L.plantarum also alters gut metabolism, such as  the TOR insulin signalling 

pathway, implicated in pathogenesis of NDs in both the fly and humans (Komleva et al., 

2021; Newell & Douglas, 2014; Spinelli et al., 2019; Storelli et al., 2011). Moreover, 

L.plantarum has also been found to influence AD effected behaviours (such as memory) 

of humans/mammals. For example, the abundance of L.plantarum ameliorates age-

dependant memory impairment in Mus musculus (mouse) models of PD (Castelli et al., 

2021). This species also ameliorates mating-preference memory of Drosophila, which is 

effected in fly models of NDs (Schretter, 2020; Schretter et al., 2018). Furthermore, a 

species that effects locomotion, which is the hallmark negative symptom (a behaviour that 
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is reduced from what is considered normal behaviour) of PD, in humans is unknown, 

however in Drosophila that species is considered to be Lactobacillus brevis (Schretter et 

al., 2018). Therefore, Lactobacillus species may be the culprits behind PD pathogenesis in 

the gut. So, by studying the fundamentally microbiota of the fly in the DMGB axis, species 

that influence NDs and the aetiologies which effect those species may be unraveled in 

humans.  

It is now known that the gut microbiota affect host signaling, nutrition/metabolism, 

intestinal barrier function, and co-adapted with the immune system to counteract infection 

(Hakansson & Molin, 2011; Newell & Douglas, 2014; Rinninella et al., 2019). Moreover, 

the commensals are heavily involved with the immune system in the context of 

inflammation. As previously discussed, the gut microbiota can bring on metaflammation 

by elevating the redox status of the gut, thus weakening the gut epithelium, all events linked 

to NDs (Kowalski et al., 2019). In-fact it has been demonstrated that the species that 

colonize the gut pre and postnatally may increase the risk of metaflammation and of 

developing neurological disorders later on in adulthood (Grochowska et al., 2019; Ma et 

al., 2019; Silva et al., 2020). However, it has also been proposed that commensal or 

pathogenic bacterial secretions, of prion-like peptides, may trigger other proteins in the gut 

that are sensitive to misfolding and oligomerization to aggregate, such as α-Synuclein (S, 

Chen et al., 2016; Q, Chen et al., 2019). Then, these misfolded proteins will somehow 

trigger protein aggregation of NDs peptides in the brain via the vagus nerve (Braak et al., 

2003). This hypothesis was confirmed with preliminary data of Rattus norvegicus (lab rat) 

fed with bacteria that produce prion-like curli, where brain neuronal α-syn deposition is 

increased in the gut and brain (S. Chen et al, 2016) 
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In conclusion, the communication of the gut-commensals with the CNS is 

becoming increasingly recognized in the context of NDs, as gut commensals have been 

discovered to influence the secretion and production of important neuroprotective 

metabolites, and promote or prevent inflammation in parallel innate immunity. However, 

the microbes cannot carry out all of these communicative functions without interacting first 

with the host through the intestinal epithelium.  

 

1.3.3 The intestinal epithelium 

The intestine literally has a mind of its own, hosting an ENS with a neuron density 

much greater than that of the CNS. The gut is also proposed to secrete important 

neuroprotective neurotrophic factors, which promote neuron survival and plasticity. For 

example, Brain Derived Neurotrophic Factors (BDNFs) that are produced by gut 

epithelium are suggested to affect the development and survival of vagal nerve afferents. 

The vagus nerve is the major route of sensory information of the gut to the brain, and one 

proposed route of DMGB axis communication (Braak et al., 2003; Biddinger & Fox, 2014). 

Damage to the vagal afferents is expected to perturb feeding, and therefore the overall 

metabolism of an organism, directly and indirectly effecting the brain (Biddinger & Fox, 

2014). Moreover, the gut also integrates information from the environment, and resident 

immune system (the gut microbiota), in order to relay to other organs, including the brain, 

to protect against oxidative stress and cell death.  

As mentioned above, digested and processed metabolites in the gut after a meal 

may communicate to the brain via two ways, the systemic circulation, or the vagal nerve 

through the ENS. In particular, some of these secretions have been identified as 
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neuroprotective trophic factors (Liu, 2018), in the ENS, but also CNS and PNS; this is true 

for humans, and proposed for Drosophila gut communication (Di Cara et al., 2018). 

Therefore, the disruption of gut metabolism due to dramatic changes in diet and commensal 

populations, may disrupt these neuroprotective trophic factors, causing the brain to become 

more vulnerable to infection and disease, especially NDs. For example, a BDNF in 

humans, orthologous to Drosophila Neurotropin 1 (DNT1), is neuroprotective in the brain. 

However, when released from the gut, is also known to protect the death of enteric glial 

cells which are vulnerable to local inflammation, therefore protecting the support cells of 

enteric neurons, and in-turn the enteric neurons and vagal afferents (Steinkamp et al., 

2012). In fact, in a study conducted by (Vidal-Martínez et al.,  2016),  it was suggested that 

gut-derived BDNF may protect enteric neurons against damage caused by misfolding α-

Synuclein.  

To recapitulate what was previously introduced, emerging evidence has linked 

commensal dysbiosis to local and systemic inflammation, promoting NDs and 

corresponding pathologies (Q. Chen et al., 2019; Campos-Acuña et al., 2019).  Moreover,  

it has been speculated that signals of inflammation from the gut may be relayed to the brain 

by the enteric nervous system, via the vagus nerve (a telephone wire-like, major axonal 

highway to the brain) (Breit et al., 2018). Thus the gut acts more like the relay center in the 

DMGB axis, receiving, processing and distributing information to the brain from the diet 

and gut commensals. However, just like a game of ‘telephone’, if the person (the gut) 

receiving the messages cannot hear properly (abnormal metabolic/physiologic function), 

then the message will not be relayed correctly which may be disastrous (NDs). One 
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organelle in particular, known as the peroxisome, is the ‘deafening’ factor to consider 

within DMGB axis communication. 

 

1.4 Introduction to the peroxisome  

The peroxisome is a highly metabolic cellular organelle, present in virtually every 

cell of the body and conserved across eukaryotes, from yeast to humans (Baron et al., 2016, 

Smith & Aitchison, 2013). This busy organelle participates in a broad range of conserved 

cellular-metabolic processes, most notably β-oxidation of VLCFAs, the anabolism and 

catabolism of complex lipids such as ether phospholipids (like plasmalogens), and 

synthesis and turnover of  Reactive Oxygen and Reactive Nitrogen Species (ROS/RNS). 

These metabolites are essential for supporting cellular energetic processes, limiting redox 

stress, maintaining cell structure, signalling, and mitigating inflammation (Di Cara, 2020; 

Smith & Aitchison, 2013). Moreover, peroxisomes tightly coordinate these processes with 

other organelles such as mitochondria (Schrader et al., 2015), especially for oxidative 

homeostasis of the cell to prevent apoptosis. However, the extent to which peroxisomes 

interact, and may regulate the function of other organelles such as mitochondria, is still 

unclear (Tanaka et al., 2019).  

 All operations that make and keep the peroxisome functional are mediated by 

peroxisomal proteins known as peroxins (PEX). The loss of peroxisome function, as a 

consequence of PEX mutations, causes Peroxisome Biogenesis Disorders (PBDs). This 

autosomal recessive spectrum disorder in humans can be mimicked and has been studied 

in animal models such as Mus musculus, and Drosophila melanogaster with the same PEX 
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mutations (Hiebler et al., 2014; Klouwer et al., 2015; Mast et al., 2011; Yakunin et al., 

2010). Of the roughly 30 known peroxins (Smith & Aitchison, 2009), 14 are known in 

humans to cause PBD if mutated (Klouwer et al., 2015). The most common peroxin to 

cause PBDs is PEX1 (Hiebler et al., 2014; Smith & Aitchison, 2013), which is involved in 

the ubiquitination step required to recycle PEX5 and PEX7, that act as receptors to bind 

and transport essential peroxisomal enzymes to the peroxisome (Smith & Aitchison, 2013). 

PBDs manifest as aberrant multi-organ developmental diseases. Clinically, children born 

with PBDs presents with facial malformations, neurodevelopmental delays, learning 

disabilities, and general behavioural changes (Klouwer et al., 2015). However, the 

consequences of peroxisome dysfunction are not limited to development, but also have 

been implicated in the onset and progression of other disease pathologies, such as NDs 

later on in life.  

 

1.4.1  Peroxisomes as modulators of the DMGB axis  

In many NDs, such as AD and PD, increased peroxisome numbers and metabolic 

disturbances linked to the organelle within neurons of the brain have been identified 

(Cipolla & Lodhi, 2017; Kou et al., 2011). In particular, lipid profile changes in the brain 

are a characteristic of NDs. This is demonstrated in lipid composition analysis of post-

mortem brains of AD patients in which an accumulation of VLCFAs, substrates of 

peroxisome β-oxidation, were found (Kou et al., 2011). There is also a parallel decrease in 

ether-phospholipids, products of peroxisomal metabolism, (Kou et al., 2011), which have  

antioxidant properties necessary for reducing ROS-mediated oxidative stress and 

preventing cellular death/tissue inflammation respectively. These ether-phospholipids 
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include plasmalogens (Kuczynski & Reo, 2006), which can be found in both white and 

grey matter of the brain and are known to be neuroprotective (Estes et al., 2021; Liu & 

Zhang, 2014; Su et al., 2019). VLCFAs, or their precursors, are primarily derived from diet 

even though both can also be endogenously synthesized by peroxisomes. This suggests that 

abnormal peroxisomal metabolism regardless of breakdown or synthesis of VLCFAs, can 

lead to inflammation. Although evidence of peroxisome dysfunctions in the development 

of NDs in the brain has received substantial attention, there is a paucity of research into the 

contribution that gut peroxisomes play via the DMGB axis. 

Lipids are very important for cellular structure, cytoskeletal dynamics, and intra- 

and inter-cellular signalling, and neuron survival (Custers et al., 2022). Interestingly, in 

AD, peroxisomes are absent from the dendritic/bouton projections of the neurons and 

instead cluster at the soma (Kou et al., 2011). In addition, in areas of low peroxisomal 

localization, AD pathologies such as protein aggregate pathologies are apparent (Kou et 

al., 2011). This suggests that peroxisome dysfunction is affecting cytoskeletal dynamics 

such as cellular trafficking, and therefore their own ability to localize to other areas of the 

cell where needed, such as the plasma membrane for signalling purposes. Cytoskeletal 

remodelling defects are common in pathophysiology’s of NDs, especially 

synucleinopathies of PD which exhibit dysfunctional vesicle trafficking and exocytosis of 

neurotransmitters. Given the crucial role peroxisomes play in the remodelling of the 

cytoskeleton (Di Cara et al., 2017), it is plausible that peroxisome dysfunctions could also 

underlie intestinal synucleinopathies observed in the ENS of humans and mice. For 

example, in PBD mouse models, peroxisome dysfunction is associated with α-Synuclein 

oligomerization and deposition (Yakunin et al., 2010). Additionally, recent work shows 
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that Drosophila peroxisome dysfunction in macrophage-like cells (hemocytes), alters the 

cells lipid-profile and in-turn impedes cytoskeletal remodelling (for phagocytosis) (Nath 

et al., 2022). This suggests that the association between intestinal peroxisomes and α-

Synuclein promote pathologies of NDs in the gut epithelium and/or ENS.   

As mentioned previously, α-Synuclein plaques have been identified in the gut and 

enteric neurons of PD patients prior to the onset of disease, as well as in cases of 

inflammatory diseases that compromise the gut epithelial barrier (Challis et al., 2020; 

Derkinderen  et al., 2021; Hawkes et al., 2010). Likewise, peroxisome dysfunction has 

been found to compromise the integrity of the gut, by activating Tor kinase dependant 

autophagy and  promoting  dysplasia of the gut epithelium, as reported in Drosophila gut-

specific peroxisome KD models by (Di Cara et al., 2018). In this way, peroxisomes were 

also found to modulate the gut microbiota (Di Cara et al., 2018), further suggesting that 

perturbation of gut-commensals promotes local and systemic inflammation and altered 

lipid metabolic profiles corresponding to onset of NDs.  

There remains a lot that is still unknown or unclear about how peroxisomes of the 

gut may contribute to the pathogenesis of NDs, since this organelle is overlooked even as 

a potential metabolic regulator within the gut, let alone in the DMGB axis. However, 

peroxisomes may also influence the secretion of BDNF, promoting the survival of neurons 

in the CNS and PNS of both humans and Drosophila (Braverman et al., 2013; Di Cara, 

2020). This evidence supports a potential role for peroxisomes in the secretion of 

neuroprotective neurotrophic factors from the gut to the brain. Therefore, I hypothesize 

that peroxisomes in the gut are important modulators of the DMGB axis, and when 

perturbed can lead to the development of NDs (Figure 4). 
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Figure 4. The hypothesis as a visual summary: peroxisomes are important 

modulators of the diet-microbiota-gut-brain axis in Drosophila melanogaster. 

Peroxisomes are proposed to integrate signals from the gut microbiota and environment 

such as the diet in order to communicate with the brain in a neuroprotective way. If 

peroxisomes are thus rendered dysfunctional in the gut, neurodegenerative diseases may 

develop in the fly. Diagram partially constructed via https://app.biorender.com/. 
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1.5  Thesis hypothesis: perturbed peroxisomes in the intestinal epithelium 

modulate neurodegeneration through the DMGB axis 

I hypothesized that peroxisomes in the gut are important modulators of the DMGB 

axis, and when perturbed can lead to NDs. To test this hypothesis in the simpler Drosophila 

melanogaster model, I knocked down Peroxin 5 (PEX5) in the midgut of the fly. PEX5 is 

an essential transporter of peroxisome-targeted matrix enzymes, and a depletion of PEX5 

would mean a depletion of peroxisome metabolic capacity, thus compromising metabolism 

in the gut (Smith & Aitchison, 2013). I constructed this genotype by crossing a fly 

expressing the Gal4 transcription factor exclusively in the midgut under a tissue specific 

promoter (Mex-Gal4) (P1 in Figure 2), to a fly line expressing an inverted repeat of PEX5 

(Mex>Pex5-i) under the enhancer UAS (P2 in Figure 2); yielding a knockdown of PEX5 in 

the midgut of these animals (F1 in Figure 2). Additionally, I used the Gal4-UAS system to 

overexpress canonical human-linked mutant-alleles of NDs; α-Synuclein (Mex>SNCA) 

and β-secretase (Mex>BACE), as gut-specific reference models for NDs. These models 

aimed to not only compare the consequences of peroxisomal dysfunction to well known 

mutant alleles of NDs, but also look at what disturbing mitochondria, therefore metabolism 

in the midgut, would have on the fly brain. This is because, mitochondria and peroxisomes 

share close metabolic interactions within the cell, such as fatty acid -oxidation.  

To begin testing the hypothesis, I first wanted to confirm through behavioural 

assays that the brain was effected as a result of altering transcriptional expression of PEX5 

in the gut (Figure 5). Therefore I primarily used negative geotaxis climbing assays to test 

locomotor ability of my genotypes for both sexes as a common measure of NDs in 

Drosophila (Madabattula et al., 2015). For Mex>Pex5-i, the sex where I observed a deficit 
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in Negative Geotaxis Climbing Ability (NGCB) were primarily the males on normal 

Cornmeal conditions (CM); all other genotypes were effected by their overexpression of 

canonical human-linked neurodegenerative disease-genes  in the gut. I then conducted 

these climbing assays again on different dietary conditions, such as high fat (HFD), and 

antibiotic treated/axenic (AX) conditions, to test the effects of dramatically altering diet 

and gut microbiota populations.  

After observing climbing deficits of the males on normal conditions, I then wanted 

to confirm whether any behavioural phenotype in Mex>Pex5-i, Mex>BACE and 

Mex>SNCA references were neurobehavioral and not due to feeding nor developmental 

defects of the heart. Thus, in collaboration with Dr. Deniz Top, we carried out feeding 

assays on the Mex>Pex5-i and Mex>SNCA male flies, and respective driver controls 

Mex>w1118 and Mex>GFP. To test the heart of the aforementioned genotypes, we 

collaborated with Dr. Hua Bai at Iowa State University. Moreover, as another mean of 

assessing behaviour of NDs in the flies, I also looked at memory of the flies in collaboration 

with Dr. Jamie Kramer at Dalhousie University, to stress the effect of peroxisome 

metabolic dysfunction in the gut, on memory. Additionally, to try and counteract any 

neurobehavioral phenotypes I observed, and in order to begin unraveling a mechanism of 

action, I treated Mex>Pex5-i and Mex>SNCA male flies where a decline of climbing 

phenotype was observed, compared to respective driver controls, with niacin (vitamin B3). 

Then I assessed these treated and non treated flies for improvements of climbing behaviour 

in parallel with ROS (H2O2) quantification in the brains of treated and un-treated flies as 

well. I did this because, niacin is reported to improve locomotion deficits in flies, which 

may be involved in a peroxisome-linked gut-brain communication pathway. These findings 



35 
 

were further confirmed using fluorescent ROS maker dihydroethidium (DHE) to visualize 

ROS accumulation in the CM Mex>Pex5-i and Mex>SNCA male brains.  

After confirming a behavioural phenotype in the males, I looked at inflammation 

and structural/functional abnormalities in the brain in Mex>Pex5-i and control Mex>w1118, 

and Mex>SNCA and control Mex>GFP (Figure 5). To do this I looked at redox 

accumulation according to expression of AMPs in the brains of the aforementioned male 

models, via insect AMP Attacin (Att) and Drosomycin, and inflammatory cytokine 

Unpaired-3 (Upd3), associated with sterile inflammation (Kenmoku et al., 2017). Next, 

since ROS accumulation was confirmed in these male brains, and accumulation has been 

linked to mitochondrial abnormalities, using Transmission Electron Microscopy (TEM), I 

looked for mitochondrial abnormalities in the brains, such as mitophagy or abnormal 

cristae patterns. These results were then confirmed using MitoSOX®, a stain for superoxide 

accumulation in mitochondria which indicates mitochondrial stress.  

Additionally, to look at structural/functional abnormalities in the brain as a result 

of any inflammation identified, I specifically looked at the Dopaminergic (DA) neurons 

using the antibody Tyrosine Hydroxylase (TH), since death of these neurons in humans 

and Drosophila with PD/PD-like pathologies have been identified along with locomotor 

disturbances. I focused on two clusters known as Protocerebral Anterior Medial (PAM) 

and Protocerebral Posterior Lateral 1 (PPL1) DA neurons.  

Finally, after looking at the behavioural changes of the flies, to further investigate 

a mechanism of action for any neurobehavioral phenotype observed, I performed -omic 

screens on the Mex>Pex5-i midguts. For this thesis, I focused primarily on the 

transcriptomic screens of the gut (Figure 5), to try and identify a peroxisome mediated 
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DMGB axis communication pathway. The transcriptomic analyses were carried out on the 

guts of Mex>Pex5-i and respective driver controls Mex>w1118 on different food conditions. 

I then used QIAGEN™ open access analysis bioinformatic tool GeneGlobe™ to run an 

enrichment analysis of the transcriptomic screens, and identified genes that encode for 

neuropeptides and their receptors as potential hits; which are common signaling 

molecules/receptors from the gut to brain. These NPs/NPRs were then validated, and tested 

in the two sexes and conditions High Fat Diet, and Axenic (AX, antibiotic cocktail) 

separately over aging, in order to identify hits that were comparable to the behavioural 

assays. Additionally, I completed genetic manipulation of our strongest gene hit Myo-

inhibitory peptide (Mip), to see how behaviour is effected with overexpression of Mip in 

the midgut. This was done to begin identifying the first block of a potential mechanism by 

which Mip and the other potential transcriptomic hits cause brain inflammation, neuronal 

death, and abnormal behaviour through the DMGB axis.  

Conclusively, my project is a novel study in the rapidly expanding field of ND 

research pertaining to the DMGB axis because, the peroxisome is an overlooked organelle 

when it comes to studying diseases other than PBDs in the brain, let alone in the gut. With 

this thesis, I hope to bring to light that the peroxisome is as important to disease 

pathogenesis anywhere in the body as other organelles such as mitochondria. Additionally, 

I aim to contribute to the urgent and ever expanding field of NDs research in hopes of 

finding a cure or better treatment options to alleviate global disease burden.  
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Figure 5. A visual summary of the three main objectives employed to test the 

hypothesis. Hypothesis: perturbed peroxisomes in the intestinal epithelium modulate 

neurodegeneration through the DMGB axis. After knocking down peroxisome function in 

the midgut of the fly (MexPex5-i), three main objectives were carried out as outlined. 1) 

negative geotaxis climbing assays and courtship short-term memory assays to investigate 

locomotor and memory deficits that arise from neurodegeneration, 2) to look at neuron 

survival and activation in the brain by assessing brain inflammation/oxidative status/cell 

death and the abundance of active metabolic factors (such as TH in DA), and 3) carry out 

-omic screens of the midgut, transcriptomic is priority, to further investigate a peroxisome-

linked DMGB axis mechanism of communication.  
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CHAPTER 2: MATERIALS AND METHODS 

2.1 Behavioural studies  

2.1.1  Ethics statement  

There are no ethical issues surrounding invertebrate models, such a the Drosophila 

melanogaster (fruit fly), for experimentation.   

 

2.1.2  Drosophila  stocks and husbandry   

All active Drosophila melanogaster fly strains/crosses were maintained at 25°C in 

an incubator set at 60% humidity with a 12hr light:dark cycle. Multiple 46 mL 

polypropylene Drosophila food vials (AS507, ThermoFischer Scientific™) of necessary 

crosses were set up for each experiment, to ensure enough female and male flies in the 

filial progeny (F1) eclose. The virgin females (driver strains) used to make each cross were 

primarily of a transgenic strain that carries a P element expressing the midgut-specific 

driver Mex-Gal4, integrated into the Drosophila genome on the X-chromosome 

(Bloomington Drosophila Stock Center, BDSC:91367, P{w[+mC]=mex1-GAL4.2.1}9-1, 

y[1] w[1118]). Collected virgins were separated from males until sexual maturity 

(normally aged to 2-4 days old (do) for optimal mating). Mature virgin females were then 

crossed with males of w1118 (BDSC:5905, w[1118]), UAS-Pex5 RNA-i (Vienna 

Drosophila Resource Center, VDRC:42332, w[1118]; P{GD14972}v42332), UAS-GFP 

(BDSC:5137, w[1118]; P{w[+mC]=UAS-mCD8::GFP.L}LL5, P{UAS-

mCD8::GFP.L}2), UAS-SNCA (BDSC:51375, w[1118]; P{w[+mC]=UAS-

SNCA.J}1/CyO), UAS-BACE (BDSC:29877, w[1118]; P{w[+mC]=UAS-BACE1.L}2), 

and UAS-Mip (Korean Drosophila Resource Center, KDRC:10027, w[1118](I); P(UAS-
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Mip) vie72a (II)). Additionally, another enterocyte driver used in the midgut was Myo1Ats-

GAL4; Tub-GAL80ts, UAS-GFP (Jiang et al., 2009) (A kind gift from Dr. Edan Foley, 

University of Alberta). This driver was crossed to UAS-Cas9 (BDSC:54595, w[1118]; 

P{y[+t7.7] w[+mC]=UAS-Cas9.C}attP2) and sgRNA Pex3 (A strain made in the Di Cara 

Lab) separately. Finally, a brain driver used to express UAS-BACE as a brain-only positive 

control was Elav-Gal4 (BDSC:458, P{w[+mW.hs]=GawB}elav[C155]). Moreover, 

crosses of interest were always set in parallel with controls for same day eclosure of F1 

adults (Table 1), to ensure aged-matched mutants and controls on the day of assay. 

Table 1. Table of relevant crosses. Drosophila follow Mendelian genetic inheritance. The 

following table highlights this method of inheritance with a list of all the crosses 

constructed for this thesis project. Drosophila have four chromosomes; the 1st (X/Y), and 

2nd and 3rd (autosomal) only are used for genetic manipulation. 

 

Crosses F0 F1 ♂ F1 ♀ 

(Mex GAL4  ☿) x (w1118 ♂) 

𝑀𝑒𝑥 𝐺𝐴𝐿4

𝑀𝑒𝑥 𝐺𝐴𝐿4
;

+

+
;

+

+
   x  

𝑋

𝑌
;

+

+
;

+

+
 

 

𝑀𝑒𝑥 𝐺𝑎𝑙4

𝑌
;
+

+
;
+

+
 

 

𝑀𝑒𝑥 𝐺𝑎𝑙4

𝑋
;
+

+
;
+

+
 

(Mex GAL4  ☿) x (UAS PEX5 RNAi ♂) 

𝑀𝑒𝑥 𝐺𝐴𝐿4

𝑀𝑒𝑥 𝐺𝐴𝐿4
;

+

+
;

+

+
   x  

𝑋

𝑌
;

𝑈𝐴𝑆 𝑃𝐸𝑋5 𝑅𝑁𝐴𝑖

𝑈𝐴𝑆 𝑃𝐸𝑋5 𝑅𝑁𝐴𝑖
;

+

+
 

 

𝑀𝑒𝑥 𝐺𝑎𝑙4

𝑌
;
𝑈𝐴𝑆 𝑃𝐸𝑋5 𝑅𝑁𝐴𝑖

+
;
+

+
 

 

𝑀𝑒𝑥 𝐺𝑎𝑙4

𝑋
;

𝑈𝐴𝑆 𝑃𝐸𝑋5 𝑅𝑁𝐴𝑖

+
;
+

+
 

(Mex Gal4  ☿) x (UAS GFP/Cyo♂) 

𝑀𝑒𝑥 𝐺𝑎𝑙4

𝑀𝑒𝑥 𝐺𝑎𝑙4
;

+

+
;

+

+
   x  

𝑋

𝑌
;

𝑈𝐴𝑆 𝐺𝐹𝑃

𝐶𝑦𝑜
;

+

+
 

 

𝑀𝑒𝑥 𝐺𝑎𝑙4

𝑌
;
𝑈𝐴𝑆 𝐺𝐹𝑃

+
;
+

+
 

 

𝑀𝑒𝑥 𝐺𝑎𝑙4

𝑋
;
𝑈𝐴𝑆 𝐺𝐹𝑃

+
;
+

+
 

(Mex Gal4  ☿) x (UAS SNCA/Cyo♂) 

𝑀𝑒𝑥 𝐺𝐴𝐿4

𝑀𝑒𝑥 𝐺𝐴𝐿4
;

+

+
;

+

+
   x  

𝑋

𝑌
;

𝑈𝐴𝑆 𝑆𝑁𝐶𝐴

𝐶𝑦𝑜
;

+

+
 

 

𝑀𝑒𝑥 𝐺𝑎𝑙4

𝑌
;
𝑈𝐴𝑆 𝑆𝑁𝐶𝐴

+
;
+

+
 

 

𝑀𝑒𝑥 𝐺𝑎𝑙4

𝑋
;
 𝑈𝐴𝑆 𝑆𝑁𝐶𝐴

+
;
+

+
 

(Mex Gal4  ☿) x (UAS BACE♂) 

𝑀𝑒𝑥 𝐺𝐴𝐿4

𝑀𝑒𝑥 𝐺𝐴𝐿4
;

+

+
;

+

+
   x  

𝑋

𝑌
;

𝑈𝐴𝑆 𝐵𝐴𝐶𝐸

𝑈𝐴𝑆 𝐵𝐴𝐶𝐸
;

+

+
 

 

𝑀𝑒𝑥 𝐺𝑎𝑙4

𝑌
;
𝑈𝐴𝑆 𝐵𝐴𝐶𝐸

+
;
+

+
 

 

𝑀𝑒𝑥 𝐺𝑎𝑙4

𝑋
;
 𝑈𝐴𝑆 𝐵𝐴𝐶𝐸

+
;
+

+
 

(Mex Gal4  ☿) x (UAS Mip♂) 

𝑀𝑒𝑥 𝐺𝐴𝐿4

𝑀𝑒𝑥 𝐺𝐴𝐿4
;

+

+
;

+

+
   x  

𝑋

𝑌
;

𝑈𝐴𝑆 𝑀𝑖𝑝

𝑈𝐴𝑆 𝑀𝑖𝑝
;

+

+
 

 

𝑀𝑒𝑥 𝐺𝑎𝑙4

𝑌
;
𝑈𝐴𝑆 𝑀𝑖𝑝

+
;
+

+
 

 

𝑀𝑒𝑥 𝐺𝑎𝑙4

𝑋
;
𝑈𝐴𝑆 𝑀𝑖𝑝

+
;
+

+
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Table 1. continued. Table of relevant crosses 

Crosses F0 F1 ♂ F1 ♀ 

(Myo1Ats-Gal4 ☿) x  

(UAS Cas9 ♂) 

𝑋

𝑋
;

𝑀𝑦𝑜1𝐴[𝑡𝑠]−𝐺𝑎𝑙4

𝐶𝑦𝑜
;

𝑇𝑢𝑏−𝐺𝑎𝑙80[𝑡𝑠],
𝑈𝐴𝑆−𝐺𝐹𝑃

𝑇𝑚6 𝐵
   

x  
𝑋

𝑌
;

+

+
;

𝑈𝐴𝑆 𝐶𝑎𝑠9

𝑈𝐴𝑆 𝐶𝑎𝑠9
 

 

𝑋

𝑌
;
𝑀𝑦𝑜1𝐴[𝑡𝑠] − 𝐺𝑎𝑙4

+
; 

     

𝑇𝑢𝑏 − 𝐺𝑎𝑙80[𝑡𝑠],
𝑈𝐴𝑆 − 𝐺𝐹𝑃
𝑈𝐴𝑆 − 𝐶𝑎𝑠9

 

 

𝑋

𝑋
;
𝑀𝑦𝑜1𝐴[𝑡𝑠] − 𝐺𝑎𝑙4

+
; 

      

𝑇𝑢𝑏 − 𝐺𝑎𝑙80[𝑡𝑠],
𝑈𝐴𝑆 − 𝐺𝐹𝑃
𝑈𝐴𝑆 − 𝐶𝑎𝑠9

 

(Myo1Ats-Gal4 ☿) x  

(sgRNA PEX3 ♂) 

𝑋

𝑋
;

𝑀𝑦𝑜1𝐴[𝑡𝑠]−𝐺𝑎𝑙4

𝐶𝑦𝑜
;

𝑇𝑢𝑏−𝐺𝑎𝑙80[𝑡𝑠],
𝑈𝐴𝑆−𝐺𝐹𝑃

𝑇𝑚6 𝐵
 x  

𝑋

𝑌
;

 𝑈6−𝑠𝑔𝑅𝑁𝐴 𝑃𝐸𝑋3 𝐾𝑂

𝐶𝑦𝑜
; 

 𝑈𝐴𝑆 𝐶𝑎𝑠9

𝑇𝑚3 𝑠𝑏
 

 

 

𝑋

𝑌
;

𝑀𝑦𝑜1𝐴[𝑡𝑠] − 𝐺𝑎𝑙4

𝑈6 − 𝑠𝑔𝑅𝑁𝐴 𝑃𝐸𝑋3 𝐾𝑂
; 

       
𝑈𝐴𝑆 − 𝐶𝑎𝑠9

𝑇𝑢𝑏 − 𝐺𝑎𝑙80[𝑡𝑠],
𝑈𝐴𝑆 − 𝐺𝐹𝑃

 

 

 

 

 
𝑋

𝑋
;

𝑀𝑦𝑜1𝐴[𝑡𝑠] − 𝐺𝑎𝑙4

𝑈6 − 𝑠𝑔𝑅𝑁𝐴 𝑃𝐸𝑋3 𝐾𝑂
; 

 
𝑈𝐴𝑆 − 𝐶𝑎𝑠9

𝑇𝑢𝑏 − 𝐺𝑎𝑙80[𝑡𝑠],
𝑈𝐴𝑆 − 𝐺𝐹𝑃

 

(Elav Gal4☿) x (w1118♂) 

𝐸𝑙𝑎𝑣 𝐺𝑎𝑙4

𝐸𝑙𝑎𝑣 𝐺𝑎𝑙4
;

+

+
;

+

+
   x  

𝑋

𝑌
;

+

+
;

+

+
 

 

𝐸𝑙𝑎𝑣 𝐺𝑎𝑙4

𝑌
;
+

+
;

+

+
 

 

𝐸𝑙𝑎𝑣 𝐺𝑎𝑙4

𝑋
;
+

+
;
+

+
 

(Elav Gal4☿) x (UAS BACE♂) 

𝐸𝑙𝑎𝑣 𝐺𝑎𝑙4

𝐸𝑙𝑎𝑣 𝐺𝑎𝑙4
;

+

+
;

+

+
   x  

𝑋

𝑌
;

𝑈𝐴𝑆 𝐵𝐴𝐶𝐸

𝑈𝐴𝑆 𝐵𝐴𝐶𝐸
;

+

+
 

 

𝐸𝑙𝑎𝑣 𝐺𝑎𝑙4

𝑌
;

𝑈𝐴𝑆 𝐵𝐴𝐶𝐸

+
;
+

+
 

 

𝐸𝑙𝑎𝑣 𝐺𝑎𝑙4

𝑋
;

𝑈𝐴𝑆 𝐵𝐴𝐶𝐸

+
;
+

+
 

 

The F1 progeny were collected and kept at 25°C, separated by genotype, sex, and 

date collected (to track aging). Collection of the flies involved the use of CO2 anesthesia, 

which would not be administered for more than 5 min at a time to prevent animal death. If 

F1 progeny were left to age, the fly food vials were changed every 3-5 days. 

 

2.1.3 Drosophila food: cornmeal, high fat diet, axenic diet, niacin diet  

Preparation of the cornmeal (CM) fly food followed the recipe of the Bloomington 

stock center https://bdsc.indiana.edu/information/recipes/bloomfood.html. Once the food 

https://bdsc.indiana.edu/information/recipes/bloomfood.html
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was finished cooking, a thermometer was placed to monitor the cooling down of the food 

as the stove-top is turned off. At 70-80°C anti-mold was added (per liter : 4 mL propionic 

acid (402907, Sigma-Alrich™), 1 mL phosphoric acid (P5811, Sigma-Aldrich™),  and 3g 

of Methyl-Benzoate (JRD0440, Sigma-Aldrich™) in 100 mL 95% EtOH. Then the liquid 

food was poured into a DrosoFiller™ (Flystuff 59-168 Droso-filler, Narrow, Genesee 

Scientific) for mass dispensing into polypropylene 46 mL housing vials. Another option 

was to use Genesee scientific™ Nutrifly® mix (66-116, Genesee Scientific™) when 

consistency in the fly food was needed: per 100 mL of water 17.77g/100 mL of Nutrifly® 

mix was cooked following the same instructions as the CM food and addition of anti-mold 

described above.  

High-fat food was made using a 4:1 ratio cornmeal food to fat.  The fat mix was a 

3:1 ratio of coconut oil (C1758, Sigma-Aldrich) to erucic acid (Broccoli-seed oil, E3385, 

Sigma-Aldrich™). The choice of the fats was made to obtain a mixture of Long Chain 

Fatty Acids (LCFAs) (coconut oil) and Very Long Chain Fatty Acids (VLCFAs) (erucic 

acid). Anti-mold was added. 

The antibiotic cocktail/axenic (AX) food was prepared using Nutrifly® and a 

cocktail of antibiotics, weighed under a fume hood and dissolved in sterile water. 

Antibiotics were then added to obtain final concentrations of: 100 µg/mL Ampicillin 

(A1593, Sigma-Aldrich), 100 µg/mL Metronidazole (M3761, Sigma-Aldrich), 100 µg/mL 

Neomycin (N1876, Sigma-Aldrich), 250 µg/mL Tetracycline (0.8168, Sigma-Aldrich), 

and 50 µg/mL Vancomycin (1709007, Sigma-Aldrich). Anti-mold was added. 
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Finally, niacin (nicotinic acid) food was also prepared using Nutrifly® mix and 

0.100g/100 mL of nicotinic acid (N4126, Sigma-Aldrich) to cooked Nutrifly® food, 

dissolved in water, for a final concentration of 100 mmol. Anti-mold was added.  

 

2.1.4 Negative geotaxis climbing assays   

Negative geotaxis climbing assays were carried out according to a protocol 

designed and optimized by (Madabattula et al., 2015), to assess upward-climbing 

locomotor behavior in the fly. To set up the assay area,  a sturdy table was placed in a low 

humidity room (~40%), a Pyrex™ 250mL graduated cylinder (3066, Corning® by Sigma-

Aldrich™) was placed in the middle of a foam mat on the table, and the bottom of the 

cylinder was traced onto the mat with a marker, to keep the positioning of the cylinder in 

the room consistent (Figure 6). The room was moderately lit, and an extra desk lamp was 

placed above the cylinder to add extra illumination for the camera (Figure 6). The lamp 

was placed where the light illuminated the area but not the cylinder directly, to avoid 

reflection of light within the cylinder which may affect the climbing of the flies. 
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Figure 6. The general room setup of the negative geotaxis climbing assay arena. 

Cohorts of 20 Drosophila per replicate were collected and then separated by 

genotype, day of collection, and sex. The flies were assayed at age 10, 15, 20, 30, 40, and 

50 days old (do), in parallel with controls. To conduct each assay, replicates were tapped 

into a 250 mL glass cylinder gently using a funnel, and the record button was pressed on 

the video recording device (iPhone XR: A1984, Apple Inc.). As the recording began, the 

cylinder was lifted up and then tapped back down gently 10 times to bring all of the flies 

to the bottom of the cylinder, then tapped ten times again in an asynchronous manner with 

shaking in-between to startle and disorient the animals. The negative geotaxis climbing 

ability (NGCA) of the flies were recorded for 2 min.  

To score the assays, the following spreadsheet was set up to track and calculate the 

percentage of flies that had climbed over the target height of 190 mL (considered a 

successful climb), in 10 sec intervals for 2 min (Figure 7). Only flies that climbed over the 

Mat 

Pyrex® 250ml 

Graduated cylinder  

Lamp 

Camera prop 
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target line, and not just reached the target line, were considered in the data collection 

(count). The identified ideal timeframe that was used, that showed the least variance within 

the same genotype was between 10-20 sec, was based on the optimized protocol by 

(Madabattula et al., 2015). These measurements were also considered in accordance to 

other previously published negative geotaxis climbing experiments, also using Drosophila 

models of PD and AD with locomotor deficits (Chakraborty et al., 2011; Feany & Bender, 

2000). The mean percentage (M) and standard deviation (SD) of flies over the target line 

for all replicates within each genotype, age and sex were calculated on Microsoft® Excel® 

(v 2103 [16.0.13901.20400] 2021). The data was then plotted with statistical analysis 

carried out using simple two-tailed, unpaired Student’s t-tests, assuming equal variance 

and an α=0.05, on GraphPad PRISM (v 9.4.0). Statistical tests were carried out in 

accordance to the original protocol reported by (Madabattula et al., 2015).  

 

 

Figure 7. A sample of the spread sheet used to calculate the climbing success for each 

replicate of the negative geotaxis climbing assays. The spread sheet also calculates the 

endpoint indicating how many flies were above 190 mL at the end of each assay according 

to (Madabattula et al., 2015). Time is in 10 sec intervals, ‘climbed up/down’ refers to how 

many flies between two consecutive intervals have successfully climbed over or below 

190mL, ‘cumulative’ indicates how many flies have successfully climbed over the 190mL 

accounting for the ones that also climbed down, and percentage is total number of 

successful flies over total flies in each cohort at each selected time interval.  

 

2.1.5 Courtship memory assays  

Courtship in Drosophila is an easy way to test for memory deficits, since male 

courtship/mating behavioral patterns are simple to identify. What courting assays measure, 

is the ability of virgin males to reduce courting/mating behavior as a result of rejection, 
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after being trained to learn and remember what rejection looks like by a non-receptive pre-

mated-female. Therefore, short-term courtship memory in male Drosophila was carried 

out in collaboration with Dr. Jamie Kramer at Dalhousie University in accordance with an 

optimized protocol published by Koemans et al., in 2017.   

Drosophila Cantron-R strains were used to obtain mated-females were prepared 

according to (Koemans et al., 2017), in parallel with  target crosses for the genotypes of 

interest, Mex>Pex5-i, Mex>w1118, Mex>SNCA, and Mex>GFP; set in narrow 

polypropylene food/housing vials 46 mL. One day before collecting virgin males of the 

interested phenotype to be tested (day 0), Canton R males and females were collected and 

placed together to mate for 4  days (until day 3). Then on day 1, virgin males eclosed from 

the crosses set to obtain the genotypes of interest and were collected every 30-60 min 

throughout the day, using an aspirator to gently place each male into individual wells of a 

housing block (96 deep well plates filled with cornmeal food). Each genotype was divided 

into two groups, trained and non-trained (See below). To obtain enough replicates for 

statistical power, and in the interest of time, fly collection and assay/data collection 

spanned over three consecutive days, where the Canton-R flies were always one day older 

than the virgin males.  

On the day of the assay, from 10am to 11am, pre-mated Canton-R females were 

anesthetized and separated from the males (1hr before training). At 11am, the pre-mated 

females were anesthetized again and individually placed into single wells of a new housing 

block. Then, without anesthetization and using an aspirator as described by Koemans et 

al., 2017, the virgin males to be trained were placed into each well with an individual pre-

mated female. From 11am to 12pm (1hr) the virgin males were left in each well to learn 
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and identify rejection from the non-receptive female. Afterwards, the groups of trained 

males were moved once again into a vacant housing plate without the females and left to 

rest in solitude from 12pm to 1pm (1hr) in the arena incubator before assaying. At 1pm the 

trained males were gently moved into assay wells with a new pre-mated female, and 

courtship was recorded for ten min.  

Each assay was scored for 5/10 min using a stopwatch to record the total time a 

male fly was courting/coupling to a pre-mated female; starting and stopping the same timer 

as the male starts and stops courting/coupling. Courtship behavior can be identified by 

males orienting towards, following, and touching a female, and extending one wing 

outwards and vibrating it while following the female (courtship song). When all assays 

were scored, the average  percentage of time spent courting over 5 min was calculated 

(courting index) for each genotype and from there the learning index was calculated (LI = 

[CI naive – CI trained] / CI naive), both  according to Koemans et al., 2017; indicating how 

well (in %) a male has learned and remembered how to court and be rejected. The data was 

then plotted with statistical analyses using using a multiple unpaired t-test, assuming equal 

variance and an α =0.05, on GraphPad PRISM (v 9.4.0). The simple t-test was deemed 

fitting for comparing between genotypes and not conditions, which was the main interest 

of this thesis.  

 

2.1.6  Feeding assays  

In collaboration with Dr. Deniz Top at Dalhousie University, feeding assays 

conducted on CM Mex>Pex5-i or Mex>SNCA males in comparison to CM controls 
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Mex>w1118 or Mex>GFP males were composed of four replicates of 15 male flies (n=60); 

this assay was adapted from (Botero et al., 2021). 

3D printed acrylic feeding chambers were used to house flies during the assay, 

where each well of the chamber contained 1% agar as a source of hydration, and 5μl 

borosilicate glass capillaries filled with liquid fly food and tracking dye. The 

microcapillaries were then connected and sealed off to the feeding chambers (Figure 8). 

Three days before the assay, the flies were kept in original food vials within the assay 

incubator, set a 25 °C 12 hr light-dark cycle, to habituate. Then on day one of the assay, 

each individual assay chamber was occupied by one fly (Figure 8), and from days one to 

three a camera in the incubator recorded how much food was being consumed over a period 

of 36 hrs (during the active 12 hr light-cycle of the fly) (Figure 8). After three days, the 

data was collected and trimmed down and the same steps were repeated for each of the 

remaining replicates; at the end the data was pooled with approximately 60 flies per 

genotype after eliminating flies that had died during the assay. Then GraphPad Prism (v 

9.2.0) was used to visualize the data and run statistical analyses, using two-tailed, unpaired 

Student’s t-tests, assuming equal variance and an α=0.05, as calculated by our 

collaborators.  
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Figure 8.  Apparatus of the feeding assays. As depicted, male Drosophila occupy a single 

chamber with a microcapillary filled with food, where 15 chambers were designated to the 

genotypes of interest, and the remaining 15 chambers to controls. Image source: MacKayla 

Williams, BSc Hon. Neuroscience, working in the lab of Dr. Deniz Top.  

 

2.1.7  Heart assessments 

In collaboration with Dr. Hua Bai at Iowa state university, the hearts of 

approximately 30 male and female flies per genotype were assessed for abnormalities of 

heart rate, heart pressure, arrythmia, diastole, and systole using a protocol developed by 

(Fink et al., 2009) according to (K. Huang et al., 2020). Moreover, statistical analyses 

consisted of one-way ANOVAs in accordance with (K. Huang et al., 2020).  

 

2.2 BRAIN PATHOLOGY  

2.2.1 Quantitative polymerase chain reaction of antimicrobial peptides and 

inflammatory cytokines in Drosophila heads  

The easiest way to begin looking at inflammation in the brain of Drosophila is by 

quantifying antimicrobial peptides (AMPs) or inflammatory cytokines (ICs) expression in 

the whole-head of the fly. Individual replicates of  approximately n=13 heads were 

carefully cut at the neck of the fly, using Dumont straight micro-dissection scissors and #5 

micro-dissection forceps (15040-11 and 11251-10, Fine Science Tools™), making sure to 

avoid piercing the head and inducing inflammation through injury. Then, the heads were 

preserved in 250 μl of TRIzol™ reagent (15596026, ThermoFischer Scientific™) in a 1.5 

mL Eppendorf ™ centrifuge tubes (022363204, Eppendorf™). Once three biological 

replicates were collected of each genotype, in addition to separating males and females, 
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the samples were kept on ice during collection and processed by RNA extraction, or frozen 

at -80 °C for later RNA extraction.  

To proceed with RNA extraction, the samples were homogenized on ice; first 

manually, to make sure the soft brain tissue was exposed to the TRIzol™ reagent, and then 

using an electric-motorized pestle to further homogenize the lysate (pestles 47747-358, 

cordless motor 47747-370, VWR®). The samples were immediately centrifuged at 4°C 

(centrifugation speed: 13,000 g-force) for 3 min, placed on ice again, and then the 

supernatant was carefully separated into another 1.5 mL microcentrifuge tube; avoiding 

the debris from the fly head cuticle at the bottom of the tube, which clogs the RNA 

extraction column in the following steps. An equivalent volume of 95% ethanol was added 

to the collected supernatant, to precipitate the RNA, and mixed gently but thoroughly by 

pipetting up and down until there was no phase separation observed. The mixture was 

immediately pipetted into a column-tube of the ZYMO™ Research, Direct-zol® RNA 

Microprep kit (R2061, ZYMO™), and then further processed as instructed by the kit. Once 

the RNA was isolated, samples were either immediately quantified on  QUBIT™ 

fluorometer (Q33238, ThermoFischer Scientific™), Nanodrop™ spectrophotometer (ND-

ONEC-W, ThermoFischer Scientific™), or preserved at -80°C.  

After quantification, 1μg of RNA was prepared into complimentary DNA (cDNA) 

using Applied Biosystems™ High Capacity cDNA Reverse Transcription kit (4387406, 

Thermo Fischer Scientific™), following the manufacturing instructions for the cDNA 

reaction mix, and using an Eppendorf 6331 Nexus Gradient Flexlid Thermal Cycler for an 

approximately 3hr PCR reaction; 10 min 25°C → 120 min 37°C → 5 min 85°C → 4°C 

hold. The cDNA was then stored at -25°C undiluted, or immediately diluted with nuclease 
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free water (1:5) to be used in a Quantitative Polymerase Chain Reaction PCR (qPCR) 

assay, following a PowerTrack SYBR Green Master Mix qPCR reaction kit (A46109, 

ThermoFischer Scientific™) protocol and using 10 nmol of target primers per reaction: 

Attacin (Att AMP: forward primer 5′AGTCACAACTGGCGGAC3’, reverse primer 

5′TGTTGAATAAATTGGCATGG3’), Unpaired-3 (Upd3 IC: forward 

5’AAAACGGCCAGAACCAGGAA3’, reverse 5’CATGGCCAAGGCGAGTAAGA3’), 

and Drosomycin (Drosomycin AMP: forward 5′GACTTGTTCGCCCTCTTCG3’, reverse 

5′CTTGCACACAGACGACAG3’).  All AMPs/ICs were tested against an internal control  

Ribosomal protein L23 (RPL23) also diluted to 10 nmol per reaction (forward 

5′GACAACACCGGAGCCAAGAACC3’, reverse 

5′GTTTGCGCTGCCGAATAACCAC3’). The QuantStudio™ 6 Flex Real-Time PCR 

(qPCR) System was used to carry out the qPCR reaction, using quick-cycling techniques 

in accordance with the PowerTrack™ SYBR Green Master Mix manufacturing 

instructions; 2 min 95°C (x 1) → 5 sec 95°C + 30 sec 60°C (x 40) → 4°C hold.   

Data was exported as a Microsoft Excel® file reporting raw cycle threshold values 

(CT), and a relative quantification of gene expression (Relative expression ratio) was 

calculated for each sample (formulas are reported below in Figure 9). These ratios were 

normalized using primer efficiencies for each oligonucleotide pair that indicate how well 

the primers bind and amplify the target template. Primer efficiencies were easily calculated 

using the slope of the a serial dilution curve constructed using target tissue cDNA and 10 

nmol of forward and reverse primer per reaction (a serial dilution of 1:5) (As outlined in 

Figure 9). The relative expression ratios were then copied into PRISM GraphPad Prism (v 

9.4.0) for graphing and statistical analyses using a two-tailed, unpaired Student’s t-tests, 
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assuming equal variance and an α=0.05. This statistical test was deemed appropriate 

because only two groups were being compared.  

Calculating Primer efficiency 

 

Slope Prompt into excel: = SLOPE(Average dilution 1 to 0.008, Log 1 to 0.008) 

Primer efficiency in % = (10(-1/slope)-1)*100 

Amplification coefficient Eamp =10^(-1/slope) 

Calculating Relative expression ratio for each replicate: 

 EAMP or IC =(ERPL 
CT RPL)/ (EAMP or IC  

CT AMP or IC) 

Figure 9. Calculations for primer efficiencies and relative expression ratios for 

general qPCR gene quantification. Most equations written out will work as Microsoft 

Excel® prompts, especially for slope. One thing to note is that Eamp is the amplification 

coefficient, while EAMP or IC indicates the amplification coefficient for a target 

antimicrobial peptide or inflammatory cytokine. 

 

2.2.2  Oxidative stress assessment in the brain: DHE and H2O2 

Another way to assess inflammation in the brain is to look at the redox state of the 

brain through Dihydroethidium (DHE) accumulation (30980035MG, ThermoFischer 

Scientific ™), as reported by (Di Cara et al., 2018). To do this, Drosophila brains were 

incubated with 33 µmol of DHE in SFM4 (Drosophila cell media: 89130-770, VWR™) 

immediately after dissection, using #5 microdissection forceps.  All brains were left to 

incubate in the DHE solution for 2 min, rinsed once briefly with 1x PBS (Phosphate 

Buffered Saline, recipe reported in supplementary table 1), before washing 3 times for ~1 

min in 1x PBS. After washing, the brains were immediately fixed for 7 min in 4% 

RPL

Dilution factor TR1 TR2 TR3 Log Average slope Primer Efficiency E(amp)

1 12.186 12.267 0 12.2265 -2.97988 116.5626003 2.165626003

0.2 13.819 13.902 -0.69897 13.8605

0.04 16.116 16.176 -1.39794 16.146

0.008 18.367 18.448 -2.09691 18.4075
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formaldehyde (diluted 1:4, J19943.K2, Thermo Fischer Scientific™), received 3 more 

washes in 0.05% PBSTritonX (Phosphate Buffer Saline mixed with 0.05% Triton-X 

detergent: 9036-19-5, Sigma-Aldrich™), and then rinsed once more in 1x PBS before 

mounting onto glass microscope slides using ProLong™ Gold Antifade mounting media 

(P10144, ThermoFischer Scientific™). 

To carry out H2O2 quantification, as reported by (Di Cara et al., 2018), Drosophila 

heads were dissected using Dumont straight micro-dissection scissors and #5 micro-

dissection forceps, and then homogenized in a 1.5 mL Eppendorf™ microcentrifuge tube 

using 1x PBS, before centrifuging at (~13,000 g-force) until the debris of the head cuticle 

was situated at the bottom of the tube. H2O2 was then measured using Amplex™ Red 

Hydrogen Peroxide/Peroxidase Assay Kit (A22188, ThermoFischer Scientific™) 

following the protocol of the kit, and then the results of each sample were normalized 

against protein concentrations quantifies using a Qubit™ Protein BR Assay Kit (A50669, 

ThermoFischer Scientific) on a Qubit™ fluorometer. The data collected was then copied 

and graphed in GraphPad PRISM (v 9.4.0), and statistical analyses were carried out using 

a two-way ANOVA as reported by (Di Cara et al., 2018).  

 

2.2.3  Mitochondrial damage in the brain: Transmission electron microscopy  

Structural abnormalities of mitochondria in the brain neuropil of Drosophila have 

been identified in ND models (V. Costa et al., 2010; Risiglione et al., 2021). Therefore 

age-matched 30do Mex>Pex5-i and control Mex>w1118 males and females brains were 

prepared, cut and imaged using transmission electron microscopy (TEM) to visualize and 

identify abnormalities of mitochondria as a result of knocking down PEX5 in the midgut.  
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The following protocol has been provided and carried out by Mary Ann Trevor’s 

at the EM Core Facility of Dalhousie University (excluding dissections). Seven to ten 

brains from each genotype and sex were immediately dissected using #5 micro-dissection 

forceps and kept in a cold fixative composed of 2.5% glutaraldehyde fixative diluted in 

0.1M sodium cacodylate buffer. The brains were then washed three times for 10 min using 

0.1M sodium cacodylate buffer, fixed and washed again before staining for 2hrs with 1% 

Osmium Tetroxide to add contrast and help visualize most intracellular components of the 

neurons. After 2hrs, the samples were briefly rinsed in distilled H2O, and then submerged 

in 0.25% uranyl acetate  for an overnight incubation at 4°C. The next day, the tissues were 

then gradually dehydrated with a series of acetone washes. This dehydration step readies 

the samples to be infiltrated and then embedded into an Epon Araldite Resin (EAR) in 

preparation for sectioning.   

Before embedding the tissue in the resin, the tissue needs to be infiltrated with the 

resin over two days. Then the tissue is embedded into 100% EAR and cured for 48hours at 

60°C. Once the tissue has been embedded into a cured resin a Reichert-Jung Ultracut E 

ultramicrotome was used to section the tissue (100 nm thick). Samples were placed on a 

pre-stained slot-shaped copper-mesh grid. Moreover, for each biological replicate (n=2) of 

each sex and genotype, transverse and coronal sections were cut with two to three technical 

replicates per biological replicate. Once ready, the samples were viewed using a JEOL 

JEM 1230 transmission electron microscope (80kV) using a Hamamatsu ORCA-HR 

digital camera; the fields of magnifications imaged were 1k, 30k, 50k, 60k and 100k. The 

area of primary focus was dorsal (transverse cut) and dorsal anterior (coronal cut) (Figure 

11A,B). 
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2.2.4 MitoSOX®  Staining 

MitoSOX™ Red Mitochondrial Superoxide Indicator (M36008, ThermoFischer 

Scientific™) was used to evaluate internal mitochondrial stress via superoxide 

accumulation in the brains of age-matched 30do Mex>Pex5-i, control Mex>w1118, 

Mex>SNCA, and control Mex>GFP. To do this, MitoSOX™ reagent stock solution was 

diluted to 5 mmol in 1x PBS (working solution). Brains were then placed in dissecting 

wells and submerged with the working solution and incubated 30 min at 25˚C in the dark 

on a shake-plate. The brains were then rinsed with 1x PBS three times and immediately 

mounted on microscope slides with ProLong™ Gold Antifade mounting media. Both the 

Zeiss AXIO-Observer fluorescence microscope and Zeiss LSM 880 confocal microscope 

were used to image the brains at magnifications of 10x and 40x with a numerical aperture 

of 1.4. All images were taken on Zeiss Zen-Blue, and edited to add scale bars on Zeiss Zen-

blue-lite programs. 

https://www.zeiss.com/microscopy/int/products/microscope-software/zen-

lite.html?vaURL=www.zeiss.com/zen-lite.  

 

2.2.5  Terminal deoxynucleotidyl transferase dUTP nick end labeling  

In attempts to visualize brain-wide cellular death, Tali™ Apoptosis Kit - Annexin 

V (AV) Alexa Fluor™ 488 & Propidium Iodide (PI) (A10788, Thermo Fischer Scientific), 

and In Situ Cell Death Detection Kit, TMR red (TUNEL: 12156792910, Roche™ Sigma-

Aldrich™) fluorescent markers were used to visualize apoptosis (AV and TUNEL), and 

necrosis (PI). For AV and PI,  brains were dissected in 1x PBS, washed with 190μl of 1x 

Annexin Binding Buffer (ABB), and then submerged in 200μl of a working solution made 

https://www.zeiss.com/microscopy/int/products/microscope-software/zen-lite.html?vaURL=www.zeiss.com/zen-lite
https://www.zeiss.com/microscopy/int/products/microscope-software/zen-lite.html?vaURL=www.zeiss.com/zen-lite
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of 10μl of the annexin V in 190μl of 1x ABB. Then the brains were incubated in the dark 

at 25˚C room temperature for 10 min.  

After incubation, the working solution was removed and the brains were rinsed in 

190μl of ABB, before being resubmerged in a second working solution made of 10μl of 

propidium iodide counter stain in 190μl of ABB. The brains were incubated again for 10 

min, and rinsed twice with 1x PBS. Then a fluorescent DNA binding stain 4′,6-diamidino-

2-phenylindole (DAPI: ab228549, abcam™ Sigma-Aldrich™) was added at a 1:1000 

dilution for 10-15 min, to help identify individual neurons during fluorescent imaging. The 

brains were then mounted on glass slides using ProLong™ Gold Antifade mounting media 

for fluorescent imaging, anterior side up (the part where the brain is the most bulbous and 

not flat).  

The TUNEL stain for apoptosis followed a similar protocol. 20 brains were 

submerged in 50μl of working solution make of 45μl Label solution and 5μl Enzyme 

solution. The brains were then incubated at 25°C room temperature for 30 min. After 

incubation, the samples were briefly rinsed in 1x PBS, before mounting on glass 

microscope-slides using ProLong™ Gold Antifade mounting media. Both the Zeiss AXIO-

Observer fluorescence microscope and Zeiss LSM 880 confocal microscope were used to 

image the brains at magnifications of 10x, 20x, and 40x with a numerical aperture of 1.4. 

All images were taken on Zeiss Zen-Black, and edited to add scale bars on Zeiss Zen-blue-

lite programs https://www.zeiss.com/microscopy/int/products/microscope-software/zen-

lite.html?vaURL=www.zeiss.com/zen-lite. 

While collecting the images, brains were observed to be much smaller in size for 

the male Mex>Pex5-i and Mex>SNCA compared to controls. To calculate brain size in 

https://www.zeiss.com/microscopy/int/products/microscope-software/zen-lite.html?vaURL=www.zeiss.com/zen-lite
https://www.zeiss.com/microscopy/int/products/microscope-software/zen-lite.html?vaURL=www.zeiss.com/zen-lite
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image editing software FIJI ImageJ https://imagej.net/software/fiji/, the measuring tool as 

outlined in (Figure 10) was selected, the scale bar was measured, and the length of the scale 

bar was set to 200 μm by going to Analyze > Set Scale > Known distance (To 200 μm in 

Figure 10) > Ok. After ruler calibration, the measuring tool is used again to measure the 

brain from end to end in two ways, distal to distal (eyelobe to eyelobe) or dorsal to ventral 

(top to bottom). After measuring the brain, Analyze> Measure, and a pop-out window 

appeared displaying length (Figure 10). From there, measurements for both controls and 

mutants were collected using both measuring techniques aforementioned, and then copied 

in to GraphPad PRISM (v 9.4.0) for graphing and statistical analyses using two-tailed, 

unpaired Student’s t-tests, assuming equal variance and an α=0.05. This statistical test was 

deemed appropriate because only two groups were being compared at a time. 

 

  

 

 

 

 

 

 

 

 

https://imagej.net/software/fiji/
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Figure 10: A visual aid to measuring and calculating the size of Drosophila 

melanogaster brains using FIJI ImageJ https://imagej.net/software/fiji/. 
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2.2.6 Tyrosine hydroxylase immunofluorescence: assessing dopaminergic 

neuron death and activity   

 For immunofluorescence of the Drosophila intestine, midguts were dissected and 

fixed in 4% paraformaldehyde in 1x PBS (diluted 1:4, J19943.K2, ThermoFischer 

Scientific™) for 30min, washed three times in 0.3% PBST (0.3% Triton-X detergent: 

9036-19-5, Sigma-Aldrich™ in 1x PBS), and blocked (to prevent non-specific antibody 

binding) for 1hr at 25°C room temperature in 5% Normal Goat Serum (NGS) (NGS: 31872, 

ThermoFischer Scientific™, in 0.3% PBST). After incubation, the primary antibody 

Armadillo β-catenin (N2 7A1, Developmental Studies Hybridoma Bank™, 1:100 dilution) 

in 5% NGS was added for an over night incubation at 4°C. The next day the guts were 

washed five times in 0.3% PBST, before the addition of secondary antibody donkey-α 

mouse Alexa Fluorophore 555 (Red: A-21202, ThermoFischer Scientific™) in 5% NGS 

and 4′,6-diamidino-2-phenylindole (DAPI: ab228549, abcam™ Sigma-Aldrich™) both 

diluted 1:1000 and incubation at 25°C room temperature for 2hrs. Excess secondary was 

then washed off with 4 washes in PBSTw (0.2% Tween-20: 003005, ThermoFischer 

Scientific™, diluted in 1x PBS) before mounting in Prolong™ Gold Antifade (P10144, 

ThermoFischer Scientific) on glass microscope slides. Both the Zeiss AXIO-Observer 

fluorescence microscope and Zeiss LSM 880 confocal microscope were used to image the 

midguts at magnifications of 10x, 20x, and 40x with a numerical aperture of 1.4. All images 

were taken on Zeiss Zen-Blue/Black, and edited to add scale bars on Zeiss Zen-blue-lite 

programs https://www.zeiss.com/microscopy/int/products/microscope-software/zen-

lite.html?vaURL=www.zeiss.com/zen-lite. 

https://www.zeiss.com/microscopy/int/products/microscope-software/zen-lite.html?vaURL=www.zeiss.com/zen-lite
https://www.zeiss.com/microscopy/int/products/microscope-software/zen-lite.html?vaURL=www.zeiss.com/zen-lite
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To investigate effected neuronal clusters, specifically dopaminergic (DA) that are 

locomotor neurons, Tyrosine Hydroxylase (TH) (Rate-limiting-step enzyme for 

intracellular dopamine production according to (Daubner et al., in 2011) was used to 

visualize DA neurons. The Drosophila brains were dissected in cold 1x PBS and 

immediately placed in a 1.5 mL Eppendorf™ microcentrifuge tube (022363204, 

Eppendorf™) containing 200 µL of 4% formaldehyde fixative (diluted 1:4, J19943.K2, 

ThermoFischer Scientific™) on ice. Once all of the brains were dissected, the samples 

were left to fix well for an additional 30-40 min on a mechanical shake-plate at 25°C room 

temperature. The fixative was then removed, the brains were quickly rinsed with 0.5% 

PBSTw, and permeabilized with 6 x 5 min washes of  0.5% PBSTw. The brains were then 

submerged in a blocking solution of 5% NGS in 0.5% PBSTw solution overnight at 4°C  

on a mechanical shake-plate. The blocking solution was removed the next day and replaced 

with the primary antibody (Rabbit anti-TH: AB152 , abcam™ Sigma-Aldrich™, at a 1:200 

dilution) in 5% NGS 0.5% PBSTw solution. The brains were left in primary overnight at 

4°C on a mechanical shake-plate. Then, the next day, the primary antibody was removed, 

and the brains were thoroughly washed 6 x 10 min using 0.5% PBSTw. The brains were 

then submerged in secondary antibody donkey-α rabbit Alexa fluorophore A555 (Red), or 

donkey-α rabbit A488 (Green: A-21206, ThermoFischer Scientific™) if co-stained with 

TUNEL (Red), at a 1:500 dilution, and DAPI (Blue) at 1:1000 dilution in 0.5% PBSTw, 

and left to incubate on a mechanical shake-plate at 25°C room temperature for 2hrs, or at 

4°C  overnight. After incubation in secondary antibody, the brains were kept out of direct 

light (or under aluminum foil) and washed thoroughly 3 x 5 min in 0.5% PBSTween before 

mounting on glass microscope-slides, with round cover slips, and using ProLong™ Gold 
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Antifade mounting media. The brains were oriented to flatter posterior side facing the glass 

slide and anterior side facing the coverslip, in order to visualize the neurons of interest 

located mostly anterior (Figure 11A) .  

 Using a Zeiss LSM 880 confocal microscope and program Zeiss Zen-Black to 

image the brains (at 10x and 20x, numerical aperture of 1.4), a Z-stack of the brain was 

imaged, in order to visualize both anterior and posterior neurons of interest (Figure 11A,B). 

Protocerebral Anterior Medial dopaminergic (PAM) and Protocerebral Posterior Lateral 1 

dopaminergic (PPL1) neurons were the clusters of interest because these clusters project 

into the mushroom body for memory and motor function as depicted in (Figure 11C) (Siju 

et al., 2021). Furthermore, data analysis consisted of quantifying the count and fluorescent 

intensity of both the PAM and PPL1 neurons. Fluorescent intensity was collected and 

calculated according to https://theolb.readthedocs.io/en/latest/imaging/measuring-cell-

fluorescence-using-imagej.html using FIJI ImageJ. The pipeline for quantifying 

fluorescent intensity is visually outlined in (Figure 12): Open FIJI ImageJ → Open file of 

interest in TIFF format → Image → Colour → Split channels. Once the TH channel was 

selected (Green or Red depending on the antibody), the image was left in grey-scale before 

setting the measurements of data collection: Measure → Set Measurements (Area, Min and 

max gray value, Integrated density and Mean gray-value. After setting the measurements, 

free-form was selected → target neurons were highlighted, and then Analyzed → and 

measured (Figure 12 at the #1), as well as areas of the brain with no fluorescence to correct 

for autofluorescence (Figure 12 at the #2). For each neuron the corrected total cell 

fluorescence (CTCF) was calculated according to the following equation: CTCF = 

Integrated Density – (Area of selected cell * Mean background fluorescence). The CTCF 

https://theolb.readthedocs.io/en/latest/imaging/measuring-cell-fluorescence-using-imagej.html
https://theolb.readthedocs.io/en/latest/imaging/measuring-cell-fluorescence-using-imagej.html


61 
 

values were then copied in to GraphPad PRISM (v 9.4.0) for graphing and statistical 

analysis using two-tailed, unpaired Student’s t-tests, assuming equal variance and an 

α=0.05. This statistical test was deemed appropriate because only two groups were being 

compared at a time. 
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Figure 11. Orientation of the Drosophila melanogaster brain and location of 

dopaminergic neurons on the anterior and posterior sides. Location of A) PAM and B) 

PPL1 neurons according to C) a visual map of all DA neuron clusters in the anterior and 

posterior brains depicted in one image illustrated by and according to (Siju et al., 2021), 

and also depicting how PPL1 and PAM connect to the mushroom body of the fly 

(analogous to the mammalian hippocampus, and both important for memory).  
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Figure 12. Visual aid on how to use FIJI ImageJ to calculate fluorescent intensity of 

neurons in the brains if Drosophila according to:  

https://theolb.readthedocs.io/en/latest/imaging/measuring-cell-fluorescence-using-

imagej.html. 

 

2.3  Transcriptomic screens and gene hit validation 

2.3.1  Experimental conditions   

Each RNA library was prepared in biological duplicates for Mex>Pex5-i and 

control Mex>w1118. Libraries for 8 different conditions were prepared. The conditions were 

a regular cornmeal, a sucrose diet, an infection (high and low doses of Pseudomonas 

entomophila), a high fat with and without an infection, and an axenic diet with and without 

and infection. The control condition was the regular CM food. The flies used were a mix 

of males and females (1:1), and were aged to 7 days at 29C before dissecting the midguts. 

The main conditions included a sucrose treatment which lasted 16hrs, where the flies were 

placed in a vials of sugar-water soaked filter paper. For the infection treatment of 

Pseudomonas entomophila, a Drosophila specific pathogen, the flies were placed in vials 

with a dry vial-plug and filter paper at the bottom which was soaked in pre-grown (16-

24hrs the day before) Pseudomonas entomophila in Luria-Bertani broth. Finally, the high-

fat and axenic diets included a 16hr period of feeding on HFD and AX food as described 

previously in section 2.1.3. 

 

2.3.2  Dissections, RNA extraction, DNase treatment, and quality control 

After being subject to one of the 8 different treatments, on the day of dissection, 

the flies were anesthetized using CO2, and dissected 20 at a time (20 guts= 1 replicate, 10 

https://theolb.readthedocs.io/en/latest/imaging/measuring-cell-fluorescence-using-imagej.html
https://theolb.readthedocs.io/en/latest/imaging/measuring-cell-fluorescence-using-imagej.html
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males and 10 females). Since only the midgut was of interest, during the dissection process, 

either micro-dissection scissors or #5 micro-dissection forceps were used to sever the hind 

and foregut regions (Capo et al., 2019). Each midgut was dissected, and immediately 

placed in 250µl of TRIzol® reagent on ice in a 1.5 mL Eppendorf™ microcentrifuge tube 

to immediately be processed for RNA extraction, or frozen at -80 for later processing.  

After 2 biological replicates of each genotype within each condition were collected 

(a total of 32 samples), the QIAGEN™ RNeasy Mini kit was used to extract the RNA from 

the samples (74104, QIAGEN™) according to the manufacturers protocol. RNA extraction 

procedures were carried out with high-precaution on a bench sterilized with  70% ethanol 

and  RNaseZap™ (83930, Sigma-Aldrich™) to eliminate surface RNases. The samples 

were taken out of the -80C, 4 were processed at a time, and left to thaw on ice before 

homogenizing for approximately 10 sec with a VWR™ motorized pestle, and let sit at 5 

min at 25°C room temperature. Then 250µl of additional TRIzol®  was added (topping the 

homogenate up to 500µl) before the addition of 100µl of chloroform (366927, Sigma-

Aldrich™) for a TRIzol®/Chloroform phase separation. Once the chloroform was added, 

the samples were shaken vigorously by hand for 15-20 sec, and left to sit on the bench for 

3 min before centrifugation for 15 min at 4°C (~13,000 g-force). After centrifugation, the 

upper aqueous layer, containing the RNA, was collected carefully not to draw-up any of 

the TRIzol® at the interface. After separating the upper phase to a new 1.5 mL 

microcentrifuge tube, one volume of 70% ethanol was added, mixed thoroughly by 

pipetting up and down until there was no sign of phase separation, and then immediately 

pipetted into a 2 mL RNeasy spin column and proceeded as instructed by the QIAGEN™ 

RNeasy Mini kit (74004, QIAGEN™). The concentrations and integrity of the RNA were 
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then quantified using a Qubit™ Broad Range RNA quantification assay kit (Q10210, 

Thermo Fischer Scientific™), and the Qubit™ RNA IQ assay kit (Q33221, Thermo 

Fischer Scientific™), on a Qubit™ fluorometer.  

These samples were also contaminated with genomic DNA (gDNA), as confirmed 

by an Agilent Technologies 2100 Bioanalyzer and RNA Pico Chip (5067-1513, 

Agilent™). Therefore, each sample was treated with QIAGEN RNase-Free DNase set 

(79254, QIAGEN™) and Invitrogen™ Deoxyribonuclease1 (DNase1:18047019, Thermo 

Fischer Scientific™) according to the manufacturers protocols. After DNase treatment the 

RNA samples were immediately placed on ice for quantification on Qubit™ fluorometer 

before library prep. 

 

2.3.3  Transcriptomic library preparation and quality control 

Once all of the samples were collected, and treated with DNase to eliminate gDNA 

contamination, the QIGEN QIAseq™ UPX 3’ Transcriptome Kit (333088, QIAGEN™) 

was used to make one transcriptomic library per condition. This library kit uniquely tags 

individual samples with a unique molecular index or cell-ID (UMI) which allows pooling 

of samples under one library index. Indices 1-8 were used from the QIAseq UPX 3' Trans. 

12-index (48) index set (333074, QIAGEN), with one index per condition. Therefore, a 

total of eight libraries were constructed of four samples (biological duplicates of 

Mex>Pex5-i and control Mex>w1118), according to the QIAGEN™ QIAseq™ UPX 3’ 

Transcriptome Kit manual below: 

https://www.qiagen.com/us/resources/resourcedetail?id=28512222-986f-4027-bb45-

2c7e65d3fd2b.  

https://www.qiagen.com/us/resources/resourcedetail?id=28512222-986f-4027-bb45-2c7e65d3fd2b
https://www.qiagen.com/us/resources/resourcedetail?id=28512222-986f-4027-bb45-2c7e65d3fd2b
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Before quantifying each library, quality control was approached in two different 

ways; 1) using gel-electrophoresis to check the library size (ideally between 400-600 bp) 

and 2) using the Agilent™ Bioanalyzer and Bioanalyzer High Sensitivity DNA Analysis  

(5067-4626, Agilent™) to check the library size in bp and the presence of remaining gDNA 

contamination. Additionally, the average library size was required for the QIAGEN 

QIAseq™ Library Quant Assay Kit (333314, QIAGEN™), in order to accurately quantify 

library concentration before sequencing. Libraries were considered the optimal size for 

sequencing (Supplementary Figure 3), and therefore the libraries proceeded to Next 

Generation Illumina Sequencing at Gémone-Québec Canada. 

 

2.3.4  Demultiplexing/alignment/mapping and enrichment analyses 

Once sequencing was complete, the QIAGEN CLC Genomic Workbench 

https://digitalinsights.qiagen.com/products-overview/discovery-insights-

portfolio/analysis-and-visualization/qiagen-clc-genomics-workbench/ was used to 

demultiplex and convert each library into FASTQ files. Once the libraries were converted 

into FASTQ, QIAGEN open source Bioinformatics tool GeneGlobe was used to further 

demultiplex individual UMIs and to run an enrichment analysis 

https://go.qiagen.com/GeneGlobeResearchCycle?cmpid=CM_PCR_GG_GGAwareness_

0621_SM_TwitterOrg. Additionally, the enrichment analysis (secondary analysis) on 

GeneGlobe provided a list of hits ranked by p-values that indicated which genes were the 

most to least likely, truly differentially expressed. These p-values were then ranked from 

smallest to largest (most likely to be truly differentially expressed to least). Then, using 

DAVID Bioinformatics Database https://david.ncifcrf.gov/, another open source 

https://digitalinsights.qiagen.com/products-overview/discovery-insights-portfolio/analysis-and-visualization/qiagen-clc-genomics-workbench/
https://digitalinsights.qiagen.com/products-overview/discovery-insights-portfolio/analysis-and-visualization/qiagen-clc-genomics-workbench/
https://go.qiagen.com/GeneGlobeResearchCycle?cmpid=CM_PCR_GG_GGAwareness_0621_SM_TwitterOrg
https://go.qiagen.com/GeneGlobeResearchCycle?cmpid=CM_PCR_GG_GGAwareness_0621_SM_TwitterOrg
https://david.ncifcrf.gov/
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bioinformatics tool, the genes were further investigated in order to identify the best fits for 

the study, based on enrichment of the hits in biological processes. Ultimately, 

neuropeptides and neuropeptide receptors emerged as gene hits of interest.  

 

2.3.5 Gene hit validation and analytics 

Once target genes were identified, the first step was to validate the expression of 

these genes (using calculations from Figure 9), and to try and understand expression 

directionality in each genotype and sex. Similar samples to the transcriptomic screen were 

prepared on CM, HFD, and AX conditions, the midguts were dissected, 1µg of RNA was 

extracted using ZYMO® Research: Direct-zol RNA Microprep kit, and quantified on a 

NanoDrop® spectrophotometer for concentration (ng/μl), and quality. Quality was 

assessed by checking the absorbance ratios of each concentration: 230/280 and 260/280 

(ratios of nucleic acid purity). Samples that did not meet the 260/280 ratio of ~1.8-2.0 or 

260/230 ratio of ~2.0-2.2 were discarded. The RNA was then reverse transcribed into 

cDNA using High Capacity RNA-to-cDNA™ Kit. Then using PowerTrack SYBR™ 

Green PCR Master Mix (using 10 nmol of each primer) and  QuantStudio™ 6 Flex Real-

Time PCR machine, the following gene hits identified from the transcriptomic screens 

were tested. Amn (FBgn0086782), AstA (FBgn0015591), AstA-R1 (FBgn0015591), 

Bursicon (FBgn0038901), CCAP (FBgn0039007), CCAP-R (FBgn0039396), CCHa2 

(FBgn0038147), CCHa2 (FBgn0033058), Dsk (FBgn0000500), FMRFa (FBgn0000715), 

Mip (FBgn0036713), Ms-R2 (FBgn0264002), NPF (FBgn0027109), PDF-R 

(FBgn0260753), sNPF (FBgn0032840), Tk (FBgn0037976). All genes can be found on 

FlyBase for reference  https://flybase.org/. Primers used are listed in Table 2 below.  

https://flybase.org/
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Table 2. Sequences of neuropeptide and neuropeptide receptor primers 

Gene of interest Oligonucleotide sequences (written 5’-3’) 

AMN-F 5’ATT CCG CGC CCG AAT TTT TC3’ 

AMN-R 5’CGT TTC GCT GTC GTT GCA TA3’ 

AstA-F 5’CGC CTG CCG GTC TAT AAC TT3’ 

AstA-R 5’CTT GTT CTG TCG GCC AGG TC3’ 

AstA-R1-F 5’CCC GTA TTC TTT GGC ATT ATC GG3’ 

AstA-R1-R 5’GGC CAG GTT GAT TAT CAG CAG A3’ 

CCAP-F 5’GTC ATC GTT CTG GGC AAT TCA3’ 

CCAP-F 5’TCG CTG GAA AGG GAG AAC A3’ 

CCAP-R 5’GAT GTC GGT GAG GAC GTT GA3’ 

CCAP-R 5’TCG TCC ACA GCC TGT AAA TGC3’ 

CCHa2-F 5’CGC CAA ATG AAC AGG TGC C3’ 

CCHa2-R 5’GTC GGC GAG GTC GGT TAA3’ 

CCHa2-R -F 5’GAC GGC GGA ATA GTA CCG TAT3’ 

CCHa2-R -R 5’CGG TGG CGA AAG AAG ATG ATG3’ 

DSK-F 5’TCG GCG ACT ACA GGA ATT GGA3’ 

DSK-R 5’TCC CCG AAT AGA GAG AAT GAT GG3’ 

FMRFa-F 5’TCT GTG ATT GGC ATC GAC TAC T3’ 

FMRFa-R 5’CTC TTG CCG AAG TGC ATG AAG3’ 

MIP-F 5’CGA GGA GAT ATA TAG TCA GCT ATG G’ 

MIP-R 5’TCG CTC TCG CTA AGT TGG TC3’ 

MsR2-F 5’AAG TTT CAC TCG GTA TTT CCC C3’ 
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Gene of interest Oligonucleotide sequences (written 5’-3’) 

MsR2-R 5’CGA TTC CTT TGC GGA TAG CTT AC3’ 

NPF-F 5’TCC GCG AAA GAA CGA TGT CA3’ 

NPF-R 5’CTC CTC ATT AAA ACC GCG AGC3’ 

Nplp1-F 5’ATG CTG CTC AAT GCC GCT ATT3’ 

Nplp1-R 5’ACT GGG GCT CAT CAG TTG ATT TA3’ 

Pdf-F 5’TCG CTA CAC GTA CCT TGT CG3’ 

Pdf-R 5’GAT AGC GAC AGA GAG TGG CC3’ 

Pdfr-F 5’CCC TGG AAT CTA ACG CTT GC3’ 

Pdfr-R 5’TCC TGT TTG TGG TAG GGTGTA AT3’ 

Rpl23-F 5′GACAACACCGGAGCCAAGAACC3’ 

Rpl23-R 5’GTTT GCG CTG CCG AAT AAC CAC3’ 

sNPF-F 5’GTG TTC CTC AGT TCG AGG CAA3’ 

sNPF-R 5’AGT TCA AAA GCG AGT TGT ACC A3’ 

Tk-F 5’CAA TTC CTT TGT GGG GAT GCG3’ 

Tk-R 5’CTG CTG TTT TCC TCT CAA GTC AT3’ 
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CHAPTER 3: EFFECTS OF GUT-SPECIFIC PEX5 DEPLETION AND SNCA/ 

BACE OVEREXPRESSION ON BEHAVIOUR AND THE BRAIN 

3.1  A genotypic & condition dependant decline of NGCA 

3.1.1 A decline of NGCA in male Mex>Pex5-i on CM conditions 

As previously published, a Knock Down (KD) of Peroxin 5 (PEX5) in the 

Drosophila intestinal epithelium (midgut) resulted in dysplasia of Enterocytes (ECs) (Di 

Cara et al., 2018). Thus, compromising metabolism in the midgut (Smith & Aitchison, 

2013). Moreover, the conjecture of compromising the gut epithelium in humans is the 

increased vulnerability and likeliness of developing Neurodegenerative Diseases (NDs). 

Furthermore, sharing physiological affinity to the human small intestine (Capo et al., 

2019), the Drosophila midgut may also have an important role in neuroprotective 

signaling, thus intestinal instability may have a negative outcome on the brain. For this 

reason, PEX5 was depleted (Mex>Pex5-i) in the midguts of male and female flies, and then 

stained with an anti-Armadillo antibody (armadillo protein in Drosophila is the homolog 

of mammalian β-catenin) to visualize dysplasia of ECs and intestinal stem cells (ISCs) in 

the model. In order to identify and connect any phenotypes observed in and of the brain to 

midgut alterations.  

In parallel, the effects of overexpressing canonical human-linked mutant-alleles of 

NDs in the midgut was also considered; in order to probe the distal effects of these common 

disease genes on the brain in comparison to a PEX5 midgut-KD fly. For example, a mutant 

allele of α-Synuclein (SNCA), linked to Parkinson Disease (PD), and encodes a protein that 

damages mitochondrial activity and leads to neuronal death (Faustini et al., 2017), was 

overexpressed in the midgut of the animal. Both peroxisomes and mitochondria organelles 
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share similar metabolic activity in the gut, and since SNCA in the gut is linked to NDs in 

the brain (Yan et al., 2021), then Mex>SNCA acts as a great reference model for studying 

the contributions of peroxisome metabolism in the Diet-Microbiota-Gut-Brain (DMGB) 

axis of NDs. 

Both Mex>Pex5-i and the Mex>SCNA males displayed midgut dysplasia in the 

form of elevated ISC proliferation, clumping into larger clusters of cells (Figure 13A), 

when compared to age matched controls  at 20 days old (do) (Figure 13A). These findings 

were recapitulated in  male midgut-specific Crispr Cas9-specific Knock Out (KO) model 

of PEX3 at 20do (Figure 13B); PEX3 is another essential peroxin involved in peroxisomal 

de-novo biogenesis (Smith & Aitchison, 2013). Ultimately indicating that the phenotype 

was not caused by the Mex-Gal4 tissue-specific driver, nor exclusively caused by depletion 

of PEX5 rather than general peroxisomal function. Additionally, PEX3 CRISPR KO male 

midguts underwent Terminal deoxynucleotidyl transferase dUTP Nick-End Labeling 

(TUNEL) to detect apoptosis. Results indicated that the proliferating and clumping ISCs 

were also dying, while there were no visible apoptotic cells in the control midguts; 

confirming gut-epithelial dysplasia (Figure 13B). The female Mex>Pex5-i did not show 

the same ISC proliferation and clumping as the males, the ISCs of the females were instead 

sporadic and individually scattered (Figure 13C). On the other hand, the Mex>SNCA 

females did display increased ISC proliferation but, no clumping (Figure 13C).  
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Figure 13. Dysplasia in the midguts of Mex>Pex5-i males and Mex>SNCA males and 

females. Representative images of the Intestinal stem cell (ISC) staining of male and 

female midguts all aged matched at ~20do, using N2 7A1 Armadillo β-catenin antibody, 

and secondary antibody Alexa Fluorophore 555 (Red) or 488 (Green). A) Dysplasia can be 

observed by the actively proliferating and clumpy enterocyte progenitors in both 

Mex>Pex5-i males (bottom left panel) and Mex>SNCA males (bottom right panel, with the 

white box) in red, compared to controls in the upper panels. All midguts were imaged on 

Zeiss Axio Observer fluorescent microscope at 40x magnification except Mex>Pex5-i 

males imaged using a Zeiss LSM 880 confocal microscope at 40x magnification. All scale 

bars read 50μm. B) Armadillo staining (Green) of Myo1A>Pex3 Cas9 KO midguts. 

Dysplasia can be observed in the form of actively proliferating enterocyte progenitors 

(Green), and cellular death stained by TUNEL (Red), compared to the control in the upper 

panel. All midguts were imaged on a Zeiss LSM 880 confocal microscope at 40x, and all 

scale bars read 50μm. C) Mex>Pex5-i and control females are comparable with no 

dysplasia. Mex>SNCA females (bottom right panel) compared to controls in the upper 

panels, however there is little to no clumping of progenitor cells. All midguts were imaged 

on Zeiss Axio Observer fluorescent microscope at 40x magnification except Mex>Pex5-i 

females imaged using a Zeiss LSM 880 confocal microscope at 40x magnification, and all 

scale bars read 50μm, except for the female Mex>GFP reading 40μm. 
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After observing dysplasia in the midgut, behavioural assays were used to assess 

whether damage to the intestinal epithelial structure and physiology effects the brain in a 

neurodegenerative manner, especially over aging of the animal. Therefore, negative 

geotaxis climbing assays (locomotor assays) were used to assess the Negative Geotaxis 

Climbing Ability (NGCA) of Mex>Pex5-i that successfully climbed up over the target 

height (190 mL on a 250 mL graduated cylinder) than the respective, age-matched controls 

(Mex>w1118). Flies were tested in cohorts of 20 on a regular Cornmeal (CM) diet first, at 

time points 10, 15, 20, 30, 40 and 50do.  

I observed that there was a lower average percentage of Mex>Pex5-i male flies 

showing a decline of NGCA as early as 20do and as late as 30do. All statistics were 

calculated using two-tailed, unpaired Student’s t-tests, assuming equal variance and 

α=0.05. The number of flies assayed ranged from n=60-160 flies per genotype. At 20do, 

the Mex>Pex5-i males displayed a ~17% lower success rate in climbing (NGCA) 

(M=26.00%, SD=3.000) compared to the controls (M=42.60%, SD=3.228); t(6)=7.206, 

***p=0.0004 (Figure 14A). At 30do, Mex>Pex5-i (M=26.67%, SD=12.58) displayed a 

~48% decline of NGCA compared to the control (M=75.63%, SD=12.60); t(4)=4.665, 

**p=0.0096 (Figure 14A). However, female Mex>Pex5-i were comparable to controls on 

a CM diet over all time points of aging (Figure 14B). 
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Figure 14. Drosophila negative geotaxis climbing assays of Mex>Pex5-i and respective 

controls Mex>w1118, reared at 25℃ on a CM diet (comparing between genotypes). The 

x-axis is reporting days aged, and the y-axis is reporting NGCA as the mean % of flies that 

have successfully climbed up over a target height. All statistical analyses were carried out  

using two-tailed, unpaired Student’s t-tests, assuming equal variance and an α=0.05. The 

number of flies assayed ranged from n=60-160 per genotype. A) Male Mex>Pex5-i were 

assayed in comparison to Mex> w1118 controls, at time points 10do (t(9)=1.261, p=0.2390), 

15do (t(4)=1.783, p=0.1492), 20do (t(6)=7.206, ***p=0.0004), 30do (t(4)=4.665, 

**p=0.0096), 40do (t(6)=0.2561, p=0.8064), and 50do (t(6)=0.4075, p=0.6978). B) Female 

Mex>Pex5-i were assayed in comparison to Mex> w1118 controls, at time points 10do 

(t(5)=05251, p=0.6220), 15do (t(4)=0.9827, p=0.3814), 20do (t(6)=0.3876, p=0.7117), 

30do (t(6)=0.5549), p=0.5990), 40do (t(6)=1.3350, p=0.2302), and 50do (t(6)=1.000, 

p=0.3559) 

 

These climbing assays were then repeated with animals of the same genotypes, but 

reared at 29℃ instead, because the Gal4-UAS system used to perform the PEX5 KD is 

stronger at 29℃. The reason for testing flies reared at 29℃, was to ensure that the flies 

used for the transcriptomic screen (aged 7do, raised at 29℃) were comparable in climbing 

deficit to the ones raised at 25℃ over aging, at 10, 20 or 30do. Indeed,  what was concluded 

from these assays was that male Drosophila reared at 29℃, aged approximately 10 days 

faster than at 25℃. All statistical analyses were carried out using two-tailed, unpaired 

Student’s t-tests, assuming equal variance and α=0.05. The number of animals assayed 

ranged from n=100-200 flies per genotype. At 10do, there is a significant ~45% decline of 

NGCA displayed by the Mex>Pex5-i males (M=12.50%, SD= 11.33) compared to the 
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respective controls Mex>w1118 (M=56.75%, SD= 14.37); t(14)=7.258, ****p= <0.0001 

(Figure 15A). Additionally, the female Mex>Pex5-i and controls Mex>w1118 were 

comparable over aging at time points 10, 20 and 30do (Figure 15B). 

 

  Males at 29℃                           Females at 29℃ 

 

 

 

 

 

Figure 15. Drosophila negative geotaxis climbing assays of Mex>Pex5-i and respective 

controls Mex>w1118, reared at 29℃ on a CM diet (comparing between genotypes). The 

x-axis is reporting days aged, and the y-axis is reporting NGCA as the mean % of flies that 

have successfully climbed up over a target height. All statistical analyses were carried out  

using two-tailed, unpaired Student’s t-tests, assuming equal variance and an α=0.05. The 

number of flies assayed ranged from n=100-200 flies per genotype. A) Male Mex>Pex5-i 

were assayed in comparison to Mex> w1118 controls, at time points 10do (t(14)=7.258, 

****p= <0.0001), 20do (t(14)=1.675, p=0.1161), and 30do (t(3)=0.2928, p=0.7888). B) 

Female Mex>Pex5-i were assayed in comparison to Mex> w1118 controls, at time points 

10do (t(18)=0.7259, p=0.4772), 20do (t(16)=1.512, p=0.1500), and 30do (t(8)=0.0000, 

p>0.9999). 

  

3.1.2  A HFD and AX conditions exacerbates a decline of NGCA in male 

and female Mex>Pex5-i  

A PEX5 KD perturbs midgut metabolism on a regular CM diet, corresponding to a 

decline of NGCA in male Drosophila. Other ways of disrupting gut metabolism is by 

changing the diet, such as feeding a high fat diet (HFD), or treating the animals with 

antibiotics (axenic or AX) to eliminate the gut microbiota (commensals). Since 

peroxisomes modulate dietary and commensal gut metabolism, I hypothesized that by 
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disturbing midgut metabolism of Drosophila by feeding control flies (Mex>w1118) with a 

HFD, or an antibiotic cocktail (AX), a deficit of NGCA will arise and mimic the phenotype 

of the PEX5 KD. For ease of data collection, only the 10do, 20do and 30do time points 

were measured for these conditions. Additionally, instead of 20 flies per cohort (biological 

replicate) 25 flies were used to avoid a dramatically shrinking population (n) size with 

aging since HDF and AX conditions can impact survival. All statistics were calculated 

using two-tailed, unpaired Student’s t-tests, assuming equal variance and an α=0.05. The 

number of flies assayed ranged from n=60-160 flies per genotype. 

After the HFD treatment and recovery, the NGCA of male controls mimicked that 

of Mex>Pex5-i at 30do (t(6)=0.6057, p= 0.5669)  (Figure 16A). This decline of NGCA in 

the HFD male controls was recapitulated when comparing against CM conditions. The 

control males were dramatically effected by the HFD at 30do, where there is a significant 

~35% decline of NGCA between the HFD (M=39.00%, SD=16.00) and CM (M=75.63%, 

SD=12.60); t(9)=3.438, **p=0.0074 (Figure 17A). Moreover, Mex>Pex5-i males on HFD 

versus CM were comparable over aging, at 10, 20 and 30do (Figure 17A), and therefore 

the HDF did not effect the Mex>Pex5-i males to a greater extent than the PEX5 gut KD. 

On AX conditions, the NGCA of male controls was effected so much that it 

mimicked that of Mex>Pex5-i males at 10do (t(6)=1.465, p=0.1934), 20do (t(6)=0.7160, 

p=0.7089), and 30do (t(6)=0.6679, p=0.5290), where results are comparable (Figure 16B). 

These results were recapitulated within the same genotype at 30do, where there was a 

significant 45% drop of NGCA in the control AX males (M=15.00%, SD=16.00) compared 

to the control CM males (M=60.00%, SD=13.00); t(5)=3.962, *p=0.0107 (Figure 17B). 

Moreover, the AX diet did not greatly nor significantly effect the NGCA of Mex>Pex5-i 
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males to CM males, with comparable results at 10do (t(6)=1.465, p=0.1934), 20do 

(t(6)=0.3916, p=0.7089), and 30do (t(6)=0.6679, p=0.5291) (Figure17B). 

The HFD effected the females greatly. For The females, there was no difference 

when comparing between the two genotypes, Mex>Pex5-i and Mex>w1118  controls, on the 

HFD at 10do (t(6)=0.4736, p= 0.6525), 20do (t(6)=1.477, p= 0.1901), nor 30do 

(t(5)=0.08227, p= 0.9376) (Figure 16A). However, when comparing within the same 

genotypes between HFD and CM conditions, it was evident that there was a great decline 

of NGCA within the each female genotype, observed at all time points over aging. At 10do 

control females on a HFD (M= 56.00%, SD= 26.00) exhibited a ~28% decline of NGCA 

compared to female controls on CM, although it was not statistically significant 

(M=84.09%, SD=9.549); t(7)=2.030, p=0.0819 (Figure 17C). At 20do, there was a 

statistically significant ~55% decline of NGCA exhibited by HFD controls (M=17.00%, 

SD=14.00) compared to the CM controls (M=72.00%, SD=18.00); t(7)=5.249, 

**p=0.0012 (Figure 17C). Finally, at 30do there was a significant ~50% decline of NGCA 

in the control HFD group (M= 62.22%, SD= 26.86) compared to CM controls (M= 14.00%, 

SD= 19.80), t(7)=3.294, *p=0.0132 (Figure 17C). Within the Mex>Pex5-i females, flies 

on HFD were comparable to the CM at 10 and 20do. However, at 30do the NGCA of HFD 

females significantly declined  by ~56% when Mex>Pex5-i HFD (M=15.18%, SD=16.38) 

was compared to Mex>Pex5-i CM (M= 70.83%, SD= 15.55); t(7)=5.176, **p= 0.0013 

(Figure 17C).  

The AX effected the females greatly, like the HFD. There was no difference when 

comparing between the two genotypes, Mex>Pex5-i and Mex>w1118  controls, on the AX 

at 10do (t(6)=0.4736, p= 0.6525), 20do (t(6)=1.477, p= 0.1901), nor 30do (t(5)=0.08227, 
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p= 0.9376) (Figure 16B). Females on AX conditions displayed a significant decline of 

NGCA within Mex>Pex5-i between AX and CM at all time points of aging. At 10do, 

NGCA of Mex>Pex5-i AX (M=63.00%, SD=4.000) declined by ~17% compared to Mex> 

Pex5-i CM (M= 79.56%, SD= 13.50); t(6)=02.684, *p= 0.0363 (Figure 16B). At 20do, 

NGCA of Mex>Pex5-i AX (M=34.00%, SD=10.00) significantly declined by 39%  

compared to Mex>Pex5-i CM (M= 73.00%, SD= 11.00); t(7)=5.569, ***p= 0.0008 (Figure 

16B). Finally, at 30do NGCA of Mex>Pex5-i AX (M=28.00%, SD=16.00) significantly 

declined by ~49% versus Mex> Pex5-i CM (M= 70.83%, SD= 15.55); t(7)=4.040, **p= 

0.0049 (Figure 16B). 

When comparing within the same genotype, NGCA of AX Mex>w1118 control 

females, greatly declined  compared to CM Mex>w1118 control females at 10do, 20do, and 

30do (Figure 17D). At 10do, AX controls (M= 59.00%, SD= 12.00) displayed a significant 

~25% decline of NGCA compared to CM controls (M=84.09%, SD=9.549); t(5)=3.100, 

*p=0.0269 (Figure 17D). At 20do, there was a non-significant ~31% decline of NGCA in 

AX controls (M=41.00%, SD=28.00) compared to the CM Mex>w1118 (M=72.00%, 

SD=18.00); t(5)=1.829, p=0.1269 (Figure 17D). Finally, at 30do there was a significant 

~58% decline of NGCA by the AX controls (M= 62.22%, SD= 26.86) compared to the 

CM controls (M= 4.000%, SD= 7.000), t(7)=3.711, *p=0.0138 (Figure 17D). Indicating 

that for both Mex>Pex5-i and controls, the elimination of gut microbiota severely impacts 

the NGCA of females regardless of genotype.  
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Figure 16. Drosophila negative geotaxis climbing assays of Mex>Pex5-i and respective 

controls Mex>w1118, reared at 25℃ on a HFD and AX diet (comparing between 

genotypes). The x-axis is reporting days aged, and the y-axis is reporting NGCA as the 

mean % of flies that have successfully climbed up over a target height. All statistical 

analyses were carried out using two-tailed, unpaired Student’s t-tests, assuming equal 

variance and an α=0.05. The number of flies assayed ranged from n=60-160 per genotype.  

A) HFD Male Mex>Pex5-i were assayed in comparison to respective Mex> w1118 controls, 

at time points 10do (t(9)=1.536, p=0.1589), 20do (t(7)=18.64, ****p= <0.0001), 30do 

(t(6)=0.6057, p= 0.5669). HFD Female Mex>Pex5-i were assayed in comparison to 

respective Mex> w1118 controls, at time points 10do (t(6)=0.4736, p= 0.6525), 20do 

(t(6)=1.477, p= 0.1901), and 30do (t(5)=0.08227, p= 0.9376). B) AX Male Mex>Pex5-i 

were assayed in comparison to respective Mex> w1118 controls, at time points 10do 

(t(6)=1.465, p=0.1934), 20do (t(6)=0.7160, p=0.7089), and 30do (t(6)=0.6679, p=0.5290). 

AX Female Mex>Pex5-i were assayed in comparison to respective Mex> w1118 controls, at 

time points 10do (t(6)=02.684, *p= 0.0363), 20do (t(7)=5.569, ***p= 0.0008), and 30do 

(t(7)=4.040, **p= 0.0049). 
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Figure 17. Drosophila negative geotaxis climbing assays of Mex>Pex5-i and respective 

controls Mex>w1118 reared at 25℃ on a HFD and AX diet (comparing within 

genotypes). The x-axis is reporting days aged, and the y-axis is reporting NGCA as the 

mean % of flies that have successfully climbed up over a target height. All statistical 

analyses were carried out using two-tailed, unpaired Student’s t-tests, assuming equal 
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variance and an α=0.05. The number of flies assayed ranged from n=60-160 per genotype. 

A) HFD male Mex>Pex5-i were assayed in comparison to CM male Mex>Pex5-i, at time 

points 10do (t(4)=0.3045, p=0.7759), 20do (t(4)=1.269, p=0.2731), and 30do (t(4)=1.007, 

p=0.3710). HFD male Mex> w1118 controls were assayed in comparison to CM male Mex> 

w1118 controls, at time points 10do (t(9)=1.536, p=0.1589), 20do (t(9)=3.438, **p=0.0074), 

and 30do (t(6)=0.6057, p= 0.5669). B) AX male Mex>Pex5-i were assayed in comparison 

to CM male Mex>Pex5-i, at time points 10do (t(6)=1.465, p=0.1934), 20do (t(6)=0.3916, 

p=0.7089), and 30do (t(6)=0.6679, p=0.5291). AX male Mex> w1118 controls were assayed 

in comparison to CM male Mex> w1118 controls, at time points 10do (t(5)=0.4216, 

p=0.6908), 20do (t(5)=0.5616, p=0.5986), and 30do (t(5)=3.962, *p=0.0107). C) HFD 

female Mex>Pex5-i were assayed in comparison to CM female Mex>Pex5-i, at time points 

10do (t(4)=0.3774, p=0.7250), 20do (t(5)=1.592, p=0.1722), and 30do (t(7)=5.176, **p= 

0.0013). HFD female Mex> w1118 controls were assayed in comparison to CM female 

Mex> w1118 controls, at time points 10do (t(7)=2.030, p=0.0819), 20do (t(7)=5.249, 

**p=0.0012), and 30do (t(7)=3.294, *p=0.0132). D) AX female Mex>Pex5-i were assayed 

in comparison to CM female Mex>Pex5-i, at time points 10do (t(6)=02.684, *p= 0.0363), 

20do (t(7)=5.569, ***p= 0.0008), and 30do (t(7)=4.040, **p= 0.0049). AX female Mex> 

w1118 controls were assayed in comparison to CM female Mex> w1118 controls, at time 

points 10do (t(5)=3.100, *p=0.0269), 20do (t(5)=1.829, p=0.1269), and 30do (t(7)=3.711, 

*p=0.0138).  

 

3.1.3  Niacin treatment improves NGCA of aged Mex>Pex5-i males 

After observing a locomotor decline in the males, the next step was to figure out 

how this phenotype could be rescued. In previous literature, vitamin B3 or niacin has been 

found to improve locomotion in PD humans and flies (Jia et al., 2008; Wakade et al., 2021). 

Therefore, Mex>Pex5-i and Mex>w1118 control flies were fed a CM diet mixed with 10 

mmol of  niacin for 30 days after eclosure (n=60 flies per genotype and condition), and 

then assayed for NGCA. All statistics were calculated using two-tailed, unpaired Student’s 

t-tests, assuming equal variance and an α=0.05. The number of flies assayed were n=60 

flies per genotype. At 30do, there was a small but statistically insignificant ~22% 

improvement of NGCA in response to niacin treatment for Mex>Pex5-i males compared 

to non-treated animals; t(4)=0.7584, p=0.4904 (Figure 18). Additionally Mex>w1118 

controls (M= 64.47%, SD=4.235) also showed a small but statistically significant ~21% 
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improvement when treated with niacin compared to untreated (M= 43.52%, SD=10.72); 

t(4)=3.149, *p=0.0345 (Figure 18).  

 

 

 

 

 

 

 

 

 

 

 

Figure 18. Mex>Pex5-i and Mex>w1118 males treated with niacin for 30 days show an 

improvement of locomotor ability compared to flies on CM conditions. For each 

genotype n=60 flies, and statistical analyses were carried out using two-tailed, unpaired 

Student’s t-tests, assuming equal variance and an α=0.05. There was only a significant 

improvement of NGCA on niacin versus no niacin treatments exhibited by Mex>w1118 

males (*p=0.0345).  

 

3.1.4  Mex>SNCA and Mex>BACE males exhibit deficits of NGCA on CM 

conditions  

By overexpressing canonical human-linked mutant-alleles of NDs that encode for  

α-Synuclein (SCNA), or β-secretase (BACE) in the brains of Drosophila, a neurodegenrtive 

phenotype/ pathologies arise (Greeve et al., 2004; Jahromi et al., 2020; Prüßing et al., 

2013). However, what about in the midgut?  To understand whether the expression of these 

mutant proteins in the intestinal tract can seed and trigger AD and PD phenotypes in the 

brain from the gut, as hypothesized in few mammalian studies (Braak et al., 2003; Challis 
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et al., 2020), these models were assayed for climbing deficits. These models were also used 

as a midgut metabolism perturbation positive control for the Mex>Pex5-i.  

On CM conditions, Mex>BACE males displayed a decline of NGCA at 15do and 

20do however, there was a high mortality in both sexes between 20 and 30 days compared 

to the respective Mex>GFP strain used as controls. At 15do, there was a significant ~55% 

decline of NGCA exhibited by Mex>BACE  (M= 12.63%, SD= 2.743) compared to control 

(M=67.59%, SD= 5.814); t(6)=17.10, ****p<0.0001 (Figure 19A). Likewise, at 20do there 

was a significant ~41% decline of NGCA exhibited by Mex>BACE (M= 12.16%, SD= 

4.616) compared to the control (M=53.10%, SD= 18.42); t(8)= 4.820, **p=0.0013 (Figure 

19A). On the contrary at 15do, female Mex>BACE on CM conditions (M=64.06%, SD= 

8.469) displayed no decline of NGCA compared to the female CM Mex>GFP control 

(M=71.30%, SD= 14.15); t(11)=1.092, p=0.2981 (Figure 19A). At 20 days the Mex>BACE 

females were climbing significantly better by ~26% (M=75.07%, SD= 18.21) compared to 

the controls (M=49.47%, SD= 19.77); t(10)=2.282, *p=0.0457 (Figure 19A). However, the 

standard deviations were very large, and the significance is very close to the alpha value 

of 0.05, so there may not be a difference at all. Thus, it was concluded that on CM 

conditions, only male Mex>BACE display a deficit of NGCA. 

On regular CM conditions, the NGCA of Mex>SNCA males declined significantly 

compared to male CM Mex>GFP controls at both 10do and 20do. As early as 10do, the 

NGCA of Mex>SNCA  (M=32.00%, SD=13.00) declined by ~54% compared to the 

controls (M=86.20%, SD=7.050); t(7)=8.046, ****p< 0.0001 (Figure 19B). At late as 20do 

before controls began to decline to the same degree, NGCA of Mex>SNCA (M=12.00%, 

SD=12.00) significantly decreased by ~41% compared to controls (M=53.00%, 
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SD=16.48); t(6)= 3.719, **p= 0.0099 (Figure 19B). The female CM Mex>SNCA also 

displayed a decline of NGCA compared to the female CM Mex>GFP control at 10do and 

20do, but not 30do and 40do (Figure 19B). Additionally, unlike the males, the mortality of 

the females was high around 50do (absence of 50do time point). At 10do, Mex>SNCA 

(M=43.00%, SD=7.000) flies displayed significantly reduced NGCA by ~33% compared 

to controls (M=76.16%, SD=13.92); t(11)= 3.893, **p=0.0025 (Figure 19B). At 20do,  

Mex>SNCA (M=55.00%, SD=8.000) displayed a significant ~22% decline of NGCA 

compared to controls (M=74.85%, SD=11.60); t(7)= 2.625, *p= 0.0342 (Figure 19B).  
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Figure 19. Drosophila negative geotaxis climbing assays of Mex>BACE, Mex>SNCA 

and respective controls Mex>GFP, reared at 25℃ on a CM diet (comparing 

between genotypes). The x-axis is reporting days aged, and the y-axis is reporting 

NGCA as the mean % of flies that have successfully climbed up over a target height. All 

statistical analyses were carried out using two-tailed, unpaired Student’s t-tests, assuming 

equal variance and an α=0.05. The number of flies assayed ranged from n=60-160 per 

genotype. A) CM male Mex>BACE were assayed in comparison to respective control 

CM male Mex>GFP, at time points 15do (t(6)=17.10, ****p<0.0001), and 20do (t(8)= 
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4.820, **p=0.0013). CM female Mex>BACE were assayed in comparison to respective 

CM female Mex>GFP controls, at time points 15do (t(11)=1.092, p=0.2981), and 20do 

(t(10)=2.282, *p=0.0457). B) CM male Mex>SNCA were assayed in comparison to 

respective CM male Mex>GFP controls, at time points 10do (t(7)=8.046, ****p< 

0.0001), 20do (t(6)= 3.719, **p= 0.0099), 30do (t(7)= 0.8568, p= 0.4199), 40do (t(3)= 

5.035, p= 0.4253), and 50do (t(3)= 1.028, p= 0.3796). CM female Mex>SNCA  were 

assayed in comparison to CM female Mex>GFP controls, at time points 10do (t(11)= 

3.893, **p=0.0025), 20do (t(7)= 2.625, *p= 0.0342), 30do (t(8)=1.700 p= 0.1275) and 

40do (t(8) 2.272 p= 0.0527). 

 

3.1.5  HFD and AX conditions exacerbate the decline of NGCA in male and 

female Mex>BACE and Mex>SNCA 

Similarly to the PEX5 gut-KD models, Mex>BACE or Mex>SNCA and control 

Mex>GFP were subjected to a HFD and AX diet. However, the results of Mex>BACE 

males and females were confusing, and did not correspond to what was observed with the 

Mex>Pex5-i males nor females for some of the same conditions.  

On HFD condtions, Mex>BACE male fly sruvival had improved on the HFD 

condition and enough flies survived to assay at 30do (Figure 20A). However, at 30do 

Mex>BACE males (M=12.00%, SD=12.00) exhibited a significant 38% decline of NGCA 

compared to the HFD Mex>GFP male controls (M=50.00%, SD=2.000); t(4)=4.20281, 

*p=0.0136 (Figure 20A). On the contrary to the males, HFD Mex>BACE females 

(M=3.000%, SD=3.000) hardly climbed up the cylinder at all, with a 3% total climbing 

success rate over the 190 mL mark, compared to the respective HFD Mex>GFP female 

controls (M=53.04%, SD=24.21); t(5)=3.476, *p=0.0177 (Figure 20A). At 20do the 

Mex>GFP females dropped to the same climbing success rate as the Mex>BACE females, 

thus both genotypes were comprarable and effected greatly after consumption of a fat rich 
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diet; t(6)=0.5336%, p=0.6128 (Figure 20A). Unlike the males, the females still did not live 

as long as 30do on the HFD nor AX diet.  

Only at 30do, AX Mex>BACE male flies displayed a significant ~41% decline of 

NGCA (M=15.00%, SD=12.00) compared to male AX Mex>GFP controls (M=56.00%, 

SD=23.00); t(7)=3.477, *p=0.0103  (Figure 20B). Interestingly, the trend of NGCA over 

aging for the female AX Mex>BACE  flies were similar to the males on AX conditons at 

10, 20 and 30do (Figure 20B). At 10do, both AX Mex>BACE females and control AX 

Mex>GFP females were comparable; t(8)=0.6519, p=0.5328. At 20do, there was an 

unusual significant ~32% improvement of Mex>BACE NGCA (M=67.00%, SD=12.00) 

than the control (M=34.69%, SD=14.00), t(8)=3.366, **p=0.0098 (Figure 20B). Finally, 

at 30do, there was a ~29% significant NGCA decline exhibited by Mex>BACE 

(M=15.00%, SD=12.00) compared to the control (M=43.75%, SD=11.31); t(8)=3.898, 

**p=0.0046 (Figure 20B). 

A 

 

 

 

 

 
0 10 20 30 40

0

20

40

60

80

100

Males

Days

%
 o

f 
F

li
e

s
 o

v
e

r 
1

9
0

m
l

Mex>GFP

Mex>BACE

*

0 10 20 30 40

0

20

40

60

80

100

Females

Days

%
 o

f 
fl

ie
s
 o

v
e
r 

1
9
0
m

L Mex>GFP HFD

Mex>BACE HFD
*



89 
 

B       

 

 

 

 

 

 

Figure 20. Drosophila negative geotaxis climbing assays of Mex>BACE and 

respective controls Mex>GFP, reared at 25℃ on a HFD and AX diet (comparing 

between genotypes). The x-axis is reporting days aged, and the y-axis is reporting 

NGCA as the mean % of flies that have successfully climbed up over a target height. All 

statistical analyses were carried out using two-tailed, unpaired Student’s t-tests, assuming 

equal variance and an α=0.05. The number of flies assayed ranged from n=60-160 per 

genotype. A) HFD male Mex>BACE were assayed in comparison to respective HFD 

male Mex>GFP controls, at time points 10do (t(8)= 0.0570, p=0.9560), and 20do (t(8)= 

1.272, p=0.2391), and 30do (t(4)=4.20281, *p=0.0136). HFD female Mex>BACE were 

assayed in comparison to respective HFD female Mex>GFP controls, at time points 10do 

(t(5)= 3.476, *p=0.0177), and 20do (t(6)=0.5336%, p=0.6128). B) AX male Mex>BACE 

were assayed in comparison to respective AX male Mex>GFP controls, at time points 

10do (t(7)=2.051, p=0.0794), 20do (t(6)=2.311, p=0.0602), and 30do (t(7)=3.477, 

*p=0.0103). AX female Mex>BACE  were assayed in comparison to AX female 

Mex>GFP controls, at time points 10do (t(8)= 0.6519, p=0.5328), 20do (t(8)=3.366, 

**p=0.0098), and 30do (t(8)=3.898, **p=0.0046). 

 

Males and females on a HFD and AX diet exhibited no difference of NGCA 

between the Mex>SNCA and respective HFD Mex>GFP controls, at 10do, 20do nor 30do 

(Figure 21). However, only at 10do, there was a  ~24% decline of NGCA in the control 

Mex>GFP AX males (M=33.09%, SD= 13.53) compared to Mex>SNCA AX males 

(M=57.20%, SD= 6.606); t(8)=3.581, **p=0.0072 (Figure 21). These phenotypes were 

similar to what was observed for the male and female Mex>Pex5-i flies, when challanegd 

with a HFD and AX treatment to remove gut commensals.  
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Figure 21. Drosophila negative geotaxis climbing assays of Mex>SNCA and 

respective controls Mex>GFP, reared at 25℃ on a HFD and AX diet (comparing 

between genotypes). The x-axis is reporting days aged, and the y-axis is reporting 

NGCA as the mean % of flies that have successfully climbed up over a target height. All 

statistical analyses were carried out using two-tailed, unpaired Student’s t-tests, assuming 

equal variance and an α=0.05. The number of flies assayed ranged from n=60-160 per 

genotype. A) HFD male Mex>SNCA were assayed in comparison to respective HFD 

male Mex>GFP controls, at time points 10do (t(8)=0.3405, p=0.7423), 20do (t(6)=1.772, 

p=0.1268), and 30 (t(2)=1.000, p=0.4227). HFD female Mex>SNCA were assayed in 

comparison to respective HFD female Mex>GFP controls, at time points 10do (t(7)= 

0.3217, p=0.7571), 20do (t(8)=2.194, p=0.0596),  30do (t(6)=2.145, p=0.0757). B) AX 

male Mex>SNCA were assayed in comparison to respective AX male Mex>GFP 

controls, at time points 10do (t(8)=3.581, **p=0.0072), 20do (t(6)=0.3024, p=0.7726), 

30do (t(4)=0.2248, p=0.8332). AX female Mex>SNCA  were assayed in comparison to 

AX female Mex>GFP controls, at time points 10do (t(8)=1.109, p=0.2296), 20do 

(t(7)=0.1417, p=0.8913), and 30do (t(6)=0.6232, p=0.5561). 

 

 When comparing within genotypes, the NGCA of male Mex>GFP on HFD 

appeared to be impacted by the HFD significantly by ~37% at 10do (M=46.32%, 

SD=12.00) compared to Mex>GFP CM males (M=83.00%, SD=10); t(7)= 4.141, 
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**p=0.0043 (Figure 22A). Likewise, there was a significant ~23% drop of NGCA at 10do 

by the AX Mex>GFP males (M=60.32%, SD=10.83) compared to male CM Mex>GFP 

(M=85.00%, SD=8.446); t(9)= 3.533, **p=0.0064 (Figure 22A). Therfore, both the HFD 

and AX diets effected the Mex>GFP controls’ climbing behaviour from a very young age.  

The Mex>GFP HFD females were also severely effected by the HFD, at all time 

points instead of just the earliest time point at 10do. Diplaying a significant ~23%, ~41% 

and ~24% decline of NGCA at 10do (M=53.04, SD=24.21), 20do (M=7.714%, SD=12.44) 

and 30do (M=14.86%, SD=13.86) compared to the Mex>GFP CM females at 10do 

(M=76.16%, SD=13.92), 20do (M=48.19%, SD=21.34) and  at 30do (M=39.30%, SD 

15.33); 10do t(12)=2.288, *p=0.0411, 20do t(9)=3.727, **p=0.0047, and 30do t(8)=2.559, 

*p=0.0337 (Figure 22B). However, similar to the Mex>GFP AX males, the AX Mex>GFP 

females only exhibited a decline of NGCA at 10do (M=43.62%, SD=14.00) compared to 

their respective controls, the Mex>GFP CM females (M=76.16%, SD=13.92); t(13)= 

4.260, ***p=0.0009 (Figure 22B).  

When comparing within the Mex>BACE genotype, HFD and AX conditions appear 

to rescue the almost null climbing success rate that was exhibited by the Mex>BACE males 

on a CM diet. At 20do on HFD, there was a significant ~45% improvement of NGCA of 

the Mex>BACE males (M=57.00%, SD= 26.00) compared to Mex>BACE CM males 

(M=12.16%, SD= 4.616); t(10)=3.763, **p=0.0037 (Figure 22C). Likewise, at 20do there 

was a significant ~55% improvement of NGCA of AX males (M=67.00%, SD= 12.00) 

compared to CM males (M=12.16%, SD= 4.616); t(7)=9.511, ****p< 0.0001 (Figure 

22C). On the contrary, instead of an improvement of NGCA, Mex>BACE  HFD females 

exhibited a dramatic decline of NGCA, where the female flies hardly moved at the bottom 
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of the cylinder, compared to Mex>BACE CM. At 20do there was an ~72% decline of 

NGCA by the Mex>BACE HFD females (M=3.600%, SD= 5.000) compared to 

Mex>BACE CM females (M=75.07%, SD=18.22); t(6)=6.446, ***p=0.0007 (Figure 22D). 

Finally, on AX conditions there was no differnece in climbing at 20do between AX 

Mex>BACE females and CM Mex>BACE females; t(8)=0.8273, p=0.4321 (Figure 22D).  

When comparing within the Mex>SNCA genotype, the HFD appears to have no 

further effects on the Mex>SNCA males compared to the Mex>SNCA CM males at 10do 

(t(7)=1.212, p=0.2647) and 20do (t(5)=0.4186, p=0.6929) (Figure 22E); similar to what 

was observed with Mex>Pex5-i on CM versus HFD. However, at 30do, Mex>SNCA HFD 

males decline to a 0% climbing success rate (M=0.000%, SD= 0.000), a 40% difference 

compared to the Mex>SNCA CM (M=40.00%, SD=6.000); t(4)=9.357, ***p=0.0007 

(Figure 22E). When comparing between CM and AX Mex>SNCA males, over aging both 

conditional effects were comprabel, howver AX Mex>SNCA males (M=57.20%, SD= 

6.606) climbed up the cylinder significantly better than the Mex>SNCA CM males 

(M=32.00%, SD=13.00) at  and early age of 10do; t(7)=3.807, **p=0.0067 (Figure 22E).  

Mex>SNCA HDF females only exhibited a significant 28% decline of NGCA at 

30do (M=0.000%, SD=0.000), compared to Mex>SNCA CM females (M=28.00%, 

SD=12.000); t(6)=4.667, **p=0.0034 (Figure 22F). On AX conditions, there were no 

striking diffrences between the Mex>SNCA AX and Mex>SNCA CM females over aging 

(Figure 22F). However, at 20do, the Mex>SNCA AX females (M=33.39%, SD=3.303) 

displayed a ~21% drop of NGCA compared to Mex>SNCA CM females (M= 55.00%, 

SD=8.000); t(5)=4.989, **p=0.0041 (Figure 22F).  
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Figure 22. Drosophila negative geotaxis climbing assays of Mex>BACE and Mex 

SNCA and respective controls Mex>GFP, reared at 25℃ on a CM, HFD and AX 

diet (comparing within genotypes). The x-axis is reporting days aged, and the y-axis is 

reporting NGCA as the mean % of flies that have successfully climbed up over a target 

height. All statistical analyses were carried out using two-tailed, unpaired Student’s t-

tests, assuming equal variance and an α=0.05. The number of flies assayed ranged from 

n=60-160 per genotype. A) CM male Mex>GFP controls were assayed in comparison to 

respective HFD male Mex>GFP controls, at time points 10do (t(7)= 4.141, **p=0.0043), 

20do (t(6)=1.569, p=0.1677), and 30do (t(5)=1.852, p=0.1233). CM male Mex>GFP 

controls were assayed in comparison to respective AX male Mex>GFP controls, at time 

points 10do (t(9)= 3.533, **p=0.0064), 20do (t(7)=1,271, p=0.2443), and 30do 

(t(7)=1.841, p=0.1082). B) CM female Mex>GFP controls were assayed in comparison 

to respective HFD female Mex>GFP controls, at time points 10do (t(12)=2.288, 

*p=0.0411), 20do (t(9)=3.727, **p=0.0047), and 30do (t(8)=2.559, *p=0.0337). CM 

female Mex>GFP controls were assayed in comparison to respective AX female 

Mex>GFP controls, at time points 10do (t(13)= 4.260, ***p=0.0009), 20do (t(9)=1.124, 

p=0.2902), and 30do (t(9)=0.5366, p=0.6046). C) CM male Mex>BACE were assayed in 

comparison to HFD male Mex>BACE, at time point 20do (t(10)=3.763, **p=0.0037). 

CM male Mex>BACE were assayed in comparison to AX male Mex>BACE, at time 

point 20do (t(7)=9.511, ****p< 0.0001). D) CM female Mex>BACE were assayed in 

comparison to HFD female Mex>BACE, at time point 20do (t(6)=6.446, ***p=0.0007). 

CM female Mex>BACE were assayed in comparison to AX female Mex>BACE, at time 

point 20do (t(8)=0.8273, p=0.4321). E) CM male Mex>SNCA were assayed in 

comparison to HFD male Mex>SNCA, at time points 10do (t(7)=1.212, p=0.2647), 20do 

(t(5)=0.4186, p=0.6929), and 30do (t(4)=9.357, ***p=0.0007). CM male Mex>SNCA 
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were assayed in comparison to AX male Mex>SNCA, at time points 10do (t(7)=3.807, 

**p=0.0067), 20do (t(5)=0.6903, p=0.5207), and 30do (t(5)=0.9408, p=0.3810). F) CM 

female Mex>SNCA were assayed in comparison to HFD female Mex>SNCA, at time 

points 10do (t(6)=0.2154, p=0.836620do (t(6)=2.305, p=0.0606), and 30do (t(6)=4.667, 

**p=0.0034). CM female Mex>SNCA were assayed in comparison to AX female 

Mex>SNCA, at time points 10do (t(6)=1.089, p=0.3179), 20do (t(5)=4.989, **p=0.0041), 

and 30do (t(5)=2.526, p=0.0528). 

 

3.1.6  Mex>SNCA males exhibit poor courtship memory  

The second type of behavioural assay used measure neurodegeneration in the 

Drosophila brain was a short-term memory assay (courtship memory) designed for male 

flies (Koemans et al., 2017). Since the males had displayed the strongest phenotype, this 

assay was another way to assess neurodegeneration in the brain. Short term memory assays 

were carried out on Mex>Pex5-i, and control Mex>w1118, in addition to the reference model 

of Mex>SNCA, and respective control Mex>GFP. Furthermore, statistical analyses were 

carried out using multiple, unpaired t-tests assuming equal variance with an α=0.05, n=11-

12 flies. 

There was no courtship memory deficit displayed by the Mex>Pex5-i CM males 

because Mex>Pex5-i CM males (M=0.000%, SD=0.000) and Mex>w1118 CM males 

(M=6.444%, SD=11.42) were comparable after training; t(22)=1.955, p=0.0634 (Figure 

23A). Moreover, both trained Mex>Pex5-i CM males, and trained Mex>w1118 CM males 

displayed significantly reduced courtship behaviour (by ~84-88%), compared to the naïve 

Mex>Pex5-i CM males (M=83.52%, SD=23.53) and naïve Mex>w1118 CM males 

(M=88.31%, SD=8.684) positive controls; t(21)=19.21, ****p<0.0001, and t(21)=12.32, 

****p<0.0001 (Figure 23A). These results are recapitulated by the LI (learning index), 

which indicated how well the flies have successfully learned and remembered how to 



96 
 

identify rejection from a pre-mated female compared to the positive control. Mex>w1118 

CM males have an LI of 93.13%, and Mex>Pex5-i CM males have an LI of 100%, both 

high values indicate that the male flies have effectively reduced their courtship behaviour 

in response to a pre-mated females, after training,  just like the controls. Of note, these 

assays were only performed on flies younger than 20do, thus it will be important to test 

Mex>Pex5-i again at an older age.  

The trained Mex>SNCA CM males did not reduce their courtship behaviour 

towards mated-females (M=68.9%3, SD= 34.66), but the trained Mex>GFP CM control 

males did (M=0.000%, SD=0.000); there were no signs of courtship identified, 

t(20)=6.597, ****p<0.0001 (Figure 23B). The trained Mex>SNCA CM males did not 

display the same degree of courtship to their naïve counterparts either, there was still a 

~30% decline in courtship of the trained males (M=68.93%, SD=34.66) versus the naïve 

males (M=99.39%, SD=1.052); t(20)=2.913, **p=0.0086 (Figure 23B). However, this 

decline of courtship behaviour by the trained Mex>SNCA CM males compared to their 

naïve counterparts was not similar to the decline observed in the trained versus naïve 

control Mex>GFP, trained males (M=0.000%, SD=0.000) versus naïve males (M=68.93%, 

SD=34.66) ; t(20)=166.3, ****p<0.0001 (Figure 23B). Furthermore, the LI of Mex>SNCA 

CM males was LI= 30.64%, and Mex>GFP CM males LI= 100%, indicating that 

Mex>SNCA CM males were ~ 69% less effective at identifying the rejection of a pre-mated 

females than the Mex>GFP CM male controls (Figure 23B). Of note, these assays were 

also carried out on younger flies (~5do), therefore, the Mex >SNCA have a decline in 

learning memory already as young adults. 
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Figure 23. Short-term memory assays (courtship assays) of Mex>Pex5-i and control 

Mex>w1118 CM males, and Mex>SNCA and control Mex>GFP CM males. A) The LIs 

of Mex>Pex5-i and control Mex>w1118 CM males are 100.0% and 93.13% respectively 

which is concurrent with comparable average courting time after training between both 

genotypes. B) The LIs of Mex>SNCA and control Mex>GFP CM males are 30.64% and 

100% respectively, concurrent with the ~69% increase of memory deficit in trained 

Mex>SNCA males compared to trained Mex>GFP controls (****p<0.0001). Statistical 

analyses were carried out using multiple, unpaired t-tests, assuming equal variance and an 
α=0.05. 

 

3.1.7  Mex>Pex5-i and Mex>SNCA males and females do not have feeding nor 

heart abnormalities  

To rule out feeding behaviour abnormalities as a confounding variable for the 

locomotor deficit observed in the male flies, in collaboration with Dr. Deniz Top, feeding 

assays were carried out to test male Mex>Pex5-i, Mex>w1118, Mex>SNCA, and Mex>GFP.  

The conclusion was that the flies of each genotype do not show a feeding difference 

compared to controls (Figure 24.1). Dr. Top also provided data regarding when and how 

much food is consumed by the flies hourly, by average, over a 30hr time course. From the 
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spike graphs during the 12hr dark cycle the Mex>Pex5-i CM males appear to be more 

active and eating at more frequent time intervals than the control Mex>w1118. The  

Mex>w1118 controls are in a rest state for the majority of the cycle, this is normal sleep 

behaviour for Drosophila, while the Mex>Pex5-i appear to be more active suggesting 

disturbances in sleep circadian at night (Figure 24.2). However, this observation will be 

discussed further with the collaborators to understand whether the changes observed are 

legitimate or negligible.  

Drosophila feeding assays 

 

Figure 24.1. Feeding assays. The average amount of food consumed over three days, in 

μl versus genotypes Mex>Pex5-i control Mex>w1118, Mex>SNCA, and control Mex>GFP 

males; n= 60 flies. No significant difference across genotypes was indicated by statistical 

analysis using a two-tailed unpaired t-test, assuming equal variance.  

 

 

 

. . 

Mex>Pex5-i  

 

             Mex>w1118 

Mex>SNCA 

 

             Mex>GFP 
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Average Drosophila feeding over time (30hr) 

 

 

 

 

 

 

 

 

 

 

Figure 24.2. Feeding assays: in 1hr intervals over 30hrs.The white areas represents data 

being collected within the 12hr light cycle, while the medium gray areas indicate data 

collection during the dark 12hr light cycle.  

 

Another potential confounder for the observed locomotor deficit could be a 

development defect in the heart, as a consequence of the Pex5 gut-KD during development. 

Therefore, in collaboration with Dr. Hua Bai at Iowa State University, the hearts of both 

genotypes Mex>Pex5-i and Mex>SNCA males and females plus respective controls 

Mex>w1118 and Mex>GFP,  were assessed on a CM (Normal Diet, ND) and HFD (Figure 

25). 

The five parameters measured were heart rate (HR), heart pressure (HP), 

arrhythmia (AI), diastole (DI) and systole (SI). HR and HP primarily measured whether 

the hearts were beating normally, not slower or faster against pressure in the systemic 

circulation, and that there are no mechanical defects of the heart. AI was used to identify 

abnormalities of the hearts pacemaker, and to rule out any physiological defects of the 
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heart. Finally, diastole and systole were used to measure contractility of the heart, to further 

rule out any mechanical or physiological defects.  

Overall, there were no striking differences between Mex>Pex5-i  and Mex>w1118 

(Figure 25A,B) in both sexes. However, the HR of the female Mex>Pex5-i both on ND 

and HFD was faster in comparison to Mex>w1118 females on a ND, ***p=0.0003 and 

*p=0.0156 respectively. However, the HP of the Mex>Pex5-i females was longer (heart 

takes longer to fill and contract) than the controls on ND (*p=0.0335). The HP is 

recapitulated by the systole (the contractility of the heart to pump blood through the body) 

which was significantly increased (the heart is contracting more vigorously) in Mex>Pex5-

i females compared to controls on both ND (*p=0.0215), and especially HFD 

(****p<0.0001).  

 Mex>SNCA and controls Mex>GFP females and males presented no differences 

in most parameters analyzed (Figure 25C, D). However, the HR of the female Mex>SNCA 

fed a HFD was faster than controls fed a HFD (*p=0.0085), and Mex>SNCA females fed 

a ND (*p=0.0384). This was also true for the SI of the fly, where output of the heart was 

decreased in Mex>SNCA females on a HFD compared to controls on a HFD (*p=0.0227), 

and Mex>SNCA on a ND (*p=0.0216). 

Dr. Bai predicted that these changes in HR may not be enough to induce a 

locomotor phenotype in the flies, especially when considering the spread of the data. This 

is true for the Mex>Pex5-i, because females do not show the decline in negative geotaxis 

but the males do, and the males do not have any heart abnormalities. Conclusively, the 

heart is not a confounding variable, otherwise abnormalities in the heart would correspond 

to the locomotor deficits observed. This is also true for Mex>SNCA males but, Mex>SNCA 
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do exhibit a reduction of NGCA. However, the heart is not a confounding variable for 

Mex>SNCA either.  

A  Mex>Pex5-i and Mex>w1118 male heart assessments 

 

 

 

 

 

 

 

 

B  Mex>Pex5-i and Mex>w1118 female heart assessments  
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C  Mex>SNCA and Mex>GFP male heart assessments 

 

 

 

 

 

 

 

 

 

 

 

 

D  Mex>SNCA and Mex>GFP female heart assessments 

 

 

 

 

 

 

 

 

 

 

 

Figure 25. Heart assessments of Mex>Pex5-i and controls Mex>w1118 males and females, 

and Mex>SNCA and controls Mex>GFP males and females, aged to 20do. Five 

paramenters were tested: HR, HP, AI, DI and SI. A) Mex>Pex5-i and controls Mex>w1118 

males B) Mex>Pex5-i and controls Mex>w1118  females. C) Mex>SNCA and controls 

Mex>GFP males. D) Mex>SNCA and controls Mex>GFP females. All Statistical analysis 
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was carried out using a one-way ANOVA, and no significant differences were observed 

between each genotype and respective control. Only Mex>Pex5-i and Mex>SNCA females 

exhibited elevated heart rates and more forceful heart contractions on ND and HFD 

compared to controls (as described above). (n=15-20 flies per sex, genotype, and 

condition). 

 

3.1.8 Sub-section summary 

 In summary, PEX5 gut-KD, and therefore dysfunction of peroxisomal metabolism 

in the midgut of flies raised on solely a CM diet, causes defects in locomotor negative 

geotaxis climbing ability for males but not females. When a HFD and AX conditions are 

introduced, the Mex>Pex5-i male locomotor phenotype does not worsen, however the 

control males are effected by both HFD and AX conditions. Locomotor climbing ability is 

only effected in the females when reared on HFD or AX conditions, and similar effect of 

HFD or AX are observed in control  female flies as the males. Therefore I concluded that 

a defect in peroxisomal metabolism has a locomotor effect on the organism over aging, 

known to accumulate free fatty acids in the intestinal cells,  and phenocopies the effect that 

a HFD and/or antibiotic treatment (AX) has (leading to dysbiosis of the midgut). Similarly,  

Mex>SCNA males present climbing deficits, although to a larger extent than the deficits 

observed in Mex>Pex5-i males. Mex>SNCA males also present memory impairment. 

Feeding behaviour and heart dysfunction were ruled out as confounding variables that may 

effect locomotion in males of both analyzed genotypes compared to the relative control. 

These assays highlighted the importance of the DMGB axis to preserve locomotor activity 

in aging animals. Moreover, to determine whether the locomotion defects are caused by 

high inflammation (inflammatory cytokines/antimicrobial peptides expression and/or high 

oxidative stress) in the brain of aging Mex>Pex5-i and Mex>SNCA, I measured these 

parameters using various assays (see next section). As locomotor defects and brain 
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inflammation was mainly observed in males, the brains of these flies were assessed for 

inflammation (looking at antimicrobial peptides, AMPs), redox stress, and 

physical/physiological damage. These assays helped to investigate how the effects that 

defective peroxisomes (Mex>Pex5-i) or mitochondria (Mex>SCNA) exclusively in the 

intestine, might affect brain health, and therefore behaviour. The males were the main focus 

for the remainder of the study. 

 

3.2 Pathologies of the Drosophila brain in aged Mex>Pex5-i and Mex>SNCA males  

After observing  locomotor deficits in the NGCA of aging male flies, to further 

investigate whether the locomotor decline in males was truly a neuronal-phenotype caused 

by neurodegeneration of the brain, three inflammatory pathways were investigated to 

detect inflammations in the brain of the genotypes of interest. The first pathway considered 

was the activation of the immunodeficiency (IMD) pathway, using the expression of the 

AMP Attacin (Att) as a read-out for activation (Badinloo et al., 2018; Hoffmann, 2003); 

Myllymäki et al., 2014). The next pathway probed was the JAK/STAT pathway, using the 

expression of its transcriptional target inflammatory cytokine (IC) Upd3 as a read-out, 

orthologous to Interleukin-6 (IL-6) in mammals (Oldefest et al., 2018; Sciambra & 

Chtarbanova, 2021). Moreover, the last pathways checked was the activation of Toll, using 

AMP drosomycin as a read-out for activation (Badinloo et al., 2018; Hoffmann, 2003). 
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3.2.1 Mex>Pex5-i male brains express more Attacin than controls 

Using Quantitative Polymerase Chain Reaction (qPCR), the expression of Att  

(Myllymäki et al., 2014), in the heads of Mex>Pex5-i and Mex>w1118 was assessed. Flies 

were tested at age 20do and 30do, at both 29°C and 25°C. 

At 29°C, there was no significant difference in Att expression between 20do 

Mex>Pex5-i and Mex>w1118  females; t(10)=0.6391, p=0.5371 (Figure 26.1A). However, 

the 20do Mex>Pex5-i males (M=9.515*10-5, SD= 3.401*10-5) had higher Att expression 

compared to the Mex>w1118  male controls (M=1.784*10-5, SD= 8.394*10-6 ); t(6)=4.415, 

**p=0.0045 (Figure 26.1A). At 25°C, there was no significant difference between 20do 

Mex>Pex5-i and Mex>w1118  within both males and females; males t(4)=1.220, p=0.2983, 

females t(4)=1.914, p=0.1281 (Figure 26.1B). However, Mex>Pex5-i males express more 

Att than the control males, while the Mex>Pex5-i females have less expression of Att 

compared to the control females.   

At 25°C on CM conditions, there was no significant difference between 30do 

Mex>Pex5-i and Mex>w1118  within each sex; males t(4)=1.065, p=0.3650, females 

t(4)=0.5798, p=0.5931 (Figure 26.2). Mex>Pex5-i males express more Att than control 

males, however one replicate of the male Mex> w1118  samples at 25°C and 30do was 

undetectable during the qPCR reaction, and the statistical test reported above is merely for 

reference and does not have enough statistical power to be conclusive. 
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Figure 26.1. The relative quantification of Attacin in 20do Drosophila heads. The 

relative quantification of Att:Rpl23 internal control in the heads of Mex>Pex5-i compared 

to Mex>w1118 age matched males and females aged to 20do. Each point on the graph 

represents one replicate of 14 fly heads. All statistical analysis was carried out using two-

tailed, unpaired Student’s t-tests, assuming equal variance and an α=0.05. A) CM male 

Mex>Pex5-i compared to male Mex>w1118 controls n=56 reared at 29°C. CM female 

Mex>Pex5-i compared to male Mex>w1118 controls n=84 reared at 29°C. B) CM male 

Mex>Pex5-i compared to male Mex>w1118 controls n=42 reared at 25°C. CM female 

Mex>Pex5-i compared to male Mex>w1118 controls n=42 reared at 25°C. 
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Figure 26.2. The relative quantification of Attacin in 30do Drosophila heads. The 

relative quantification of Att:Rpl23 internal control in the heads of Mex>Pex5-i compared 

to Mex>w1118 age matched males and females raised at 25°C and aged to 30do. Each 

point on the graph represents one replicate of 14 fly heads. All statistical analysis was 

carried out using two-tailed, unpaired Student’s t-tests, assuming equal variance and an 

α=0.05. A) CM male Mex>Pex5-i compared to male Mex>w1118 controls n=28-42. CM 

female Mex>Pex5-i compared to male Mex>w1118 controls. 

 

Other inflammatory markers in the brain include unpaired-3 (Upd3) expression, an 

Inflammatory Cytokine (IC) which upregulates in the brain during aging in Drosophila (K. 

Huang et al., 2020; Rajan & Perrimon, 2012), and drosomycin, a downstream product of 

Toll-pathway activation, were tested. With six replicates for each genotype and sex, neither 

male nor female heads of Mex>Pex5-i nor Mex>w1118 showed any significant differences 

in Upd3 expression between Mex>Pex5-i and Mex> w1118 (t(10)=0.7479, p=0.4717), nor 

the females (t(10)=0.7714, p=0.4583) (Figure 27), when the animals were aged to 20do 

and reared at 29°C 

At 25°C on normal CM conditions, there was no significant difference in 

drosomycin expression between 30do Mex>Pex5-i and Mex>w1118  within both males and 

females; males t(3)=1.191, p=0.3192, females t(4)=0.9705, p=0.3867 (Figure 28). The 
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female Mex> w1118 show high variability in drosomycin:Rpl23 ratio of relative expression, 

therefore the data is inconclusive and the more biological replicates are required per 

genotype to repeat the experiment (Figure 28). Similarly, one replicate of control Mex> 

w1118  male heads from animals aged to 30do reared at 25°C was undetectable during the 

qPCR reaction, and the statistical test reported above is merely for reference and does not 

have enough statistical power to be conclusive or non conclusive, therefore no conclusion 

can be made for the males.  

 

 

 

 

 

 

 

 

 

Figure 27. The relative quantification of unpaired-3 (Upd3) in 20do Drosophila heads. 

The relative quantification of Upd3:Rpl23 internal control in the heads of Mex>Pex5-i 

compared to Mex>w1118 age matched males and females raised at 29°C and aged to 20do. 

Each point on the graph represents one replicate of 14 fly heads. All statistical analyses 

were carried out using two-tailed, unpaired Studen’ts t-tests. A) CM male Mex>Pex5-i 

compared to male Mex>w1118 controls, n=84. B) CM female Mex>Pex5-i compared to 

male Mex>w1118 controls, n=84. 
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Figure 28: The relative quantification of drosomycin in 30do Drosophila heads. The 

relative quantification of drosmycin:RPL23 internal control in the heads of Mex>Pex5-i 

compared to Mex>w1118 age matched males and females raised at 25°C and aged to 30do. 

Each point on the graph represents one replicate of 14 fly heads. All statistical analysis was 

carried out using two-tailed, unpaired Student’s t-tests, assuming equal variance and an 

α=0.05. A) CM male Mex>Pex5-i compared to male Mex>w1118 controls n=24-42. B) CM 

female Mex>Pex5-i compared to male Mex>w1118 controls, n=42. 

 

In conclusion (Figure 29), there are no differences between Mex>Pex5-i and 

Mex>w1118 females in the expression of any of the AMPs/cytokines tested. There is a 

significant expression of Att in the heads of 20do males reared at 29°C (approximately 

30do if reared at 25°C). This is also observed for males aged to 20do at 25°C, however the 

difference is not statistically significant. There is potential for elevated Att and drosomycin 

expression in 30do male flies aged at 25°C, however more replicates are needed to confirm 

this anecdotal observation. Therefore, the only conclusive evidence of accumulating 

inflammatory markers in the brain was obtained  from the analyses of 20do male flies 

raised at 29°C. 
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Summary of Att, Upd3, and drosomycin expression in Mex>Pex5-i heads 

 

 

 

 

 

 

 

 

 

 

 

Figure 29: Summary of the results of neuroinflammatory markers Att, Upd3 and 

drosomycin. Male flies are on the left of each fly pair, and females on the right. Mex>Pex5-

i males express the inflammation marker Att and present decline in locomotor climbing 

activity on CM conditions at 20do and 30do. Furthermore, 30do males reared at 25°C are 

inconclusive due to insufficient replicates for statistical power, and neither Att, Upd3, nor 

drosomycin were expressed differently in the heads of Mex>Pex5-i females in comparison 

to Mex>w1118 females.  

 

3.2.2  Mex>Pex5-i and Mex>SNCA male brains accumulate ROS 

Quantifying AMPs/ICs in the heads of the flies proved to be challenging, therefore 

other methods of looking for inflammation in the brains of PEX5 gut-KD males were 

deployed, such as superoxide probe dihydroethidium (DHE) (Di Cara et al., 2018). When 

the brains of CM Mex>Pex5-i and control Mex>w1118  males at 30do at 25°C were stained 

with DHE, Mex>Pex5-i males exhibited a higher fluorescent intensity in the brain tissue 

than the controls; observed in patches of bright red fluorescence (Figure 30A). This 

indicated that there was an accumulation of Reactive Oxygen Species (ROS) in the brains 
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of male Drosophila with dysfunctional peroxisomes in the midgut. This ROS accumulation 

was also observed in the brains of male Mex>SNCA compared to age-matched controls 

Mex>GFP (Figure 30B).  
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Figure 30: Mex>Pex5-i and Mex>SNCA males display reactive oxygen species 

accumulation (via dihydroethidium detection) of in the brains. A) 30do CM 

Mex>Pex5-i males (Right-most panels) show accumulation of ROS in the brain (Red 

fluorescence) compared to control Mex>w1118 males (Left-most panels). Scale bars read 

200 μm at 5x magnification, and 100 μm at 20x magnification, imaged on a Zeiss AXIO 

Observer fluorescent microscope. B) 30do CM Mex>SNCA males (Right-most panels) 

show accumulation of DHE staining in the brain (Red fluorescence) compared to control 

Mex>GFP males (Left-most panels). Scale bars read 200 μm at 10x magnification, and 50 

μm at 40x magnification, imaged on a Zeiss LSM 880 confocal microscope.  

 

To validate what was observed with DHE, hydrogen peroxides  (H2O2) was 

quantified in the brains of  30do Mex>Pex5-i male aged at 25°C.  Mex>Pex5-i male brains 

have 350 pmol more H2O2 (M=402.7 pmol, SD= 50.66) than control Mex>w1118 (M=50.67 

pmol, SD= 2.081); t(8)> 6.440, ****p<0.0001 (Figure 31). This phenotype, accumulation 

of H2O2 , was rescued by treating the flies with niacin. In Mex>Pex5-i male heads treated 

with niacin, the amount of H2O2 was  significantly and dramatically reduced (M=19.00 

pmol, SD= 5.292)  in comparison to the untreated males (M=402.7 pmol, SD= 50.66); 

t(8)>6.440, ****p<0.0001 (Figure 31). The levels of H2O2 in the niacin treated Mex>w1118 

appeared to be also slightly reduce compared to the untreated males, however there was no 

significance between both averages; t(8)>6.440, p=0.7436 (Figure 31).  
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Figure 31. H2O2 accumulation in Pex5-i male brains is dramatically rescued with 

niacin. Age matched Pex5-i males on CM conditions revealed dramatic accumulation of 

ROS H2O2 in comparison to Mex>w1118 CM control males (****p<0.0001). When treated 

with niacin, H2O2 is significantly reduced to almost nothing  (****p<0.0001). Statistical 

tests were carried out using a two-way ANOVA, n=60. 

 

 

3.2.3  Mex>Pex5-i male brains display mitochondrial abnormalities  

As mentioned in the introduction, oxidative stress can trigger mitochondrial 

damage. Therefore, using Transmission Electron Microscopy (TEM) to visualize 

ultrastructure’s of the neurons, I observed a higher frequency of damaged mitochondria 

with abnormal cristae and/or mitophagy in the CM Mex>Pex5-i male brains versus control 

CM Mex>w1118. Particularly, these observations were made in the anterior dorsal area of 

the brains, in proximity to the central complex and mushroom body important in 

locomotion and memory (Givon et al., 2017; Stark et al., 2020). In (Figure 32A) in the 

bottom left panel, there appears to be an autophagosome in the later stages of mitophagy 

(M), as well as one in the early stages of mitophagy formation at the very bottom of the 

panel (M). When magnified to 100x, the shape of the autophagosome becomes clear, 

appearing like a hollow horse-shoe structure in the bottom right panel (Figure 32A). In 
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Figure 32B, the cristae abnormalities observed in Mex>Pex5-i male brains are evident 

(AC). The mitochondria appear less organized, loose and with larger gaps between cristae 

in comparison to the organized and tightly packed cristae of control Mex>w1118  males 

(Figure 32B). Moreover, there was a higher frequency of abnormal/mitochondria in 

mitophagy compared to healthy mitochondria in the brain (Table 3). Therefore, the KD of 

PEX5 in the intestinal epithelial cells of Drosophila male reared on CM diet affects 

mitochondrial morphology and trigger mitophagy in the brain.   

Mex>Pex5-i female brains did not present a higher frequency of mitochondria with 

abnormal cristae or mitophagy than controls in longitudinal brain sections, in comparison 

to the respective controls (Table 4). However, in transverse brain sections, Mex>Pex5-i 

females have more mitophagy and mitochondria with abnormal cristae. Therefore, the data 

is inconclusive for the females and requires more biological replicates to understand the  

phenotype that is more representative of the female population.  
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Figure 32: Transmission electron microscopy reveals mitochondrial abnormalities in 

the brains Mex>Pex5-i males. A) TEM of 30do CM Mex>Pex5-i and age-matched 

control Mex>w1118 male Drosophila brains where the brain section has been cut in a 

longitudinal manner. N: Normal mitochondria, M: Mitophagy, AC: Abnormal cristae 

(loose and disorganized). Scale bar 200 nm at x50k magnification (yellow scale bar) and 

100 nm at x100k magnification (blue scale bar). B) TEM of Mex>Pex5-i and control 

Mex>w1118 male Drosophila brains. N: Normal mitochondria, M: Mitophagy, AC: 

Abnormal cristae (loose and disorganized). Looking at a transverse section of the fly brain. 

Scale bar 400 nm at a x50k magnification (yellow scale bar).  
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Table 3. Mex>Pex5-i male brain have more mitochondrial abnormalities than a 

control on CM conditions. The brains of both Mex>Pex5-i males and controls, age 

matched at 30do, were sliced in a transverse (the dorsal side of the brain), and longitudinal 

manner (the anterior side of the brain).When comparing the mitochondrial counts of 

transverse or longitudinal brains, with two pooled replicates (Br1, brain 1, and Br2, brain 

2) from each genotype, there is a lower frequency of normal/healthy mitochondria, and a 

higher frequency of mitochondria in mitophagy and/or with abnormal cristae in the 

Mex>Pex5-i males (In dark purple) compared to controls (in light green).  

 

Genotype 

(Males) 

Normal 

(N) 

% Mitophagy 

(M) 

% Abnormal 

cristae 

(AC) 

% Total: 

Mex>Pex5-i 

Trans Br1 32 

 

50.79 3 

 

4.762 28 

 

44.44 

 

63 

Mex>Pex5-i 

Trans Br2 15 

 

37.50 16 

 

40.00 9 

 

22.50 

 

40 

Total 47 45.63 19 18.45 37 35.92 103 

Mex>Pex5-i 

Long Br1 32 

 

60.38 18 

 

33.96 3 

 

5.660 

 

53 

Mex>Pex5-i 

Long Br2 22 

 

44.00 12 

 

24.00 16 

 

32.00 

 

50 

Total 54 52.42 30 29.12 19 18.45 103 

Mex>w1118 

Trans Br1 21 

 

55.26 4 

 

10.52 13 

 

34.21 

 

38 

Mex>w1118 

Trans Br2 59 

 

86.76 4 

 

5.882 5 

 

7.353 

 

68 

Total 80 75.47 8 7.547 18 16.98 106 

Mex>w1118 

Long Br1 32 

 

55.17 9 

 

15.52 17 

 

29.31 

 

58 

Mex>w1118 

Long Br2 37 

 

80.43 2 

 

4.348 7 

 

15.22 

 

46 

Total 69 66.35 11 10.58 24 23.08 104 

 

 



118 
 

 

 

Figure 33. Transmission electron microscopy reveals little to no mitochondrial 

abnormalities in the brains of CM Mex>Pex5-i females. TEM of CM Mex>Pex5-i and 

age-matched control Mex>w1118 female Drosophila brains where the brain section was cut 

in a longitudinal manner. N: Normal mitochondria, M: Mitophagy, AC: Abnormal cristae 

(loose and disorganized). Scale bar 500 nm at x30k magnification (yellow scale bar) and 

200 nm at x60k magnification (yellow scale bar as well). 
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Table 4: Mex>Pex5-i female brains have little to no mitochondrial abnormalities and 

are comparable to the control Mex>w1118. The brains of both Mex>Pex5-i females and 

controls, age matched at 30do, were sliced in a transverse (the dorsal side of the brain) and 

longitudinal manner (the anterior side of the brain).When comparing the mitochondrial 

counts of longitudinal brains, with one replicate (Br1) from each genotype, there is no 

difference in frequency of normal/healthy mitochondria, or mitochondria in mitophagy 

and/or with abnormal cristae compared to controls. However in transverse brain sections, 

Mex>Pex5-i females appeared to have more mitophagy and mitochondria with abnormal 

cristae.   

 

Genotype 

(Females) 

Norma

l (N) 
% 

Mitophagy 

(M) 
% 

Abnormal 

cristae (AC) 
% Tot 

Mex>Pex5-i 

Trans Br1 
34 

66.70 

  
4 

7.843 

  
13 25.49 51 

Mex>Pex5-i 

Long Br1 
22 

81.48 

  
2 

7.407 

  
3 

11.11 

  
27 

Mex>w1118 

Trans Br1 
33 

100.0 

  
0 

0.000 

  
0 

0.000 

  
33 

Mex>w1118 

Long Br1 
26 86.67 2 6.670 2 6.670 30 

 

To confirm that the mitochondria in the brain of Mex>Pex5-i males were indeed 

stressed and dying, as identified by TEM imaging, MitoSOX™ was used to stain for 

superoxide accumulation in mitochondria. Mex>Pex5-i male brains displayed more red 

fluorescence in the tissue at 10x magnification compared to the male Mex>w1118 control 

brains (Figure 34A). This observation was better recapitulated at a higher magnification of 

40x, where the cell bodies for both genotypes are visible, but only the Mex>Pex5-i cell 

bodies fluoresce due to superoxide accumulation in mitochondria (Figure 34A). Similar 

results were observed in Mex>SNCA male brains using MitoSOX™ (Figure 34B). 
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Figure 34. MitoSOX® reveals that Mex>Pex5-i and Mex>SNCA male brains have 

more superoxide accumulation inside of mitochondria than controls Mex>w1118 and 

Mex>GFP. A) Staining with superoxide marker for mitochondria MitoSOX™ of 30do CM 

Mex>Pex5-i males (Right-most panels) shows accumulation of these ROS in mitochondria 

by lighting up entire neuron bodies in the brain (Red fluorescence) compared to control 

Mex>w1118 (Left-most panels) with little to no fluorescent neurons. Scale bars read 200μm 

at 19x magnification, and 50 μm at 40x magnification, imaged on a Zeiss LSM 880 

confocal microscope. B) 30do CM Mex>SNCA males (Right-most panel) showing 

accumulation of ROS in the mitochondria of neurons (Red fluorescence of cell bodies) 

compared to control Mex>GFP (Left-most panels). Scale bars reading 200 μm at 10x 

magnification, and 50μm at 40x magnification, imaged on a Zeiss LSM 880 confocal 

microscope. 

 

 

3.2.4 Mex>Pex5-i males display wide-spread neuronal death in the brain  

After confirming that there is inflammation and redox stress in the brain of both 

CM Mex>Pex5-i and CM Mex>SNCA males, this indicates that neurons in the brain may 

be dying as a result. I began using annexin V (AV, marker for apoptosis), and Propidium 

Iodide (PI, marker for necrosis) to try and visualize cellular death in the brain. Despite 

countless attempts to optimize these protocols, efforts were unrequited (Supplementary 

Figure 1, and 2).  

The final approach to visualizing widespread cellular death in the brain was to use 

Terminal deoxynucleotidyl transferase biotin-dUTP Nick End Labeling (TUNEL) to stain 

for apoptosis, that proved to be effective and consistent. CM Mex>Pex5-i males reared at 

25 °C to the age of 30do, displayed more red fluorescent/dying cells across the entire brain 

than then age-matched male controls Mex>w1118 (Figure 35A). Additionally, these results 

were recapitulated in CM Mex>SNCA males and age-matched male Mex>GFP controls 

(Figure 35B). On the contrary to the males, and in agreement with the results from the CM 

climbing assays, age matched Mex>Pex5-i females and respective controls have no 

difference in red fluorescent intensity, indicating a lack of cellular death in both genotypes 
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(Figure 35C). However, there was an organized cluster of dying cells in the ventral regions 

of the brain, which at first was suspected to be an artifact, but was observed in multiple 

Mex>Pex5-i female brains; this phenotype prompts further investigation (Figure 35B). 

Conclusively, however, there is no sign of wide-spread cellular death for the PEX5 gut-

KD females versus controls (Figure 35C).   

 TUNEL Red death stain as an indicator of cellular apoptosis (Males) 
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     TUNEL Red death stain as an indicator of cellular apoptosis (Females)  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 35. TUNEL stain for apoptosis reveals brain-wide cellular death in both 

Mex>Pex5-i and Mex>SNCA males in comparison to Mex>w1118 and Mex>GFP 

controls. A) Staining with TUNEL marker for cellular apoptosis of 30do CM  Mex>Pex5-

i males (Right-most panels) shows death of neuron bodies in the brain (Red fluorescence) 

compared to control Mex>w1118 (Left-most panels) with little to no fluorescent neurons. 

Scale bars read 200 μm at 10x magnification, and 100 μm at 20x magnification, imaged on 

a Zeiss LSM 880 confocal microscope. B) 30do CM Mex>SNCA males (bottom panel) 

showing neuronal death (Red fluorescence of cell bodies) compared to control Mex>GFP 

(upper panel). Scale bars read 50 μm at 40x magnification, imaged on a Zeiss LSM 880 

confocal microscope. C) 30do CM Mex>Pex5-i females do not show brain-wise neuronal 

cell death, and are comparable control Mex>w1118 females. Scale bars read 200 μm at 10x 

magnification, and 100 μm at 20x magnification, imaged on a Zeiss LSM 880 confocal 

microscope. 
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An additional observation while staining with tunnel was a smaller brain size in the 

male PEX5 gut-KD flies compared to respective controls. A loss of brain mass is 

characteristic to NDs in humans and other animal models (Raskin et al., 2015), therefore 

the wide-spread cellular death seen in the Mex>Pex5-i brains at an older age may result in 

the brain shrinking over time. Two dimensions of brain size were measured, from one 

eyelobe to another (distal to distal), and from top of the brain to bottom (dorsal to ventral); 

confirming that the Mex>Pex5-i males reared at 25 °C and aged to 20do were indeed 

significantly smaller in size than the respective Mex>w1118 controls. Distal to distal, 

Mex>Pex5-i (M=647.4 μm, SD=46.91) versus Mex>w1118 (M=715.4 μm, SD=53.19); 

t(16)=2.878, *p=0.0109 (Figure 36A). Dorsal to ventral, Mex>Pex5-i (M=313.2 μm, 

SD=31.37) versus Mex>w1118 (M= 378.5 μm, SD=39.76); t(16)=3.864, **p=0.0014 

(Figure 36A). Likewise, these results were recapitulated in Mex>SNCA males compared 

to control Mex>GFP males. Distal to distal,  Mex>SNCA (M=325.9 μm, SD=40.66) versus 

control Mex>GFP (M=435.2 μm, SD=50.19); t(26)=6.334, ****p<0.0001 (Figure 36B). 

Dorsal to ventral, Mex>SNCA (M=158.6 μm, SD=22.31) versus control Mex>GFP 

(M=213.1 μm, SD=26.23); t(26)=5.919, ****p<0.0001 (Figure 36B).  
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Figure 36. The brain size of CM Mex>Pex5-i males is significantly smaller than 

control males. Two different measurements of brain size (in μm) were considered, 

measuring from dorsal to ventral (top of brain to bottom) and from distal to distal (eye-

lobe to eye-lobe). Statistical analyses was carried out using two-tailed, unpaired Student’s 

t-tests, assuming equal variance and an α=0.05, with an n= 9 brains. A) Mex>Pex5-i males 

has a significantly smaller brain than Mex>w1118 control males. Measuring distal to distal 

(*p=0.0109) and dorsal to ventral (**p=0.0014). B) Mex>SNCA males had a significantly 

smaller brain size than control Mex>GFP males. Measuring distal to distal (****p<0.0001) 

and dorsal to ventral (****p<0.0001). 
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3.2.5 Mex>Pex5-i display PAM and PPL1 dopaminergic neuron 

death/dysfunction 

After identifying widespread cellular death in the brains of the male Mex>Pex5-i 

in comparison to age matched Mex>w1118 males, further investigation of effected neurons 

specifically looked at Dopaminergic (DA) Protocerebral Anterior Medial (PAM) and 

Protocerebral posterior lateral 1 (PPL1) neuron clusters, which are part of the locomotor 

circuits, in the  Drosophila brain. Using Tyrosine Hydroxylase (TH) to visualize and count 

PAM and PPL1 clusters,  PAM but not PPL1 neurons were significantly less abundant in 

CM Mex>Pex5-i male brains (M=111.9, SD=24.49) than the respective control CM 

Mex>w1118 (M=134.6, SD=16.05); t(14)=2.210, *p=0.0443 (Figure 37A). There was no 

difference between Mex>Pex5-i and  Mex>w1118  PPL1 neuron count (t(10)=2.019, 

p=0.0711 (Figure 37A), nor between Mex>SNCA and Mex>GFP male PAM 

(t(16)=0.7569, p=0.4601) or PPL1 (t(14)=0.2119, p=0.8352) (Figure 37B). However, there 

was a significant decline of TH fluorescent intensity in PPL neurons of Mex>Pex5-i males 

(M= 0.0058, SD=0.0039) compared to Mex>w1118 males (M=0.0151, SD=0.0051); 

t(6)=2.882, *p=0.0280 (Figure 38A). There was also a significant decreased fluorescent 

intensity of PAM neurons of Mex>Pex5-i males (M=0.0586, SD=0.0084) compared to 

Mex>w1118 males (M=0.1201, SD=0.0302); t(4)=3.396, *p=0.0274 (Figure 38B). 
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Figure 37. PAM DA neuron in the brains of 30do Mex>Pex5-i males are less abundant 

than in control Mex>w1118. All brains were stained with TH to visualize and count of DA 

neurons (y-axis). A) The DA neuron counts of clusters PAM (n=9) and PPL1 (n=6) in 

Mex>Pex5-i male brains compared to control Mex>w1118, were less abundant in the 

Mex>Pex5-i males. PAM neuron count was significantly less in mutants than controls 

(*p=0.0443), but PPL1 count in Mex>Pex5-i males compared to controls, although less 

abundant too, was not statistically significant. B) The DA neuron counts of clusters PAM 

(n=9) and PPL1 (n=8) in Mex>SCNA males were comparable to control Mex>GFP. All 

statistical analyses were carried out using a two-tailed, unpaired Student’s t-test, α=0.05, 

assuming equal variance and an α=0.05.  
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Figure 38. PAM and PPL1 DA neuron fluorescence in the brains of 30do  Mex>Pex5-

i males is reduced compared to Mex>w1118 controls. Primary antibody used was anti-TH 

and secondary antibody Alexa Fluorophore 488 (Green). All images were imaged on a 

Zeiss LSM 880 confocal microscope at a magnification of 20x with a scale bar of 100 μm, 

except PPL1 Mex>w1118 imaged at 10x with a scale bar of 200 μm. A) The fluorescent 

intensity of Mex>Pex5-i PPL1 neurons is reduced in visual comparison to controls, 

outlined by the red-dotted circles. Corrected total cell fluorescence of Mex>Pex5-i PPL1 

neurons is significantly reduced in quantitative comparison to controls (*p=0.0280), n=4 

brains. B) The fluorescent intensity of Mex>Pex5-i PAM neurons is reduced in comparison 

to controls, outlined by the red-dotted circles. Corrected total cell fluorescence of 

Mex>Pex5-i PAM neurons is significantly reduced compared to controls (*p=0.0274), n=3 

brains..  

 

3.3  Summary of chapter 3  

To demonstrate that the climbing deficit observed in males was a neurophenotype, 

I quantified established markers of inflammation and neuronal survival in the brains of 

Mex>Pex5-i and respective control. Expression of AMPs/ICs in the heads were quantified 

using qPCR. A significantly higher AMP Att expression was detected in the heads of 20do 

Mex>Pex5-i males compared to the Mex>w1118 control, indicating a greater inflammatory 

status on these gut-KD brains. Other markers of inflammation such as oxidative stress were 

also measured (DHE  for ROS detection and H2O2 detection in the brains respectively), and 

showed to be highly accumulated in the brains of Mex>Pex5-i males relative to age-

matched controls. Together these experiments confirmed inflammation and redox stress in 

the brain of Mex>Pex5-i males. With redox stress comes mitochondrial damage, and 

indeed increased mitophagy and mitochondria with abnormal cristae were identified in 

Mex>Pex5-i male brains using TEM, compared to controls with almost no mitophagy, or 

abnormal mitochondrial cristae. TEM findings were further validated by looking at 

superoxide accumulation within neuronal mitochondria in the Mex>Pex5-i male brains 

using MitoSOX™ staining. Finally neuronal death in the brain was observed in a TUNEL 
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stain for apoptosis. An increase of inflammation, oxidative stress, and damage of the 

mitochondria corresponded to a reduction in brain size of the Mex>Pex5-i males in parallel 

to loss of PPL1 and PAM DA neuron signalling. Altogether allowing me to conclude that 

dysfunction of peroxisomes in intestinal epithelial cells causes remote inflammation in the 

brain over aging in males, and causes loss of brain matter and loss of DA neurons. These 

brain defects ultimately affect the locomotion activity of Mex>Pex5-i males. 
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CHAPTER 4: TRANSCRIPTOMIC SCREENING OF THE DROSOPHILA 

MEX>PEX5-i MIDGUT 

4.1  Mip expression is elevated in the male Mex>Pex5-i midgut on CM, and 

exacerbated on HFD and AX conditions 

Knocking down the essential peroxisomal protein PEX5 exclusively in the midgut 

of Drosophila melanogaster, effected locomotor behaviour in aging animals, distally 

causing accumulation of oxidative stress and wide spread cellular death in the brain. These 

phenotypes were exacerbated by feeding a high fat diet (HFD) and/or by antibiotic 

cocktail/axenic treatment (AX). These findings strongly support the idea that peroxisomes 

are modulators of the diet-microbiota-gut-brain (DMGB) axis communication network that 

influences the onset of neurodegenerative diseases (NDs). Therefore a transcriptomic 

screen was carried out to further dissect  the mechanism of action in health and disease.  

Each transcriptomic complimentary DNA (cDNA) library consisting of biological 

duplicates of Mex>Pex5-i and Mex>w1118 (males and females combined) in eight different 

conditions (cornmeal (CM), 5% sucrose, high and low dose Pseudomonas entomophila, 

antibiotic cocktail or axenic (AX), high fat diet (HFD), and AX or HFD with 

P.entomophila). Results of the RNAseq analyses revealed multiple differences in gene 

expression profiles between Mex>Pex5-i and Mex>w1118 guts. Gene enrichment analyses 

revealed that a group of gene strongly dysregulated in Mex>Pex5-i midguts compared to 

Mex>w1118 was represented by neuropeptides and neuropeptide receptors (NPs/NPRs). 

Considering the importance of neuropeptides in gut-brain communication, I further 

focused my study on these gene hits. 
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Figure 39. Differential gene expression of NPs/NPRs from the HFD transcriptomic 

screen enrichment analysis of Mex>Pex5-i and Mex>w1118 of the Drosophila midgut.  

 

The identified hits of NPs/NPRs (Figure 39), were then validated in the midguts of 

mixed male and female samples of Mex>Pex5-i and control Mex>w1118 aged to 7 days old 

(do) at 29 °C on a CM and HFD diet, (20 guts of 10 males and 10 females per replicate, a 

minimum of 3 biological replicates per genotype). The following gene hits were tested 

(using Quantitative Polymerase Chain Reaction, qPCR) according to the results obtained 

from the transcriptomic screen in HFD condition: Amn (FBgn0086782), AstA 

(FBgn0015591), AstA-R1 (FBgn0015591), Bursicon (FBgn0038901), CCAP 

(FBgn0039007), CCAP-R (FBgn0039396), CCHa2 (FBgn0038147), CCHa2-R 

(FBgn0033058), Dsk (FBgn0000500), FMRFa (FBgn0000715), Ms-R2 (FBgn0264002), 

NPF (FBgn0027109), PDF-R (FBgn0260753), sNPF (FBgn0032840) , Tk (FBgn0037976) 

https://flybase.org/ (Supplementary Figure 4).  

Fold Changes of genes in  Mex>Pex5-i compared to Mex>w1118 

Neuropeptides & 

Neuropeptide Receptors  

https://flybase.org/
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Gene expression was calculated as reported in Chapter 2 and statistical analyses of 

the results were carried out using a two-tailed multiple unpaired t-test, assuming equal 

variance with an α=0.05. Comparisons between genotypes were of primary interest 

(Supplementary Figure 4). The expression of the strongest validated hits, based on results 

from (Supplementary Figure 4) and the literature (most likely to act within the DMGB 

axis) included: Amn (Turrel et al., 2020), AstA (Hentze et al., 2015), Bursicon (Scopelliti 

et al., 2016), CCHa2 (Ren et al., 2015), Dsk (Hentze et al., 2015), and sNPF (S. Lee et al., 

2004). These hits were tested in older (30do) flies and in separate sexes reared at 25°C on 

CM, HFD and AX conditions (Supplementary Figure 5). The reason why the flies were 

aged to 30do was to test the Negative Geotaxis Climbing Ability (NGCA) of flies at the 

age where the largest difference between the control and the mutant was observed in the 

climbing assays. Moreover, since the climbing assays and the brain analyses suggested a 

stronger effect in Mex>Pex5-i males, potential gene hits were tested in separate sexes.  

Furthermore, another neuropeptide known as Myo-inhibitory peptide (Mip, 

FBgn0036713, Hung et al., 2020; Williamson et al., 2001) was chosen for further 

investigation in accordance with results collected by a former lab member, Julia 

Kalinowski of the Universität Bonn Germany. Therefore, the initial validation of Mip is 

not present in the supplementary figures. The function of Mip remains unknown, but it has 

been speculated in Drosophila to play roles in sleep circadian in the brain and gut-motility 

in the gut.  Moreover, Mip has been identified as an ortholog of the neuropeptide galanin 

in mammals that is upregulated in the brain of AD patients (Wraith et al., 2009), therefore 

it is a strong candidate for the DMGB axis.  
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Mip was found to be elevated in the midgut whenever there was a locomotor deficit 

in correspondence, this was observed on a CM diet when comparing expression levels of 

Mex>Pex5-i males (M=0.0061, SD=0.0019), to control Mex>w1118 male (M=0.00263, 

SD=0.0005); t=3.0849, *p=0.0368. In 30do Mex>Pex5-i males, on a HFD and AX diet, 

Mip was comparably elevated in both genotypes (Figure 40A, Figure 42). This data 

corresponds  to the observed decline of NGCA of the Mex>w1118 (Figure 14,16, 42A). 

Interestingly in the females, Mip appears to increase within the Mex>w1118  midgut between 

CM and HFD and AX conditions, while within the Mex>Pex5-i midgut, Mip remains the 

same (Figure 40B), which did not correlate at all with the NGCA of the CM females of 

Mex>Pex5-i (Figure 14, 16).   

 

 

 

 

 

 

 

 

 

 

 

 

 



135 
 

Male 

 

 

 

 

 

 

 

 

  Female  

 

 

 

 

 

 

 

Figure 40. Relative gene expression (quantification) of Mip in the midguts of 30do 

Drosophila males and females separaely, using qPCR to validate Mip of the HFD 

transcriptomic screen on CM, HFD and AX conditions. All statistical analyses were 

carried out using multiple, two-tailed, unpaired t-tests, assuming equal variance with an 

α=0.05. A) Relative expression of Mip:RPL23 in males, n=3, between Mex>Pex5-i and 

Mex>w1118 on CM (t(4)=3.085, *p=0.0368), HFD (t(4)=0.9978, p=0.3750), and AX diets 

(t(4)=1.287, p=0.2673). B) Relative expression of Mip:RPL23 in females, n=3, between 

Mex>Pex5-i and Mex>w1118 on CM (t(4)=0.6655, p=0.5421), HFD (t(4)=44.41, 

****p<0.0001), and AX diets (t(4)=2.808, *p=0.048). 
 

 

 

 

M
ip

 C
M

M
ip

 H
FD

M
ip

 A
X

0.0000

0.0100

0.0200

0.0300

0.0400

0.0500

Mip:RPL23

R
e

la
ti

v
e
 q

u
a

n
ti

fi
c

a
ti

o
n

Mex>w1118

Mex>Pex5-i

ns ✱✱✱✱ ✱

B

M
ip

 C
M

M
ip

 H
FD

M
ip

 A
X

0.0000

0.0050

0.0100

0.0150

0.0200

Mip:RPL23

R
e

la
ti

v
e
 q

u
a

n
ti

fi
c

a
ti

o
n

Mex>w1118

Mex>Pex5-i

ns ns

A

✱



136 
 

When Mip was tested in the midgut of the reference model, male Mex>SNCA 

(M=0.0096, SD= 0.0014) had significantly elevated Mip in the midgut compared to control 

Mex>GFP (M=0.00314, SD=0.0009); t(4)=6.785, **p=0.0025) (Figure 41).  

Mip 

 

 

 

 

 

 

 

 

Figure 41: Detection of neuropeptide gene expression in 30do Mex>SNCA and control  

Mex>GFP Drosophila from pooled midgut samples extracted from males and females on 

a CM diet. Statistical tests included an two-tailed unpaired t-test, assuming equal variance 

with  n= 3 replicates of 20 fly guts. Target of interest Mip was highly expressed in 

Mex>SNCA compared to control Mex>GFP (**p=0.0025). 

 

4.2 Mip elevation in the midgut of Mex>Pex5-i and Mex>SNCA males 

corresponds to observed pathologies of the brain and behaviour   

Mip expression patterns analyzed in flies on CM, HFD and AX correlates with 

NGCA of male Mex>Pex5-i compared to Mex>w1118 control, where Mip expression 

appears to trend inversely proportional to NGCA of the male flies. For example, at 30do 

(Figure 40) Mex>Pex5-i males on a CM diet expressed a higher expression of Mip 

compared to the controls, corresponding to a drop of NGCA in Mex>Pex5-i (~20%) but 

not controls (~60% climbing success rate) (Figure 42). Likewise, at 30do on a HFD, both 

the NGCA of Mex>Pex5-i and controls were comparable, as well as Mip expression, 
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between the two genotypes. Mip expression levels were much higher on HFD than CM, 

corresponding to the decline of NGCA in both genotypes (Figure 42A). Similarly, at 30do 

on an AX diet, Mip expression was similar between the two genotypes and slightly higher 

on the AX diet compared to CM, and perfectly correlated to NGCA between both 

genotypes (~30% climbing success rate) (Figure 42A). When Mip expression was tested in 

Mex>SNCA, using midgut RNA samples extracted from males and females, Mip was 

significantly highly expressed at 20do compared to controls, and corresponded to the 

decline of NGCA in Mex>SNCA males at 20do (Figure 42B). The reason why the female 

Mex>SNCA are not compared in (Figure 42B) is because the NGCA of both the males and 

females on a CM diet were comparable. Therefore, it is assumed that what ever mechanism 

of action that created a locomotor decline in the males, must be true for the females, until 

proven otherwise. In subsequent experimentation, separating males and females will be 

beneficial to rule out an additive effect on the qPCR data, caused by mixing males and 

females which may express Mip in different amounts.  
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Figure 42: Elevation of Myo-inhibitory peptide gene expression (Mip) corresponds to 

a decreased NGCA. All statistical analyses using two-tailed multiple unpaired t-tests, 

where based on an α=0.05 and assumed equal variance. A) Mex>Pex5-i male midguts at 

30do express elevated levels of Mip compared to controls Mex>w1118, corresponding to the 

deficit of NGCA seen at 30do in the climbing assays. B). Mex>SNCA midguts at 20do 

express elevated levels of Mip compared to controls Mex>GFP, corresponding to the 

deficit of NGCA seen at 20do in the climbing assays.  
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4.3  Overexpressing Mip in the midgut of control Drosophila improves male 

NGCA at an old age 

To test whether Mip is neurotoxic, neuroprotective, or a side product of 

pathological gut-brain communication, I overexpressed Mip using a UAS-Mip line crossed 

to the Mex-GAL4 midgut enterocyte driver, and tested NGCA at 10do, 20do and 30do of 

age on normal CM conditions; testing both males and females separately (Figure 43). Since 

Mex>Mip is an overexpression model in enterocytes, the respective age and sex matched 

control were Mex>GFP.  

At 10do, male Mex>Mip (M=75.73%, SD=12.41) NGCA significantly declined by 

~17%  in comparison to the respective control Mex>GFP (M=92.50%, SD=11.62); 

t(18)=3.121, **p=0.0059 (Figure 43). Between both genotypes there was no difference of 

NGCA at 20do t(10)=1.018, p=0.3346 however, at 30do there as an improvement of 

NGCA by Mex>Mip (M=57.64%, SD=16.54) in comparison to the respective controls 

(M=34.48, SD=10.14); t(14)=3.376, **p=0.0045 (Figure 43). At 30do Mip appears to have 

a neuroprotective effect than the neurotoxic effect seen at 10 days.  

 On the contrary, the female Mex>Mip NGCA was worse than their respective 

Mex>GFP controls at 10, 20, and 30do. At 10do, female NGCA Mex>Mip (M=62.65%, 

SD=10.10) significantly declined by ~15% in comparison to their respective control 

(M=77.59%, SD=13.20), t(18)=2.844, *p=0.0108 (Figure 43). At 20do NGCA of 

Mex>Mip (M=31.51%, SD=15.59) declined by ~21% compared to the control 

(M=52.81%, SD=12.57); t(14)=3.008, *p=0.0094 (Figure 43). Finally at 30do, female 

NGCA Mex>Mip (M= 12.52%, SD=15.32) significantly declined by ~15% in comparison 

to their respective control (M= 34.22%, SD=10.01), t(8)=2.652, *p=0.0210 (Figure 43). 
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Ultimately, males appeared to improve at 30do with Mip overexpression in the enterocytes 

of the midgut, while females appear to worsen.  

 

Mex>Mip negative geotaxis climbing assays  

 

 

 

 

 

 

 

 

Figure 43. Negative geotaxis climbing assays of Mex>Mip in male and female 

Drosophila on CM conditions. A) Male Mex>Pex5-i declined of NGCA at 10do 

(**p=0.0059) compared to the control, while the control at 30do declined of NGCA 

compared to Mex>Pex5-i (**p=0.0045). B) At all three time points, Mex>Pex5-i females 

declined of NGCA compared to controls, 10do (*p=0.0108), 20do (*p=0.0094), and 30do 

(*p=0.0210). 

 

 

4.4  Summary of chapter 4  

 Out of all of the gene hits revealed by our transcriptomic screen of Mex>Pex5-i and 

control Mex>w1118, NPs/NPRs emerged as potential peroxisome dependant regulators of 

the DMGB axis. This is because, gene expression of the identified hits were stronger when 

the transcriptomic was performed in stressful conditions such as on a HFD. Myo-inhibitory 

Peptide (Mip) was the neuropeptide that corresponded best with the male climbing assays, 

and was also upregulated in the same manner on CM conditions in Mex>SNCA males 

compared to Mex>GFP controls. When Mip was genetically overexpressed in the midgut 

of control flies, surprisingly the NGCA of the female flies was negatively effected by the 

overexpression at all time points, while there was no difference of NGCA displayed by the 
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male until an older age of 30do, where males appeared to climb better than the control. 

These results conclude that Mip in the midgut may be neuroprotective in the males but 

neurotoxic in the females with dysfunctional midgut peroxisomes. However, subsequent 

experiments are ongoing to better define the connection between Mip expression in the gut 

of aging Mex>Pex5-i and Mex>SNCA and the onset of neurodegenerative phenotypes in 

the brain. 
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CHAPTER 5: DISCUSSION 

5.1  The role of peroxisomes on the gut-brain communication as seen by changes 

in behaviour, brain pathology, and a transcriptomic screen  

Neurodegenerative diseases (NDs) are one of the leading causes of disability and 

death worldwide that have no cure. These diseases not only impact  individual lives, but 

also heavily affect the health care system, and economy (Aarli et al., 2006; Feigin et al., 

2019, 2020; Health, 2022).  

Research of NDs has expanded outside of the brain to consider interorgan 

communications as contributors of pathogenesis and potential aetiologies of NDs. The-

Diet-Microbiota-Gut-Brain (DMGB) axis in particular has sparked interest for studying 

NDs in this light because, the diet, gut-commensals and gut epithelial cells have been 

identified to interact as a triad; communicating to the brain in a neuroprotective manner 

(Baxter et al., 2019; Castelli et al., 2021; Custers et al., 2022; Joseph et al., 2017). When 

protective neurotrophic factors within or secreted by the gut are perturbed, this could affect 

communication to the brain and lead to the development of NDs. Although this concept 

has been developed, it has been difficult to identify exactly what is being perturbed in the 

gut that may drive pathology in the brain, due to the vast metabolic interactome of the triad 

and to the multiple environmental changes that might affect the triad (Ball et al., 2019; 

Kim et al., 2021; Kuraishi et al., 2013; Stephens et al., 2018).  

Peroxisomes are organelles, which are essential for mediating/modulating 

complex-lipid and redox metabolism in the intestine and controlling microbiota 

populations (Di Cara et al., 2018; Klouwer et al., 2015; Smith & Aitchison, 2009, 2013). 
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Based on this established roles that the peroxisome play in the gut cells, they emerged as 

major modulators of factors that impact the DMGB axis and, if disturbed, drive NDs. This 

is a novel and unexplored area of research and during my master degree, I aimed to unravel 

how peroxisome dysfunctional in gut enterocytes may disrupt neuroprotective 

communication within the DMGB axis in the context of sporadic NDs.  

By using Drosophila melanogaster as a highly amenable genetic model for 

studying human neurological diseases, I knocked-down (KD) peroxisome function in the 

enterocytes (EC) of the fly’s midgut, and then looked at how behaviour changes on 

different dietary conditions, and when the gut microbiota is eliminated by antibiotic 

treatments. Additionally, I tested two gut-reference models overexpressing canonical 

human-mutant-alleles of Alzheimer disease (AD) α-Synuclein (SNCA) and Parkinson 

disease (PD) β-Secretase (BACE), and assayed these genotypes and under the same dietary 

conditions. These reference models ultimately aimed to connect previously-studied 

disease-linked genes of NDs to peroxisome dysfunction in the gut, in light of previous 

literature implicating the pathogenesis of SNCA and BACE in the gut before the brain in 

both human and mouse alike (Braak et al., 2003; Brudek, 2019; Q. Chen et al., 2019; Yan 

et al., 2021). I observed that on normal dietary conditions (cornmeal, CM), the gut-KD 

alone affected male but not female climbing behaviour (negative geotaxis climbing ability, 

NGCA). Interestingly, in a study conducted by (Greeve et al., in 2004), male transgenic 

AD models of Drosophila appear to have more amyloid plaque formation in their brains 

than females. Therefore, males may be more inclined to developing NDs in Drosophila, 

similar to human males being more prone to developing PD. Additionally, considering 

sexual dimorphisms between male and female Drosophila, the behavioural phenotype I 
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observed may reflect differences between male and female metabolism, especially lipid 

metabolism in the fly midgut. Implicated from a study looking at the lipid-metabolic sexual 

dimorphisms of Drosophila, male flies appear to metabolize Fatty Acids (FAs) into Triacyl 

Glycerols (TAGs) more rapidly than females in the midgut (Heier & Kühnlein, 2018), 

according to the levels of TAGs found in the fly fat-body (adipose tissue equivalent) (De 

Groef et al., 2021). Peroxisomes are involved in  β-oxidation of VLCFAs; when 

peroxisomes are dysfunctional in the midgut, VLCFAs may accumulate as observed in 

Peroxisome Biogenesis Disorders (PBDs) (Klouwer et al., 2015; Sellin et al., 2018). 

Therefore, if male flies are not used to slower metabolism of FAs in the gut like the females, 

then accumulating VLCFAs from peroxisome dysfunction may be more lipotoxic and 

overwhelming for male animals; altering gut functions and disrupting the DMGB axis, thus 

effecting the brain and impacting climbing behaviour. The correlation between 

accumulation of FAs in the gut and the onset of neurophenotypes, is supported by the fact 

that there is a decrease in locomotion  observed over aging in control flies that are fed a 

High Fat Diet (HFD). 

Specifically the fats that we used to make the HFD were Erucic acid (broccoli oil) 

which is a monounsaturated VLCFA (22:1ω9) and can only be catabolized by 

peroxisomes, and coconut oil in high concentrations (made up of Long Chain Fatty Acids, 

LCFAs) found to reduce Drosophila life span and locomotion (Odubanjo et al., 2020). 

When a HFD was introduced, the male Mex>Pex5-i on a HFD and cornmeal (CM) 

exhibited comparable climbing activity but, HFD females displayed a severe drop of 

NGCA compared to the CM. This locomotor phenotype in the males suggests that a diet 

rich in VLCFAs and LCFAs acts in the same way on the DMGB axis as peroxisome 
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dysfunction in the gut. This hypothesis is also supported by comparing the male control 

HFD and CM, which show decline in NGCA in old age when gut-metabolism generally 

begins to wane (Roberts & Rosenberg 2013). This further suggests that with aging, 

peroxisome function is increasingly important to help prevent mitochondrial dysfunction, 

and development of NDs. 

The dramatic decline of female Mex>Pex5-i over aging on a HFD observed at 20 

and 30 days, recounts the lipid-metabolic differences identified between males and females 

on CM conditions, where at 10 days old (do) the females are able to resist the consequences 

of elevated lipid availability in the gut, but as the fly ages with a PEX5 gut-KD it cannot.  

However, unlike males, female controls were severely affected by the HFD from an early 

age of 10do but, to an even greater extent than the Mex>Pex5-i females. This may be due 

to Mex>Pex5-i females having both a slower FAs metabolism and potentially adapting to 

this metabolism being slowed down further by peroxisomes. Regardless, the females still 

need further investigation, and the HFD highlights how males and females differ in FAs 

metabolism in the gut.  

Many males also passed-away on the HFD compared to females therefore, males 

appear to be very sensitive to FAs, and clearance by peroxisomes is essential. Females 

metabolize general FAs slower and are therefore used to having more FAs in the midgut 

(Heier & Kühnlein, 2018). So a peroxisome KD will in-turn only effect the females if 

challenged with excess fat intake (as observed on HFD compared to CM). Ultimately 

suggesting that peroxisomes in the gut and a high fat diet may impact the DMGB axis in 

the same metabolic way leading to distal inflammatory signaling that trigger 

neurodegeneration in the brain. For example, both dysfunctional peroxisomes and high fat 
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diets are known to induce oxidative stress in the gut and trigger local inflammation which 

could linked to ND development in the brain from the gut (Di Cara et al., 2018,2019; 

Reginato et al., 2021; von Frieling et al., 2020). Typically the gut microbiota can help the 

gut in metabolizing FAs (Custers et al., 2022; Festi et al., 2014), however, a HFD that 

induces oxidative stress and inflammation in the gut can perturb these important 

populations, in-turn making the gut more vulnerable to dysplasia, and triggering a shift in 

DMGB communication which favours neurodegeneration.  

By eliminating the gut microbiota, the NGCA of both Mex>Pex5-i and Mex>w1118 

males and females declined steeply and acutely beginning at the ages of 10-20 days. The 

decline of Axenic (AX) Mex>w1118 males mimic  CM Mex>Pex5-i males, suggesting that 

peroxisomal dysfunction can affect  the survival of species in the gut microbiota that are 

positive contributors to the protective signaling of DMGB axis. Moreover, since 

Mex>Pex5-i males on AX versus CM conditions were comparable, this further suggests 

that the gut commensals are communicating to the brain via peroxisomes. In brief,  

peroxisomal activity is important to maintain signaling in the DMGB axis that directly 

impact the gut-brain axis, or that affect the brain via activities of the commensals (Gut-

Microbiota-Brain axis) acting upstream of the commensals as demonstrated by the fact that 

locomotor decline cannot be worsened by eliminating gut-commensals in Mex>Pex5-i. 

Indeed, the peroxisome has been found to modulate commensal populations in Drosophila 

(Di Cara et al., 2018). Particularly, the PEX5 gut-KD in the CM males impact the 

Lactobacilllus phyla by significantly reducing these species like the AX condition does. 

Lactobacilllus are very important for host behaviour as Lactobacillus. Brevis has an 

identified role in locomotor activity in Drosophila (Schretter et al., 2018) Specifically 
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coordinated behaviour, therefore without L.Brevis, according to (Schretter et al., 2018), fly 

walking speeds are decreased.  

However, female CM Mex>Pex5-i may have slightly different commensal 

composition, therefore they do not present the same severe phenotype observed in 

Mex>Pex5-i males. It is possible that they have species that compensates for lost/disturbed 

populations. The data collected-thus far does not provide the means to make such 

conclusions therefore, in light of publication, a meta-transcriptomic will be completed in 

subsequent experiments; allowing us to understand which populations are effected in 

addition to what metabolites and other factors these microbes may be secreting into the 

DMGB axis. 

Identifying neurotoxic/neuroprotective metabolites such as Short Chain Fatty 

Acids (SCFAs) in the DMGB axis is one way to begin studying a mechanism of action in 

neurodegenerative disease development because, both the gut and the gut-commensals 

secrete a variety of lipid and other metabolites that promote brain health.  Niacin (vitamin 

B3) is one metabolite which has been implicated in both human and Drosophila PD studies 

to improve locomotor behaviour, to maintain gut-epithelial homeostasis and to act as an 

anti-inflammatory agent in the gut (Jia et al., 2008; Qi et al., 2019; Wakade et al., 2021). 

In-fact, Mex>Pex5-i male guts have extensive dysbiosis which in-turn was correlated to a 

decline of NGCA, and redox stress in the brain. When the Mex>Pex5-i males were treated 

with niacin (vitamin B3), not only was there an improvement of NGCA, but also a very 

dramatic decrease of ROS in the brain. These findings suggest that functional peroxisomes 

may drive the production of important neuroprotective metabolites in the gut, by 

modulating commensal populations that secrete metabolites such as niacin to prevent 
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neurodegeneration over aging. Thus, a meta transcriptomic can help us to identify these 

neuroprotective populations that are effected by peroxisomes. Another method of 

investigating important peroxisome-linked metabolites and their mechanism of action in 

the DMGB axis and NDs, is to carry out metabolomic, peptidomic, and lipidomic screens 

in the midguts, and in Drosophila blood (hemolymph) since metabolites in the midgut can 

be secreted  to communicate with the brain, not just via the gut epithelium, but also in an 

endocrine way via the systemic circulation. These screens were completed in light of 

publication, but we are still waiting on results. However, hemolymph screens of the 

reference model Mex>SNCA have been completed and we identified that inflammatory 

ceramides are upregulated in the circulation of the fly, and since Mex>SNCA mimics the 

neurophenotypes observed in aging Mex>Pex5-i males, inflammatory ceramides may also 

be upregulated in the circulation of the Mex>Pex5-i males.  

Ceramides are known to be pro-inflammatory, and growing evidence suggests that 

elevation of ceramides in the circulation (metaflammation) of an organism may contribute 

to NDs like AD in mammalian models (Estes et al., 2021; Jana et al., 2009; Reginato et al., 

2021). Likewise, in the Drosophila, ceramide accumulation (due to upregulation of 

ceramide synthase in PEX19 mutant) has been found to impair overall host energy 

metabolism (over-nutrition/metaflammation) by increasing free fatty acids due to 

upregulation of  ceramide synthase Schlank, in addition to mitochondrial damage in the 

gut (Sellin et al., 2018). Additionally the severe overexpression of Schlank due to mutating 

PEX19 globally in the Drosophila reduced larval locomotion and caused 

neurodegeneration. Therefore, considering our findings of gut dysbiosis, 

neuroinflammation/redox stress/and neuronal death in both Mex>Pex5-i and Mex>SNCA 
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males in the gut, Mex>Pex5-i and Mex>SNCA potentially accumulate inflammatory 

ceramides leading to metaflammation that drive ND development. A recent study conduced 

by (Vos et al., 2021), where Schlank was knocked down in a fly PD model for pink1, 

rescues the flying defects observed in these PD model. Of note, accumulation of ceramides 

were found by our group also in inflammatory macrophages that have no functional 

peroxisomes in Drosophila (Nath et al., 2022). Moreover, our recent lipidomic analysis on 

the Mex>Pex5-i showed accumulation of various ceramide species in these guts compared 

to the relative control (data not shown in the thesis). 

Considering all of the pathological similarities observed between Mex>Pex5-i and 

Mex>SNCA males, we can simply infer that peroxisomes and known disease-linked genes 

of NDs may share the same mechanism of  pathogenesis from the gut; this makes it easier 

to study a mechanism of action and identify metabolites between the two genotypes to 

unravel the DMGB axis.  

The purpose of the reference models was to compare and connect the effects of 

peroxisome dysfunction to pathologies of NDs, that may be induced by established human-

mutant alleles of NDs in the gut, such as damage to the mitochondria in presence of  

oligomerizing α-Synuclein mutant proteins. This strategy, could help us to unravel a 

mechanism or driver of peroxisome-linked DMGB axis neurodegeneration. Since both 

BACE and SNCA pathological proteins have been identified in the gut to form prion-like 

fibrils and plaques similar to what is seen in an AD or PD brain, the likelihood that the 

onset of AD and PD starts in the intestinal tract is a possibility and this study aimed to help 

to explore this alternative and unexplored mechanism of disease for NDs. We used  

Mex>BACE as a model of AD when Mex>BACE males and females on a CM diet were 
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compared to Mex>Pex5-i males and females on a CM diet; both genotypes and sexes show 

comparable phenotypes in comparison to their respective controls. Mex>BACE males 

exhibit NGCA lower than control and  a high mortality rate in the tested population before 

even reaching 30do. On the other hand, the females did not show a decline of NGCA in 

respect to control Mex>GFP, despite a high mortality in the females at 30do as well. This 

suggests that peroxisome DMGB axis pathologies correlate with BACE DMGB axis 

pathologies, and share a similar neurodegenerative mechanism of action from the gut; 

another possibility to explore is whether β-amyloids may be a product of peroxisome 

dysfunction in the gut.  

 Both Mex>GFP male and female controls, similar to the Mex>w1118 controls, were 

effected negatively by the HFD and AX conditions; where both males and females dropped 

of NGCA. However, the complete opposite occurred in the Mex>BACE males on both 

HFD and AX conditions, where there was a dramatic amelioration of both NGCA at 10do 

and 20do, comparable to the respective male controls, and survival compared to 

Mex>BACE CM. Only at 30do do the HFD and AX Mex>BACE males begin to decline 

compared to the respective controls. Therefore, I hypothesize that when β-amyloids are 

abundant in the gut on regular conditions, there is some tertiary factor that males have and 

females may not have in abundance that is creating plaques and severe dysplasia in the gut 

of the males. This instability of the gut epithelium is further perturbing commensal 

populations, to not only eliminate populations that produce neuroprotective lipids 

(SCFA’s) or metabolites but to also promote growth of opportunistic populations that may 

produce neurotoxic lipids or metabolites. This would explain why eliminating the gut 

microbiota in Mex>BACE males rescues the locomotor phenotype to the same degree as 
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the respective AX control. With all of this to consider, if Mex>Pex5-i was promoting the 

β-amyloid pathology in the gut, then in theory on HFD or AX conditions, the PEX5 gut-

KD males should have behaved the same as the BACE overexpression males. In-fact, the 

females behaved like Mex>Pex5-i females on both CM and HD conditions, however on 

AX conditions the Mex>BACE females were comparable to their respective controls, 

suggesting that BACE may not be effecting the gut microbiota, but lipid metabolism in the 

gut in the females. In light of all these observation, Mex>BACE becomes too convoluted 

to consider as a reference model, and thus, I decided to focus on the Mex>SNCA as means 

of a positive control for both males and females.  

  Mex>SNCA males on CM conditions exhibited a NGCA decline similar to the 

Mex>Pex5-i males, but not females; the female Mex>SNCA were still used as a positive 

control. Moreover, the effects of dietary changes on Mex>SNCA males and females trended 

in the same way as observed in Mex>Pex5-i males and females. This leaves me with the 

hypothesis that  both genotypes could share the same neuropathological mechanism of 

action in the DMGB axis. For SNCA this mechanism of action is already heavily studied, 

which may help us to unravel how peroxisome dysfunction may contribute to NDs (PD). 

This neurodegenerative phenotype was also confirmed in the Mex>SNCA males with a 

second behavioural memory assay, where males on simple CM conditions presented with 

memory deficits in courtship learning. Although the memory phenotype could not be 

confirmed in the Mex>Pex5-i before the end of the project, there were various other ways 

I used to confirm the presence of problems in the brains of aging  Mex>Pex5-i males. I 

first tested different Anti-Microbial Peptides (AMPs)/ Inflammatory Cytokines (ICs) in the 

heads of the male and female Mex>Pex5-i and respective controls. What I found was that 
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male Mex>Pex5-i flies had more Attacin AMP expression in the brain than the respective 

male controls at 29°C 20do ≈ 30do, and 25°C 20do, but not in the females which is 

concurrent with the CM locomotor assays. It was very difficult to extract enough RNA 

from the male heads to test the AMPs, which is why there is a small population tested n=3 

biological replicates for each data set and hardly any significance, and why at 25°C 30do 

no comment can be made because only two of three replicates yielding data for the 

Mex>w1118 controls. Therefore, we used other means of assessing inflammation in the 

brain, such as looking at oxidative stress using Dihydroethidium (DHE), H2O2 

accumulation, structural abnormalities/cellular death, and increased superoxide 

accumulation in the mitochondria (using MitoSOX®) of the fly brains of the Mex>Pex5-i.  

After observing brain-wise tissue apoptosis in both Mex>Pex5-i and the reference 

model Mex>SNCA males, I began to look for death and abnormalities of  neurons 

connecting to the mushroom body involved in locomotion (Protocerebral anterior medial 

(PAM) and Protocerebral posterior lateral 1 neurons (PPL1) dopaminergic (DA) neurons 

stained with Tyrosine hydroxylase (TH)). What I found was that PAM and PPL1 neurons 

in the brain of the Mex>Pex5-i males are reduced in number, but also fluorescent intensity 

was reduced, suggesting DA neuron cell death and loss of function. These results were not 

replicated in the Mex>SNCA, however, considering many difficulties while staining for 

TH particularly with the Mex>SNCA males, these experiments will be repeated for further 

validation.  

Overall, the pathologies leading to neurodegeneration in the brain by knocking 

down PEX5 in the midgut were akin to those of overexpressing mutant human-ND-linked 

SNCA, further justifying that peroxisomes are important modulators of the DMGB axis and 
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could even be triggering α-Synuclein peptides to aggregate in the midgut likewise. To 

begin investigating the mechanism of action, I therefore carried out a transcriptomic 

screens of the Mex>Pex5-i and respective controls’ midguts, on different dietary 

conditions, to better understand which genes in the gut are being dysregulated by 

peroxisomes and causing a neurodegenerative phenotype in the fly. 

 

5.1.1  The dysregulation of Mip in Mex>Pex5-i male Drosophila midguts  

corresponds to neurodegenerative phenotypes as seen by the locomotor  

decline and brain pathology 

The most dysregulated genes were observed in the HFD libraries, therefore we 

chose dysregulated Neuropeptides (NPs) and their Receptors (NPRs) from the enrichment 

list of differentially expressed genes between the genotypes of interest in HFD condition. 

Unfortunately, the transcriptomic screens were completed in parallel with the locomotor 

assays and other experiments to confirm neuroinflammation, oxidative stress, and neuron 

death in the brains of Mex>Pex5-i males. Therefore, the validation of the screens were 

carried out in samples composed of mixed male and female midguts. The limitation to this 

was that if one NPs/NPRs was down or upregulated in one sex, that does not necessarily 

mean that it will be in the other sex, especially considering that we were more interested 

in the males. With a combination of quantitative PCR validation and information from the 

literature available for each  individual gene hit I selected for validation, I chose five genes 

to validate in males and female midguts separately on CM, HFD and AX conditions. One 

neuropeptide stood out above the rest, Myo-inhibitory peptide (Mip).  
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Mip is known throughout Drosophila literature mostly in the brain, effecting 

satiety, anorexic brain signalling that defines body weight (Min et al., 2016), and is a sleep 

circadian hormone for both sexes (Oh et al., 2014). In the gut however, not much is known 

about Mip other than its potential role in gut motility (Williamson et al., 2001), and that it 

is probably primarily secreted mostly by Enteroendocrine cells (EE) since it is a peptide 

hormone (Hung et al., 2020). Furthermore, Mips in Drosophila have been found to have 

conservation at the N-terminus to vertebrate neuropeptide galanin (Min et al., 2016), which 

has been found highly expressed in the frontal lobes of AD patients. Particularly, galanin 

has been observed to be neuroprotective; for example, eliminating experimental induced 

autoimmune encephalomyelitis in mouse models (Wraith et al., 2009). Thus, Mip may also 

be neuroprotective from the gut to the brain in Drosophila.  

Mip expression patterns at 30do in the males suggested an inversely proportional 

correlation to NGCA across all three conditions, where elevation of Mip meant a decline 

in climbing ability. Excitingly, the same results were found in 20do CM Mex>SNCA 

midguts (males and females mixed). Therefore, I hypothesized that Mip secreted into the 

gut, or from the gut into the systemic circulation may be neurotoxic. To confirm this, I 

overexpressed Mip in the midgut of flies, but to my surprise the NGCA of Mex>Mip males 

were slightly, but significantly, worse in climbing than the control at 10do. Interestingly, 

the NGCA of Mex>Mip males at 30do was better than that of the control.  Therefore, I 

hypothesized that perhaps Mip is neuroprotective, like galanin, since Mex>Mip males 

appear to do better as the controls begins to decline at 30do. This hypothesis makes sense, 

because the more inflammation/oxidative stress occurs in the gut due to perturbing the diet 

and commensals, the more the fly midgut will try (but fail in our case) to homeostatically 
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oppose these changes to limit local and collateral damage. If this is true for the males, then 

future experiments where I will knock down Mip in the midgut using RNAi, I may see a 

decline of NGCA in Mex>Mip-i males. Moreover, when Mip is upregulated in a 

Mex>Pex5-i fly, a rescue of the negative geotaxis climbing phenotype may occur; in 

perhaps both males and females Mip is KD in the midguts.  

If Mip’s mechanism of action in the males is similar to the females, then 

upregulating Mip in Mex>Pex5-i females may rescue the deficit in negative geotaxis 

climbing ability observed on HFD and AX conditions. On the other hand, Mip may not be 

neurotoxic nor neuroprotective, because when the female midguts of Mex>Pex5-i were 

tested for Mip on CM, HFD, and AX conditions, only the female Mex>w1118 controls 

appeared to have an elevation of this neuropeptide.  Therefore, either the females are 

inhibiting the expression of neuroprotective Mip, and that is why we see a decline of NGCA 

on HFD and AX diets, or Mip may just be a by-product after forming another metabolite 

which may be neurotoxic. The former hypothesis is the most likely because, when Mip 

expression was tested in the brains of male Pex5-i, Mip was elevated in comparison to the 

control (not presented in the thesis).  

 

5.2 Conclusion about Mip 

Conclusively, it is still unclear how Mip may work in a neuroprotective or 

neurotoxic manner within or secreted from the fly midgut. Evidence from this study has 

suggested that Mip does not function alone and is likely highly intertwined with other 

metabolites that may be sex specific. Moreover, if Mip does not travel to the brain to work 

on its canonical receptors, then this neuropeptide may work on other receptors which are 
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yet to be identified in the DMGB axis. To further understand Mip’s mechanism of action, 

the next step is to track Mip as a peptide. Therefore in light of publication and for 

subsequent experimentation, a GFP fused Mip fly construct was made, whereby expressing 

GFP-Mip under the Mex-Gal4 midgut driver will allow us to visualize how Mip may be 

either remaining in the gut to carry out its function from there, or entering systemic 

circulation to directly target the brain. Additionally, as previously mentioned, the 

peptidomic screens of the Mex>Pex5-i hemolymph can also tell us if Mip is being secreted 

into the circulation and communicate with the brain in an endocrine fashion. These screens 

will also help us to unravel other important peptides, along with metabolites from the 

metabolomic screens, that work alongside Mip, modulated by peroxisomes, to influence 

DMGB axis communication and NDs. 

 

5.3  Limitations of the study  

During the course of my thesis, I encountered several road-blocks which made it 

difficult to obtain enough data in an efficient manner, having to repeatedly optimize 

experiments to match the quality of previously published protocols. One of the main issues 

was the variability within the negative geotaxis climbing assays, where each genotype and 

sex, despite being assayed together with controls on the same day, still displayed 

concerning variability. One reason for  the high biological variability may have been 

because not all of the conditions in the room were controlled. The main controls were 

temperature, apparatus placement, and lighting. One thing I could not control would have 

been atmospheric pressure, where on rainier and muggier days I anecdotally observed, as 

also previously published, that both the mutant and control flies performed poorly in 
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climbing ability compared to a nicer and drier day (Adonyeva et al., 2021). I believe that 

it is better to see variability and build up statistical power with more replicates than to 

control the environment too much, and dampen ecological validity. Lab conditions that are 

too controlled may not yield data representative of a true population/ biological mechanism 

of action. The variability we see with the flies is simply due to the spectrum of how each 

individual organism tolerates the induced KD or overexpression of genes in their midguts. 

The fact in the matter is that, if there is truly an effect of a gut specific PEX5 KD, and 

SNCA and BACE overexpression on the brain, then a difference will be observed between 

mutants and controls regardless of subtle changes in environment.  

Another limitation was considered after countless attempts of trying to optimize 

TH and TUNEL stains for  visualizing DA neurons and neuronal death. I found that mutant 

brains (such as Mex>Pex5-i) stained much better than controls. Therefore, I predicted that 

the Blood Brain Barrier (BBB)-equivalent of the Drosophila may be more permeable in 

the Mex>Pex5-i brains than controls. Indicating that by perturbing gut metabolism via 

peroxisomes or mitochondria in the gut (via SNCA aggregates), these disturbances 

somehow are effecting the brains ability to protect itself from external stressors, such as 

inflammatory mediators, via the BBB. One way to check if the BBB equivalent of the 

Drosophila brain is weaker in the mutants, is by injecting dye into the heads of the flies 

and live-imaging the penetration of the dye into the brains parenchyma (Pinsonneault et 

al., 2011). Or, stain the brain with an antibody anti-Repo and TUNEL to observe death of 

the BBB, where Repo is an excellent antibody that targets glial cells, which the Drosophila 

BBB is primarily composed of. Moreover, what could have helped me to identify death in 

the brains better would have been a brain-only positive control, unlike the gut-only positive 



158 
 

control of SNCA overexpression. This brain-only control would express BACE under a 

tissue specific driver for whole-brain neuropil known as Elav-Gal4, Elav>BACE, 

published as causing atrophy of the Drosophila brain (Chakraborty et al., 2011). 

Additionally, to better visualize and understand DA neuron cellular death patterns, I could 

have used DOP2R-Gal4 driver (for dopaminergic neurons in the Drosophila brain), to 

drive the expression of tetanus toxin (UAS-TNT) and death of DA neurons as a positive 

control for the TH immunofluorescence (Min et al., 2016). Therefore, in light of future 

publication, as a reference model of death in the brain, I will consider using the 

aforementioned models to help identify and confirm future experiments looking for 

neuronal death in my Drosophila models.   

As for what is mediating this potential weakening of the BBB, it could be any of 

the neuropeptide hits identified during this study, such as Mip. Which is why we 

constructed a GFP-tagged Mip fly line, since there is no antibody for Mip, in order to 

overexpress Mip in the midgut and then track where it is going and acting. Moreover, the 

pending results of the other -omic screens, especially the peptidomic of the haemolymph, 

can tell us whether Mip may be entering the systemic circulation or not. Regardless, 

knowing the cellular origin of Mip, or any of our genetic, or future metabolic/lipid hits, is 

essential to begin unraveling a mechanism of action to identify the aetiologies which 

induce a target cell to produce or stop producing said hit. For example, the Mex-Gal4 driver 

is midgut enterocyte specific, and enteroendocrine cells (EE) are known to produce and 

secrete the hormones and other mediators of communication, potentially our neuropeptide 

hits more than ECs, in the midgut of the fly (Hung et al., 2020). Therefore, we would have 



159 
 

to shift our gaze to focus on EE cells. Or, how the EC influence juxtacrine signaling of EE, 

since there is no EE specific driver of the midgut.  

 

5.5  Conclusion and future directions  

In conclusion, my three main objectives satisfied my hypothesis, that peroxisomes 

are important modulators of the DMGB axis in the context of NDs.  

1. I found that simply knocking down peroxisome function in the midgut, 

mimicked the locomotor deficits (neurodegenerative disease-like symptom) of 

a control fly exposed to an overwhelming amount of dietary lipids (HFD), or 

total loss of gut commensal bacteria (AX). Recapitulating that peroxisomes 

play a major role in gut-lipid metabolism and gut microbiota maintenance, and 

that perturbing these interactions of the peroxisomes reaps detrimental 

consequences on neuronal survival and behaviour in and of the brain.   

2. Next, I found that these behavioural deficits were indeed neuronal, by 

identifying inflammation, redox and neuronal death of the Drosophila brain in 

correspondence to a decreased climbing ability.  

3. Finally, a transcriptomic screen has showed that NPs/NPRs, major 

communication mediators between the gut and the brain, are also dysregulated. 

Further confirming that peroxisome dysfunction in the gut hinders gut-brain 

communication.  

The Drosophila melanogaster has been an invaluable model for testing my 

hypothesis. However, I have barely scratched the surface as to how peroxisomes in the gut 
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modulate development  of NDs through the DMGB axis, and therefore for my future 

directions I will be focusing on unraveling the mechanism of action for Mip, and 

potentially other identified NPs/NPRs validated throughout my thesis. Including analysis 

of the completed metabolomic, peptidomic, and lipidomic screens, and a meta 

transcriptomic on the horizon, I will also manipulate the concentrations of identified hits 

from these screens (metabolites or commensals), like I did with niacin, to try and rescue 

the neurophenotypes observed in the Mex>Pex5-i males or induce neurodegenerative 

phenotypes in a wild type fly. Furthermore, since the female flies remain elusive, with 

meta-analysis between all -omic screens I aim to further understand how a mechanism of 

action for Mip identified in males might effect females.  

The next step after that would be to try and translate what was observed in the 

Drosophila to humans or other mammalian  animal models close to humans. All in hopes 

of unraveling a peroxisome-dependant mechanism of action of the DMGB axis that will 

help enlighten the future for better detection and treatment options and even manufacturing 

a cure to NDs.  
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APPENDIX 

Supplementary Table 1: Materials  

 Materials Identification # or 

recipe 

Manufacturer/strain 

Drosophila husbandry Polypropylene 

narrow 

AS507 ThermoFischer Scientific™ 

 Narrow vial tray 59-207BLU Genesee Scientific™ 

 CO2 NA Linde Canada 

 Anesthetizing 

Flypad 

59-114 Genesee Scientific™ 

Drosophila stocks Fly line Bloomington Drosophila 

Stock Center, Vienna, or 

Korean Drosophila 

Resource Center 

 

 Mex Gal4 BDSC:91367 P{w[+mC]=mex1-GAL4.2.1}9-

1, y[1] w[1118] 

 w1118 BDSC:5905 w[1118] 

 UAS Pex5 RNA-i VDRC:42332 w1118; P{GD14972}v42332 

 UAS GFP BDSC:5137 y[1] w[*]; P{w[+mC]=UAS-

mCD8::GFP.L}LL5, P{UAS-

mCD8::GFP.L}2 

 UAS SNCA BDSC:51375 w[1118]; P{w[+mC]=UAS-

SNCA.J}1/CyO 

 UAS BACE BDSC:29877 w[1118]; P{w[+mC]=UAS-

BACE1.L}2 

 UAS Mip KDRC:10027 w[1118](I); P(UAS-Mip) 

vie72a (II) 

 UAS CAS9 BDSC:54595 w[1118]; P{y[+t7.7] 

w[+mC]=UAS-Cas9.C}attP2 

 U6-sgRNA 

PEX3/Cyo ; UAS 

GFP/Tm6b 

NA y[1] v[1]; P{y[+t7.7] 

v[+t1.8]=Lab made fly-

line}attP40 

 Myo1Ats-

Gal4/Cyo;Tubulin

-Gal80ts,UAS 

GFP 

NA A kind gift from Dr. Edan 

Foley, University of Alberta 

 Elav Gal4 BDSC:458 P{w[+mW.hs]=GawB}elav[C1

55] 

Drosophila food Ampicillin D-(-) A1593 Sigma-Aldrich™ 

 Coconut oil C1758 Sigma-Aldrich™ 
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 Materials Identification # or 

recipe 

Manufacturer/strain 

 Erucic acid E3385 Sigma-Aldrich™ 

 Methyl benzoate JRD0440 Sigma-Aldrich™ 

 Metronidazole M3761 Sigma-Aldrich™ 

 Narrow 

DrosoFiller™ 

59-168 Genesee Scientific™ 

 Neomycin 

trisulfate salt 

hydrate 

N1876 Sigma-Aldrich™ 

 Nicotinic acid N4126 Sigma-Aldrich™ 

 Nutrifly® 66-116 Genesee Scientific™ 

 Phosphoric acid P5811 Sigma-Aldrich™ 

 Propionic acid 402907 Sigma-Aldrich™ 

 Tetracycline 08168 Sigma-Aldrich™ 

 Vancomycin 

hydrochloride 

1709007 Sigma-Aldrich™ 

Climbing Assays Desk Lamp 

(Bendable) 

  

 Foam Mat   

 iPhone XR 

camera 

A1984 Apple Inc. 

 Pyrex™ 250mL 

graduated 

cylinder 

3066 Corning® by Sigma-Aldrich™ 

Courtship Assays 9-well assay 

plates 

 Dr. Jamie Kramers Lab 

 Arena Camera  Dr. Jamie Kramers Lab 

 Arena Incubator  Dr. Jamie Kramers Lab 

 Housing plates Custom Dr. Jamie Kramers Lab 

 Timer  Apple iPhone 

 Wide mouth 

Drosophila stock 

vials 

Kindly gifted by Dr. Jamie Kramers Lab 

Brain Pathology 

/Transcriptomic screens 

0.05% PBST 

 

1x PBS + 0.05% Triton-X  

 0.3% PBST 1x PBS + 0.3% Triton-X  

 0.2%,0.3%,0.5% 

PBSTw 

1x PBS + (-%) Tween-20  
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 Materials Identification # or 

recipe 

Manufacturer/strain 

 1.5 mL 

microcentrifuge 

tube 

022363204 Eppendorf™ 

 1x PBS 

(Phosphate buffer 

saline) (1L) 

Sodium Chloride (8g, 

0.137M), Potassium 

chloride (0.2g, 0.0027M), 

Sodium Phosphate 

Dibasic (1.44g, 0.01M), 

Potassium Phosphate 

Monobasic (0.245g, 

0.0018M) 

1L distilled water, 

PH~7.4 

 

 2.5% 

glutaraldehyde 

fixative diluted in 

0.1M sodium 

cacodylate buffer 

Kindly prepared by Mary Anne Trevors, EM 

Facility 

 4% Formaldehyde 

 

J19943.K2 

(16% diluted 1:4 in 1x 

PBS) 

ThermoFischer Scientific™ 

 Alexa Fluor™ 

488 & Propidium 

Iodide (PI) 

A10788 ThermoFischer Scientific™ 

 Amplex™ Red 

Hydrogen 

Peroxide/Peroxida

se Assay Kit 

A22188 ThermoFischer Scientific™ 

 Capacity RNA-to-

cDNA™ Kit 

4387406 ThermoFischer Scientific™  

Applied Biosystems™ 

 Cordless pestle 

motor 

47747-370 VWR® 

 DAPI ab228549 abcam™ Sigma-Aldrich™ 

 Dihydroethidium 

assay kit 

30980035MG ThermoFischer Scientific™ 

 DNase 1 18047019 ThermoFischer Scientific™ 

 Dumont #5 micro-

dissection forceps 

11251-10 Fine Science Tools™ 
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 Materials Identification # or 

recipe 

Manufacturer/strain 

 Dumont straight 

micro-dissection 

scissors 

15040-11 Fine Science Tools™ 

 Eppendorf 6331 

Nexus Gradient 

Flexlid Thermal 

Cycler 

 

 

 

 

 

 

Eppendorf™ 

 In Situ Cell Death 

Detection Kit, 

TMR red 

12156792910 Roche™ Sigma-Aldrich™ 

 MicroAmp™ 

Optical 96-Well 

Reaction Plate 

4306737 ThermoFischer Scientific™ 

Applied Biosystems™ 

 MitoSOX™ Red 

Mitochondrial 

Superoxide 

Indicator 

M36008 ThermoFischer Scientific™ 

 Nanodrop™ 

spectrophotometer 

ND-ONEC-W ThermoFischer Scientific™ 

 Normal Goat 

Serum (NGS) 

31872 ThermoFischer Scientific™ 

 Plastic pestles 47747-358 VWR® 

 PowerTrack 

SYBR™ Green 

PCR Master Mix 

A46109 ThermoFischer Scientific™  

Applied Biosystems™ 

 ProLong™ Gold 

Antifade 

mounting media 

P10144 ThermoFischer Scientific™ 

 QIAseq UPX 3’ 

Transcriptome 

Kits 

333088 QIAGEN 

 QIAseq UPX 3' 

Trans. 12-index 

(48) 

333074 QIAGEN 

 Qubit 

Fluorometer 

Q33238 ThermoFischer Scientific™ 

 Qubit RNA 

BR/HS kit 

Q32852 ThermoFischer Scientific™ 
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 Materials Identification # or 

recipe 

Manufacturer/strain 

 Qubit RNA IQ kit Q33221 ThermoFischer Scientific™ 

 QUBIT™ 

fluorometer 

Q33238 ThermoFischer Scientific™ 

 Qubit™ Protein 

BR Assay Kit 

A50669 ThermoFischer Scientific™ 

 Rneasy Mini Kit 

(50) 

74004 QIAGEN 

 SFM4 

(Drosophila 

culture medium) 

89130-770 VWR™ 

 The 

QuantStudio™ 6 

Flex Real-Time 

PCR (qPCR) 

System 

 ThermoFischer Scientific™  

Applied Biosystems™ 

 Triton-X 9036-19- Sigma-Aldrich™ 

 TRIzol™ reagent 15596026 ThermoFischer Scientific™ 

 Tween-20  Sigma-Aldrich™ 

 ZYMO™ 

Research, Direct-

zol® RNA 

Microprep kit 

R2061 ZYMO™ 

Programs/Machines FIJI ImageJ  FIJI ImageJ 

 GraphPad PRISM 

(v 9.4.0) 

 GraphPad PRISM® 

 Zeiss AXIO-

Observer 

fluorescence 

microscope 

 Zeiss 

 Zeiss LSM 880 

confocal 

microscope 

 Zeiss 

 Zeiss Zen-Black  Zeiss 

 Zeiss Zen-Blue  Zeiss 

 Zeiss Zen-Blue 

lite 

 Zeiss 

Antibodies Primary antibody 

Armadillo β-

catenin 

N2 7A1 Developmental Studies 

Hybridoma Bank™ 
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 Materials Identification # or 

recipe 

Manufacturer/strain 

 Rabbit anti-TH T8700-1VL abcam™ Sigma-Aldrich™, 

 Secondary 

antibody donkey-

α mouse  Alexa 

fluorophore A555 

(Red) 

A-31570 ThermoFischer Scientific ™ 

 Secondary 

antibody donkey-

α mouse Alexa 

fluorophore A488 

(Green) 

A-21202 ThermoFischer Scientific ™ 

 Secondary 

antibody donkey-

α rabbit  Alexa 

fluorophore A555 

(Red) 

A-31573 ThermoFischer Scientific ™ 

 Secondary 

antibody donkey-

α rabbit Alexa 

fluorophore A488 

(Green) 

A-21206 ThermoFischer Scientific ™ 

 

 

 

 

 

 

 

 

 

 

 

 



197 
 

 

 

 

 

 

 

 

 

 

 

 

 

Supplementary Figure 1. Efforts to optimize annexin and propidium iodide staining 

for cellular apoptosis and necrosis respectively were unsuccessful. 

Immunofluorescence imaging of CM Elav>BACE positive control for cellular death in the 

brain and control CM Elav>w1118  age matched at 20do, stained with propidium iodide 

(Red), Annexin V (Green), and DAPI (Blue). Images were captured using a Zeiss LSM 

880 confocal microscope at 40x magnification, scale bar reading 50 μm. 
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Supplementary Figure 2. Efforts to optimize propidium iodide staining for cellular 

necrosis were unsuccessful. Immunofluorescence imaging of CM Mex>SNCA males for 

cellular death in the brain and control CM Mex>GFP  age matched at 20do, stained with 

propidium iodide (Red) and DAPI (Blue). Images were captured using a Zeiss LSM 880 

confocal microscope at 20x magnification, scale bar reading 100 μm. 
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Agilent Bioanalyzer results for 8 libraries 

 

Supplementary Figure 3. Agilent Bioanalyzer transcriptomic screen results of 

genotypes Mex>Pex5-i and Mex>w1118 on eight different conditions. The numbers 

above each peak of the reference ladder electropherogram represent cDNA library size in 

bp. FU: Fluorescent units, s: sec taken to migrate on Bioanalyzer chip microchannel. 

 

 

 

Cornmeal 
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Supplementary Figure 4. Relative gene expression (quantification) in the midguts of 

7do Drosophila males and females mixed, using qPCR to validate hits identified 

from the HFD transcriptomic screen. All statistical analyses were carried out using 

multiple, two-tailed, unpaired t-tests, assuming equal variance with an α=0.05. A) 

Relative expression of Amn:RPL23, n=13, between Mex>Pex5-i and Mex>w1118 on CM 

(t(24)=2.352, *p=0.0272) and HFD (t(24)=2.199, *p=0.0377). B) Relative expression of 

AstA:RPL23, n=5, between Mex>Pex5-i and Mex>w1118 on CM (t(8)=0.7536, p=0.4727) 

and HFD (t(8)=1.849, p=0.1017). C) Relative expression of AstA-R1:RPL23, n=4, 

between Mex>Pex5-i and Mex>w1118 on CM (t(6)=4.279, **p=0.0052) and HFD 

(t(6)=3.431,*p=0.0140). D) Relative expression of Bursicon:RPL23, n=7, between 

Mex>Pex5-i and Mex>w1118 on CM (t(12)=1.962, p=0.0733) and HFD (t(12)=5.670, 

***p>0.0001). E) Relative expression of CCAP:RPL23, n=3, between Mex>Pex5-i and 

Mex>w1118 on CM (t(4)=0.3865, p=0.7188) and HFD (t(4)=2.240, p=0.0886). F) Relative 

expression of CCAP-R:RPL23, n=6, between Mex>Pex5-i and Mex>w1118 on CM 

(t(10)=1.639, p=0.1322) and HFD (t(10)=3.027, *p=0.0127). G) Relative expression of 

CCHa2:RPL23, n=6, between Mex>Pex5-i and Mex>w1118 on CM (t(10)=1.329, 

p=0.2134) and HFD (t(10)=1.461, *p=0.0274). H) Relative expression of CCHa2-

R:RPL23, n=6, between Mex>Pex5-i and Mex>w1118 on CM (t(10)=1.639, p=0.1322) and 

HFD (t(10)=3.027, *p=0.0127). I) Relative expression of Dsk:RPL23, n=5, between 

Mex>Pex5-i and Mex>w1118 on CM (t(8)=1.807, p=0.1085) and HFD (t(8)=0.6962, 

p=0.5054). J) Relative expression of FMRFa:RPL23, n=5, between Mex>Pex5-i and 

Mex>w1118 on CM (t(8)=4.074, **p=0.0036) and HFD (t(8)=1.819, p=0.1065). K) 

Relative expression of MsR2:RPL23, n=3, between Mex>Pex5-i and Mex>w1118 on CM 

(t(4)=0.4475, p=0.6777) and HFD (t(4)=0.6211, p=0.5682). L) Relative expression of 

NPF:RPL23, n=3, between Mex>Pex5-i and Mex>w1118 on CM (t(4)=1.977, p=0.1192) 

and HFD (t(4)=2.894, *p=0.0438). M) Relative expression of PDF-R:RPL23, n=6, 

between Mex>Pex5-i and Mex>w1118 on CM (t(10)=0.3357, p=0.7440) and HFD 

(t(4)=1.476, p=0.0.1707). M) Relative expression of PDF-R:RPL23, n=6, between 

Mex>Pex5-i and Mex>w1118 on CM (t(10)=0.3357, p=0.7440) and HFD (t(10)=1.476, 

p=0.1707). N) Relative expression of sNPF:RPL23, n=7, between Mex>Pex5-i and 

Mex>w1118 on CM (t(12)=3.432,**p=0.0050) and HFD (t(12)=2.874, *p=0.0139). O) 

Relative expression of TK:RPL23, n=6, between Mex>Pex5-i and Mex>w1118 on CM 

(t(10)=0.1819, p=0.8593) and HFD (t(10)=0.0522, p=0.9593). 
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Supplementary Figure 5. Relative gene expression (quantification) in the midguts of 

30do Drosophila males and females separaely, using qPCR to validate gene-hits of the 

HFD transcriptomic screen on CM, HFD and AX conditions. All statistical analyses 

were carried out using multiple, two-tailed, unpaired t-tests, assuming equal variance with 

an α=0.05. A) Relative expression of Amn:RPL23 in males, n=3, between Mex>Pex5-i and 

Mex>w1118 on CM (t(4)=6.482, **p=0.0029), HFD (t(4)=0.4187, p=0.6969), and AX diets 

(t(4)=1.805e-5, p>0.9999). B) Relative expression of Bursicon:RPL23 in males, n=3, 

between Mex>Pex5-i and Mex>w1118 on CM (t(4)=2.291, p=0.0837), HFD (t(4)=13.31, 

***p=0.0002), and AX diets (t(4)=5.718, **p=0.0046). C) Relative expression of 

Dsk:RPL23 in males, n=3, between Mex>Pex5-i and Mex>w1118 on CM (t(4)=0.1657, 

p=0.8764), HFD (t(4)=18.88, ****p<0.0001), and AX diets (t(4)=2.878, *p=0.0451). D) 

Relative expression of Bursicon:RPL23 in males, n=3, between Mex>Pex5-i and 

Mex>w1118 on CM (t(4)=6.482, **p=0.0029), HFD (t(4)=0.4187, p=0.6969), and AX diets 

(t(4)=1.805e-5, p>0.9999). E) Relative expression of Amn:RPL23 in females, n=3, 

between Mex>Pex5-i and Mex>w1118 on CM (t(4)=1.152, p=0.3134), HFD (t(4)=0.6984, 

p=0.5234), and AX diets (t(4)=2.061, p=0.1084). F) Relative expression of 

Bursicon:RPL23 in females, n=3, between Mex>Pex5-i and Mex>w1118 on CM 

(t(4)=0.5869, p=0.5888), HFD (t(4)=40.93, ****p<0.0001), and AX diets (t(4)=3.013, 

*p=0.039). G) Relative expression of Dsk:RPL23 in females, n=3, between Mex>Pex5-i 

and Mex>w1118 on CM (t(4)=1.057, p=0.3502), HFD (t(4)=28.18, ****p<0.0001), and AX 

diets (t(4)=0.7880, p=0.4748). H) Relative expression of sNPF:RPL23 in females, n=3, 

between Mex>Pex5-i and Mex>w1118 on CM (t(4)=2.887, *p=0.0447), HFD (t(4)=42.98, 

****p<0.0001), and AX diets (t(4)=1.970, p=0.1201). 
 

 

 

 


